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Ohutus
Sissejuhatus

Enne tarkvara kasutamist on selle tõhusaks ja ohutuks kasutamiseks oluline lugeda see ohutuse jaotis ja kõik sellega 
seotud teemad läbi. Enne toote kasutamist on oluline selle kasutusjuhendi sisu läbi lugeda ja sellest aru saada. Peaksite 
perioodiliselt siinseid protseduure ja ohutusealaseid ettevaatusabinõusid taas üle vaatama. 

See tarkvara on ette nähtud ainult väljaõppinud ja kvalifitseeritud personalile.

Tarkvara suiteDXT/suiteHEART® eeldatav kasulik kasutusiga on 7 aastat alates selle esmaavaldamise kuupäevast.

NeoSoft ei paku oma toodetele regulaarset hooldusteenust. Küsimuste ja probleemide korral võtke ühendust kasutajatoega.

ETTEVAATUST! USA föderaalseadus lubab seadet müüa, levitada ja kasutada ainult arstil või arsti korraldusel.

Tunnussõnu „Oht!“, „Hoiatus!“ ja „Ettevaatust!“ kasutatakse käesolevas juhendis ohtudele ning nende raskusastmele 
viitamiseks. Ohuna määratakse allikat, mis võib inimesele potentsiaalselt vigastusi põhjustada. Viige end allolevas tabelis 
olevate mõistete kirjeldustega kurssi.

Tabel 1.  Ohutusalased mõisted

Tingmärk Definitsioon

OHT!

Tunnussõna „Oht!“ kasutatakse selleks, et näidata tingimusi või tegevusi, mille puhul on 
teadaolevalt olemas konkreetne oht, mis juhiste eiramisel põhjustab raskeid kehavigastusi, 
surma või olulist varalist kahju.

HOIATUS! 

Tunnussõna „Hoiatus!“ kasutatakse selleks, et näidata tingimusi või tegevusi, mille puhul on 
teadaolevalt olemas konkreetne oht.

ETTEVAATUST! 

Tunnussõna „Ettevaatust!“ kasutatakse selleks, et näidata tingimusi või tegevusi, mille puhul on 
teadaolevalt olemas potentsiaalne oht.
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Kasutusnäidustused

Tarkvara suiteHEART® on analüütilise tarkvara tööriist, mis tagab meditsiiniliste kujutiste ülevaatamiseks ja aruandluseks 
taastatavad tööriistad. Tarkvara suiteHEART® suudab importida MR-süsteemidest meditsiinilisi kujutisi ja neid arvuti 
ekraanil vaatealal kuvada. Vaateala võimaldab ligipääsu mitmete lõikude ja mitmete faasidega kujutiste erinevatele 
uuringutele ja seeriatele. Mitme faasiga kujutiste järjestusi saab visualiseerimise lihtsustamiseks kuvada videorežiimis.

Olemas on ka aruande sisendi liides. Aruande liidese mõõtmistööriistad võimaldavad kiiresti ja usaldusväärselt täita 
piltdiagnostika uuringu täieliku kliinilise aruande. Olemasolevate tööriistades seas on punkti, kauguse, pindala ja mahu 
mõõtmise tööriistad nagu väljutusfraktsiooni, südame minutimahu, lõppdiastoolse mahu, lõppsüstoolse mahu ja voolu 
mahu mõõtmised.

Olemas on ka poolautomaatsed tööriistad vasaku vatsakese kontuuri, klapi tasapinna ja veresoone kontuuri 
tuvastamiseks, et teostada voolu analüüs, signaali intensiivsuse analüüs müokardi ja infarkti suuruse mõõtmiseks ning T2* 
analüüs.

Mõõtmistööriistade tulemusi tõlgendab arsti ja neid saab edastada suunavatele arstidele.

Kui neid tõlgendab koolitatud arst, võivad need tööriistad olla kasulikud diagnoosi panemise toetamiseks.

Kasutusotstarve

Tarkvara suiteHEART® eesmärk on aidata koolitatud kliinilisel personalil südame funktsiooni kvalitatiivselt ja 
kvantitatiivselt hinnata. Tarkvara annab tööriistad, millega DICOM-i kujutiste parameetreid kohandada, ja kujutise 
esitluse, kus kasutaja saab hinnata erinevaid MRT-ga saadud kujutisi südamest ja veresoonkonnast aja jooksul. Lisaks 
annab tarkvara tööriistad lineaarsete kauguste, pindalade ja mahtude mõõtmiseks, mida saab kasutada südame 
funktsiooni kvantitatiivseks hindamiseks. Tarkvara pakub lõpetuseks ka tööriistu voolu mahu mõõtmiseks ja võimaluse 
voolu väärtusi arvutada.

Toetatud DICOM-i kujutisevormingud

Tarkvara suiteHEART® toetab järgmisi DICOM-i vorminguid: MR ja tõhustatud MR. Lisateavet toetatud vormingute kohta 
vt tarkvara suiteHEART® DICOM-i vastavusavalduse juhendist.

ETTEVAATUST! DICOM-i kujutisena säilitatud andmed, mis on imporditud välisest PACS-ist, ei pruugi olla 
tarkvaras suiteHEART® vaadatavad. 
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Ohutusmärkused

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

HOIATUS! Pildil olevaid artefakte võidakse valesti tõlgendada, mis toob kaasa ebatäpseid tulemusi. Ärge 
kasutage diagnoosimiseks artefaktidega kujutisi. Analüüse peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

HOIATUS! Kui kujutistel ei ole patsiendi nime või ID-d, võidakse määrata diagnoos valele patsiendile. Ärge 
kasutage diagnoosi määramiseks kujutisi, millel ei ole patsiendi nime või ID-d. Veenduge visuaalselt 
enne analüüsimist, et patsiendiandmed on õige.

ETTEVAATUST! Kui kasutatakse kujutisi, millele on rakendatud kujutise filtrit, võidakse saada ebatäpsed 
tulemused. Pikselintensiivsusega korrigeeritud kujutiste analüüsimisel peaks kasutaja lähtuma 
oma äranägemisest. Filtreeritud kujutiste laadimisel kuvab tarkvara hoiatusteate.

Ohud seadmetest

ETTEVAATUST! Kahjustatud või mitteterviklikke seadmeid kasutades võib patsiendi diagnoosimise 
edasilükkumise tõttu ohtu seada. Veenduge, et seadmed on töökorras.

ETTEVAATUST! Rakendused võivad töötada seadmetel, mis sisaldavad ühte või mitut kõvaketast, mis võivad 
sisaldada patsientidega seotud terviseandmeid. Mõnes riigis võivad sellistele seadmetele 
kehtida isikuandmete töötlemist ja selliste andmete vaba ringlust käsitlevad eeskirjad. 
Isikuandmete avaldamine võib olenevalt pädevast reguleerivast asutusest tuua kaasa 
õigusmeetmete võtmist. On tungivalt soovitatav, et juurdepääs patsiendi failidele oleks 
kaitstud. Kasutaja peab mõistma patsiendiandmeid reguleerivaid seadusi.
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Küberturve
Selle tarkvara loomisel ja rakendamisel kohaldab NeoSoft järgmisi küberturbe ettevaatusabinõusid:

• NeoSoft tarkvara haldamise teatud funktsioone (kasutajaõigused, andmebaaside ümberehitamine jne) saavad teostada 
vaid väljaõppinud haldurid.

• NeoSoft tarkvara analüüsitakse regulaarselt NIST-i andmebaasis loetletud tuntud haavatavuste suhtes ja vajadusel tehakse 
parandused. 

• NeoSoft tarkvara kasutab patsientide andmete säilitamiseks ja kasutaja konfigureeritud pordi kaudu patsientide andmete 
edastamiseks võrgus DICOM standardit.

• Enne tarkvara paigaldamist kontrollitakse NeoSoft tarkvara terviklust md5 summas, et kindlustada tarkvara terviklik 
tarnimine. 

• NeoSofti tarkvara on kontrollitud kasutamiseks riistvaral, millel on krüptimine lubatud. 

• NeoSoft maandab küberturbe riske kooskõlas ISO 14971 standardiga.

• NeoSofti töötajad on läbinud küberturbe ja terviseandmete kaitsmise alase koolituse. 

• NeoSoft ei saa ega halda kaitstud terviseandmeid, välja arvatud siis, kui klient on andnud tõrkeotsingu jaoks 
erijuurdepääsu. 

• NeoSofti tarkvara on läbinud läbistustestimise. 

• Automaatne väljalogimine (ALOF) – suiteHEART võib olla konfigureeritud end sulgema, kui seda ette nähtud aja jooksul ei 
kasutata. suiteDXT jääb avatuks kuni kasutaja selle sulgeb või süsteem taaskäivitatakse. 

• Auditi kontrollid (AUDT) – suiteHEART ja suiteDXT loovad ajatempliga logisid, mis sisaldavad tarkvarasündmusi ja 
kasutajateavet.

• Autoriseerimine (AUTH) – suiteDXT-s võib haldur vaadata ja konfigureerida teiste kasutajate juurdepääsu kontrollimist. 
Olenevalt sellest, kuidas juurdepääs on konfigureeritud, võivad kasutajad suiteDXT-s ja suiteHEART-s teatud uuringuid 
ainult vaadata. Näiteks kasutajal A on juurdepääs uuringuteabele vaid asukohast A ja kasutaja B saab uuringule ligi nii 
asukohast A kui ka B.

• Seadme autentimine (NAUT) – suiteDXT saab konfigureerida suhtlema teiste DICOM-seadmetega, konfigureerides AE 
pealkirja, IP-aadressi ja DICOM-pordi. suiteHEART ei kasuta vaikimisi võrku, kuid see võib olla konfigureeritud saatma 
andmeid teistele süsteemidele konfiguratsioonimuudatuse kaudu, tuvastades teised süsteemid AE pealkirja, IP-aadressi ja 
pordi järgi. Mõlemaid tooteid võib kasutada ilma võrguta importides failisüsteemist kohalikud uuringuandmed, selle 
asemel, et saata või saada andmeid võrgu vahendusel. 

• Isiku autentimine (PAUT) – suiteHEART ja suiteDXT võivad olla konfigureeritud nii, et need võimaldavad kasutaja 
autentimist, kasutaja parooli kontrolli ja sisselogitud kasutaja jaoks saadaolevate patsiendiandmete konfigureerimist. 
Kasutajateave logitakse.

• Ühenduvusvõimalused (CONN) – suiteDXT võib andmete edastamiseks luua ühenduse teiste konfigureeritud DICOM-i 
partneritega. suiteHEART võib olla konfigureeritud saatma andmeid teistele süsteemidele konfiguratsioonimuudatuse 
kaudu, tuvastades teised süsteemid AE pealkirja, IP-aadressi ja pordi järgi. 

• Füüsilised lukud (PLOK) – pole asjakohane. NeoSoft soovitab kaitseks kasutada võrguturbetooteid.

• Süsteemi ja rakenduse tugevdamine (SAHD) – pole asjakohane. NeoSoft soovitab kaitseks kasutada võrguturbetooteid.

• Terviseandmete umbisikustamine (DIDT) – suiteDXT sisaldab Anonümiseerimise (Anonymize) funktsiooni patsiendi 
uuringute umbisikustamiseks. 

• Terviseandmete terviklus ja autentsus (IGAU) – suiteDXT sisaldab uuringute andmete importimiseks/edastamiseks 
olekuteateid, mis annavad eduka importimise või edastamise kinnituse ja teabe vigade esinemise kohta. suiteHEART 
hoiatab kasutajat hüpikakna kaudu, kui oodatud sisendandmed puuduvad või on rikutud. 

• Andmete varukoopia ja avariitaaste (DTBK) – suiteHEART-i genereeritud andmed on soovitav pikemaks säilitamiseks/
varundamiseks saata PACS-i. suiteDXT sisaldab andmebaasi taastamise tööriista, kui kohalik tarkvara peaks olema rikutud.
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• Terviseandmete säilitamise konfidentsiaalsus (STCF) – suiteHEART ja suiteDXT on ette nähtud kasutamiseks kvalifitseeritud 
personali poolt ja neid võidakse kasutaja äranägemisel kaitsta kasutajanime ja parooliga.

• Edastamise konfidentsiaalsus (TXCF) – kõik andmed edastatakse DICOM-i vormingus.

• Edastamise terviklus (TXIG) – kõik andmed edastatakse DICOM-i vormingus.

• Toote küberturbe täiendused (CSUP) – kõik paigaldused ja täiendused on uue tarkvaraväljalaske kujul, mida lubab ja 
rakendab kasutaja omal äranägemisel.

• Tarkvara ülevaade (SBoM) – suiteHEART-i Lisateabe (About) kuval on loetletud kolmandate isikute tarkvara. suiteDXT 
kolmandate isikute tarkvara teave on leitav suiteDXT paigalduskataloogi kaustas „3pInfo“. 

• Kolmandate isikute komponentide teedekaart seadme elutsüklis (RDMP) – NeoSoft hindab kolmandate isikute tarkvara 
regulaarselt ja värskendab vajadusel suiteHEART-i ja/või suiteDXT-d.

• Turbejuhis (SGUD) – NeoSoft soovitab kasutada viirusetõrjetarkvara.

• Võrguturbefunktsioonide konfigureerimine (CNFS) – toote võime konfigureerida võrguturbefunktsioone vastavalt kasutaja 
vajadustele – nii suiteHEART-i kui ka suiteDXT-d saab kasutada ilma võrguühenduseta. Kui need aga on konfigureeritud 
võrgus edastamiseks, on vajalikud vaid AE pealkiri, IP-aadress ja pordi teave. Täiendavate turbemeetmete võtmine ei ole 
nõutav/vajalik. 

• Hädaolukorra juurdepääs (EMRG) – puudub. suiteHEART-i ja suiteDXT-d ei kasutata hädaolukorras.

• Kaugteenus (RMOT) – teenust võib osutada kaugteenusena kliendi poolt ette nähtud kaugjuurdepääsu meetodi (nt 
kaugtöölaua) kaudu. suiteHEART ja suiteDXT ei sisalda ise kaugjuurdepääsu.

• Pahavara tuvastamine/kaitse (MLDP) – puudub. suiteHEART ja suiteDXT ei sisalda pahavara tuvastamist või sellevastast 
kaitset. NeoSoft soovitab kaitseks kasutada võrguturbetooteid.
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Alustamine

Rakenduse käivitamine ja sellest väljumine
Tarkvara suiteHEART® on rakendus, mida kasutatakse südame MRT (magnetresonantstomograafia) uuringute 
analüüsimiseks, vaatamiseks ja nende kohta aruannete tegemiseks. See kasutusjuhend annab üksikasjalikud selgitused 
tarkvara suiteHEART® kasutajaliidese ja südame MR-kujutiste kvantitatiivse analüüsi tegemise töövoo kohta.

Tarkvara suiteHEART® käivitamine
1. Käivitage suiteDXT arvuti töölaual oleva otsetee abil.

JOONIS 1. Tarkvara käivitamine
 

2. Valige uuringute loendist uuring ja tehke ühte järgmistest tegevustest.

• Valige suiteHEART®.
• Tehke uuringul topeltklõps.

3. Valige uuringurühm ja valige suiteHEART®.

Teiste uuringute vaatamiseks kasutage Fail (File) > Uuringu vahetamine (Switch Study).

MÄRKUS. Ekraani lahutusvõime peab olema 1920×1080 px või suurem (rõhtpaigutus); 2160x3840 või suurem 
(püstpaigutus), muidu tarkvara ei käivitu.

HOIATUS! Kui kasutada kujutisi, mille analüüsiks on rakendatud pikslite intensiivsuse filtreid, siis võivad tekkida 
ebatäpsed tulemused.
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Tarkvarast suiteHEART® väljumine

Rakendusest väljumiseks valige Fail (File) > Välju (Exit) või klõpsake kasutajaliidese ülemises paremas nurgas risti (X) 
ikooni.

JOONIS 2. Tarkvara suiteHEART® sulgemine

Uuring loetakse „kasutatuks“ või „arvestatuks“ juhtumipõhise paketi limiidiga, kui tehakse mõni järgmistest toimingutest.

a.) Mis tahes analüüsirežiimi käivitamine, paigutades kujutisele mis tahes ROI.
b.) Kohandatud seeriate loomine.
c.) Aruande allkirjastamine.
d.) Video DICOM-i eksportimine.
e.) Aruande eksportimine.
f.) DICOM-seeria loomine.
g.) Eeltöödeldud uuring.
h.) Virtual Fellow® eeltöötlemine.
i.) Automaatne seeriate koostamine.



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3                                8

Kasutajaliidese ülevaade
Ülevaade

Tarkvara suiteHEART® analüüsirežiimide liidesed on organiseeritud järgmiselt:

• Tulemuste paan – juurdepääs analüüsirežiimide analüüsitööriistadele ja tulemuste tabelile
• Pisipiltide vaade – kõikide lõikude asukohtade vaade
• Redaktorivaade – segmenteerimise redigeerimine ja ülevaatamine
• Maatriks – olemas funktsiooni ja müokardi perfusiooni analüüside jaoks 
• Video vaade – kujutiste vaatamine videona 
• Ristlõige – 3 vaateava 
• Aruandlus (Alt + R): juurdepääs aruandlusele

JOONIS 1. Analüüsirežiimide liides (joonisel on funktsiooni analüüsi režiim) 

 Jagab liidese mitmeks kuvaks.

 Taastab ühe kuva 

Pisipiltide vaade Maatriks 

Video vaade RedaktorivaadeTulemuste paan Aruandlus 

Mitu kuva

Ristlõigete 
vaateavad
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Analüüsi/vaatamise režiimid

MÄRKUS. Avatud ovaalmulgu (Patent Foramen Ovale (PFO)) analüüse saab valida faili rippmenüüst või kasutades 
klaviatuuril klahvikombinatsiooni Ctrl + 5.

Seeriate sirvimine

Valitud uuringu kujutiste vaatamiseks või seeriate vahetamiseks kasutage parem- ja vasaknoolenuppe kujutisevaaturi ülaservas. 
Seeriate valimiseks saab kasutada ka seeriatefaili rippmenüüd, mis asub filtri nupust vasakul. Seeriad, milles on olemas huvipakkuv 
analüüs või piirkond, tuuakse välja poolpaksus kirjas, nagu on näidatud joonisel Joonis 2.

JOONIS 2. Seeriate sirvimine

Tabel 1.  Analüüsirežiimid

Funktsiooni 
analüüs

Vool 
Analüüs

Müokardi 
hindamine

T1 
kaardistamine

T2 
kaardistamine

Müokardi 
perfusiooni 
analüüsid

T2* analüüs

Tabel 2.  Vaatamisrežiimid

Vaatur Virtual Fellow® 3D/4D voolu vaatur

                                   



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3                                10

Redaktori aken ja režiimi vaade

Kui kujutisevaaturis teha kujutisel paremklõps, aktiveeritakse kujutise töötlemise tööriistad. 

Failimenüü suvandid
Vali analüüs (Select Analysis) – valib analüüsirežiimi (funktsioon, vool, müokardi hindamine, müokardi perfusioon, PFO, T2*, T1 

kaardistamine, T2 kaardistamine, 3D/4D ja DENSE) 
Andmebaasi sirvimine (BrowseDB) – avab kohaliku andmebaasi
Uuringute vahetamine (Switch Study) – loetleb uuringud kiireks ligipääsuks
Aruandlus (Reporting) – avab aruandluse liidese
Aruande eelvaade (Preview Report) – kuvab aruande
Laadi üles kinnitatud uuring (Load Approved Exam) – taastab eelnevalt avatud aruande
Välju (Exit) – salvestab praegused analüüsitulemused sekundaarse ülesvõtte (SCPT) seeriatesse ja sulgeb rakenduse.

Tööriistade menüü suvandid
Eelistused (Preferences) > 

Redigeeri (Edit) – kasutaja tase – halli värvi suvandeid saab muuta ainult administraator
Redigeeri süsteemi (Edit System) – ainult administraator
Impordi (Import) – ainult administraator
Kopeeri (Copy) – kopeerige eelistused teistel kasutajatelt
Ekspordi (Export) – ekspordib kõik kasutajaeelistused ja mallid

Ülaltoodud valikuid vt Lisa A: kasutaja taseme eelistused lk 202.

Ekspordi (Export) >
Aruanne Excelisse (Report to Excel) – loob analüüsi tulemustega Exceli tabeli
Aruanne XML-i (Report to XML) – ekspordib aruande XML-failina
Andmed Matlabi (Data to Matlab) – ekspordib binaarvormingus Mat-faili (eeldab uuringulepingut)
Pinge andmed Matlabi (Strain Data to Matlab) – ekspordib binaarvormingus Mat-faili (eeldab uurigulepingut)
Segmenteerimine NRRD-sse (Segmentation to NRRD) – talletab segmenteerimise maski edasiseks analüüsimiseks 
tarkvarasse 3D Slicer või teise ettevõttesisesesse tööriista
Isopind STL-i (Isosurface to STL) – kodeerib veresoone pinna 3D-printimiseks või CAD-i jaoks pinnase võrguks

MÄRKUS. Aruande saab DICOM-ina või tulemused saab muu tootja aruandlussüsteemi eksportida ainult kuvalt Kuva 
eelvaade (Preview Report) (Ctrl + R). 

Tabel 3.  Kujutise töötlemise tööriistad

Aken/tasand

Panoraami

Suumi

Pööra

Pööra ümber

Saada aruannetesse

Ekspordi koostaja

Skannimisparameetrid

Lähtesta
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Aruande andmebaas (Report Database) – avab andmebaasi otsingu liidese
Märkmete lülitamine (Toggle Annotation) – lülitab ROI märkmete kuvamist
Joone paksuse lülitamine (Toggle Line Thickness) – lülitab märkmete tegemisel kasutatava joone paksust.
Ristlõigete joonte lülitamine (Toggle Cross Reference Lines) – lülitab kujutiste ristlõigete jooni.
Vaatevälja lülitamine (Toggle FOV) – lülitab vaatevälja
Akna/tasandi ümbervahetamine (Invert Window/Level) – vahetab ringi akna/tasandi vaate

Abimenüü suvandid
Kasutusjuhend (Instructions for Use) – tarkvara suiteHEART® kasutusjuhend
Kiirklahvid (Quick Keys) – klaviatuuri funktsioonid
DICOM-i vastavusavaldus (DICOM Conformance Statement) – tarkvara suiteHEART® DICOM-i vastavusavaldus
Täpsemalt tarkvarast suiteHEART® (About suiteHEART®) – rakenduse versiooni teave 
Regulatiivne teave (Regulatory Information) – Regulatiivne vastavusteave

Redaktori vaate juhtnupud

Faasi liuguriga  kontrollitakse video faasi valikut.

Kerige läbi faaside hoides ühel ajal all Ctrl-klahvi ja keskmist hiireklahvi.

Kujutise etappide ikoonid  võimaldavad lõik lõigu haaval 
sirvimist, kui pisipiltide vaade on lõikudel või faasidel. Lõiku saab navigeerida ka keskmise hiireratta abil.

Klaviatuuril saate olenevalt eelistuste seadistustest lõike sirvida parem-/vasaknooleklahviga ja faase sirvida üles-/allanooleklahvidega. 

MÄRKUS. X-telje (lõik) ja y-telje (faas) saab omavahel ümber vahetada. Vt Funktsiooni vahekaart lk 44. Kui teljed ümber 
vahetatakse, tuleb rakendus uuesti käivitada.

Video vaate juhtnupud

 - Video juhtriba: määrab video algus- ja lõpukaadri.

 - Kaadrid sekundis (Frames Per Second (FPS)): Video kiiruse muutmiseks klõpsake noolel või sisestage tekstiväljale 
väärtus

 - Käivita ikoon: asub video juhtriba kõrval

 - Pausi ikoon: asub video juhtriba kõrval
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Ristlõigete vaateavad

Kui kujutiseredaktori vaateavades kuvatakse parajasti kujutise lühikese telje vaadet, kuvavad kolm ristlõigete vaadet kujutise pikitelje 
vaate. Pikitelje vaade on redaktori vaateavas kuvatava kujutise suhtes olev ristlõik. A on kõigi võimalike ristlõigete rippmenüü koos 
nupuga, millega ristlõigete indikaatorite kuvamist lülitada. Kasutage miinus- ja plussmärki või keskmist hiireratast lõikude asukohtade 
vahel navigeerimiseks.

JOONIS 3. Seeriate valiku rippmenüü

 

Kujutise töötlemise tööriistad

Tabel 4.  Tööriista kirjeldus

Lõigu/faasi vaate lülitamine

Aken/tasand – valige ja kasutage muudatuste tegemiseks keskmist hiireklahvi

Värviskaala – valige ja kasutage muudatuste tegemiseks keskmist hiireklahvi

Panoraami – valige ja kasutage muudatuste tegemiseks keskmist hiireklahvi

Suumi – valige ja kasutage muudatuste tegemiseks keskmist hiireklahvi

Pööra – valige ja kasutage muudatuste tegemiseks keskmist hiireklahvi

Keera horisontaalselt – keerab kujutist horisontaalselt

Ulatus kõik – rakendab kujutise töötlust kõikidele lõikudele

Ulatus praegusest lõpuni – rakendab kujutise töötlust aktiivsest lõigust kuni viimase lõiguni

Ulatus ainult praegusele – rakendab kujutise töötlust vaid aktiivsele lõigule

Vaateavade paigutus – muudab vaaturi paigutust
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Võrdlusrežiim – läheb üle võrdlusrežiimile

Ülevaate režiim – läheb üle ülevaaterežiimile

Näita ristlõigete jooni – lülitab ristlõigete jooned sisse/välja

Värvikaardi ülekate – lülitab lõikude klassifitseerimise värvikaardi sisse/välja

Lähtesta – lähtestab W/L, panoraami, suumi ja pööra vaikeväärtustele olenevalt ulatuse sättest

Huvipakkuv piirkond – esitab pindala ja ümbermõõdu

Sihikujoonestik – esitab ühe piksli andmed

Lineaar – annab mõõtmistulemused sirgel joonel

Silt – võimaldab redaktori (Editor) aknas lisada kasutaja märkme

Nurk – võimaldab mõõta nurka

Leia tunnus – ristlõigete tööriist, mis automaatselt tuvastab ja kuvab kujutise, mis sisaldab sama asukohta

Tühista – tühistamise funktsioon ROI redigeerimiseks

Värskenda – klõpsake nupul kujutisevaaturi värskendamiseks äsja võrgust toodud uute kujutistega või 
analüüsirežiimide värskendamiseks
Filtreeri – sorteerib seeriad pulsisageduse tüübi järgi analüüsirežiimi kohaselt. Tühistamiseks valige KÕIK (ALL). 
Filtreid saab määrata valiku Eelistused (Preferences) all. Kui filtrit kasutatakse, muutub filtri nupp roheliseks.

Tabel 4.  Tööriista kirjeldus
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Kiirklahvid 
 

*Aktiivsed klahvid olenevad häälestusparameetritest.

Tegevus Kiirklahv Tegevus Kiirklahv

Kujutise suumimine Ctrl + keskmine hiireklahv Üldised märkmed

Kujutise roteerimine Ctrl + Shift + keskmine 
hiireklahv

Lineaar Alt + 1

Panoraamkujutis Shift + keskmine hiireklahv Ristid Alt + 2

Aken/tasand Alt + keskmine hiireklahv Huvipakkuv piirkond Alt + 3

Video taasesitus/paus Tühikuklahv Silt Alt + 4

Faasi kerimine Ctrl + keskmine hiireratas Nurk Alt + 5

Lõigu kerimine Keskmine hiireratas ROI redigeerimise tööriistad

Aruandlus Alt+R Kopeeri huvipakkuv piirkond Ctrl + C

Vali vaatamiseks uuesti kõik kujutised Ctrl + A Kleebi huvipakkuv piirkond Ctrl + V

Aruande andmebaas Ctrl + D ROI silumine Ctrl + S

Eelistuste redigeerimine Ctrl + E Nihuta ROI-d horisontaalselt A- ja D-klahvid

Vaatevälja lülitamine Ctrl + F Nihuta ROI-d vertikaalselt W- ja S-klahvid

Akna/tasandi ringivahetamine Ctrl + I Loo punktsplaini nurk Alt + hiire vasakklahv

Paksu joonega märkus Ctrl + L Kustuta punkt (punktsplainil) KUSTUTUSKLAHV + kursor 
valitud punktil

Ava andmebaasi sirvimine Ctrl + O Läviväärtuse tööriist Alt + hiire vasakklahvi 
lohistamine

Lahku rakendusest või välju Ctrl + Q 3D/4D redigeerimise tööriistad

Aruande eelvaade Ctrl + R 3D-rotatsioon Ctrl + Alt + keskmine hiireklahv

Vaheta uuringut Ctrl + S Kujutise suumimine Ctrl + keskmine hiireklahv

Märkuse lülitamine Ctrl + T Aken/tasand Alt + keskmine hiireklahv

Ristlõigete joonte lülitamine Ctrl + X Ristide kursori liigutamine Tõstuklahv (Shift)

Tühista Ctrl + Z Hari Alt + A

TIHE Ctrl + +0 Kustuta Alt + E

Funktsioon Ctrl + 1 Jälg Alt + T

Vool Ctrl + 2 Lõikamine Alt + C

Müokardi hindamine Ctrl +3 Sujuv Alt + S

Müokardi perfusioon Ctrl + 4 Harja suurus Alt + hiireratas

PFO Ctrl + 5 Välju muutmisest Alt + Q

T2* Ctrl + 6 Kuvarežiim Alt + D

T1 kaardistamine Ctrl + 7

T2 kaardistamine Ctrl + 8

3D/4D voolu vaatur Ctrl + 9

Navigeerimine lõikude vahel* Vasak- ja paremnooleklahvid

Navigeerimine faaside vahel* Üles- ja allanooleklahvid

Navigeerimine Virtual Fellow® 
lõikudel

Z ja A klahv järgmise ja 
eelmise lõigu jaoks
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Tulemuste paan

Tulemuste paan on olemas igale analüüsirežiimile.

JOONIS 4. Tulemuste paan

 1. Tulemuste tabel, 2. Graafiku kuva, 3. Kustuta, 4. Graafikud, 5. Tabelid

1

2

5

3

4
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Tulemuste tabel

Mõõtmistulemusi saab eelistustes ümber korraldada ja konfigureerida (vt Printimise vahekaart lk 42). Mõõtmiste tabelit saab ümber 
korraldada nii, et valite rea ja lohistate selle uude kohta. Selline tabeli järjestus on alati vaikimisi kõikide uute uuringute eelisjärjestus. 
Klõpsates mõõtmise kõrval oleval kastil valige või tühistage mõõtmise lisamine aruandesse.

JOONIS 5. Tulemuste tabel

MÄRKUS. Südame löögisageduse muutmiseks või sisestamiseks klõpsake otse tabelile.

 Graafiku ja tabeli tulemused

Tulemusi saab kuvada graafikuna või tabelina klõpsates soovitud ikoonil, mis asub paremal all nurgas analüüsi vaates.

JOONIS 6. Graafik (vasakul) ja tabel (paremal)
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Tabel 5.  Analüüsitööriistad

 Vasaku vatsakese endokardiaalne ROI  Pikitelje LV endokardiaalne ROI 

 Vasaku vatsakese epikardiaalne ROI
 Pikitelje LV epikardiaalne ROI 

 Parema vatsakese endokardiaalne ROI
  Vasaku vatsakese vaheseinmine ROI

 Parema vatsakese epikardiaalne ROI
 Vasaku vatsakese lokaalne ROI

 Mitraalklapi rõngas
 Vasaku vatsakese verevoo ROI

 Trikuspidaalklapi rõngas

 Parema vatsakese sisestuspunkt

 Vasaku vatsakesese papillaarlihase ROI

 Parema vatsakese papilaarlihase ROI

 Vasaku koja ROI 

 Parema koja ROI

 Pikitelje RV endokardiaalne ROI

 Pikitelje RV epikardiaalne ROI
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Aruandlus

Aruandluse liidese valimiseks vajutage korraga ALT + R. Lisateabe saamiseks vt Aruandlus lk 186.

JOONIS 7. Aruandluse liides

 - Aruandlus: kasutatakse aruandluse liidese või analüüsirežiimi avamiseks

 - Aruande eelvaade: kasutatakse aruande ülevaatamiseks       

 Andmebaasi sirvimine

Aken Andmebaasi sirvimine (Browse DB) näitab uuringuid kohaliku andmebaasis. Juhtnuppudega saab valida, milliseid uuringud 
vaadata või vahetatavate uuringute loendisse lisada.
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JOONIS 8. Andmebaasi sirvimine

1. Kohaliku andmebaasi loend, 2. Tarkvara suiteHEART® andmebaasi vaatur, 3. Nupp Lisa vaaturisse (Add to Viewer), 
4. Eemalda vaaturist (Remove from Viewer), 5. Uuenda vaadet (Update View), 6. Tühista (Cancel)

Andmebaasi sirvimise funktsioonid

Aken Andmebaasi sirvimine (Browse DB) kuvab alati vaikimisi kohalikku andmebaasi.

1. Kohaliku andmebaasi loend (Local database listing) – kuvab uuringuid, mis on kohalikku andmebaasi salvestatud.                
2. Tarkvara suiteHEART® andmebaasi vaatur (suiteHEART® Software database viewer) – kuvab uuringuid, mis on praegu tarkvara 

suiteHEART® andmebaasis.
3. Lisa vaaturisse (Add to viewer) – lisab kohalikust andmebaasist (näha akna ülemises osas) valitud uuringu tarkvara suiteHEART® 

andmebaasi vaatealale.
4. Eemalda vaaturist (Remove from Viewer) – eemaldab uuringu tarkvara suiteHEART® andmebaasi vaatealalt.
5. Uuenda vaadet (Update View) – sulgeb akna Andmebaasi sirvimine (Browse Database) ja toob vaadatava loendi uuringu 

rakenduse vaaturisse. Kasutatakse vahetatavate uuringute akna jaoks.
6. Tühista (Cancel) – sulgeb akna Andmebaasi sirvimine (Browse Database) ilma loendis muudatusi tegemata.

1

2

3 4

6

5
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Andmebaasi sirvimise protseduur

Uuringuid saab vaadata valides neid kohalikust andmebaasist, lisades neid tarkvara suiteHEART® andmebaasi vaaturi loendisse ja 
klõpsates nupul Uuenda vaadet (Update View).

Uuringu lisamine tarkvara suiteHEART® vahetatavate uuringute loendisse

1. Klõpsake Fail (File) > Andmebaasi sirvimine (Browse DB).
2. Leidke uuring andmebaasi vaaturis ja klõpsake uuringul, et see esile tõsta.
3. Klõpsake Lisa vaaturisse (Add to Viewer).
4. Klõpsake Uuenda vaadet (Update View).
5. Uuring ilmub nüüd tarkvara suiteHEART® vahetatavate uuringute loendisse.

Uuringu eemaldamine tarkvara suiteHEART® vahetatavate uuringute loendist

1. Klõpsake Fail (File) > Andmebaasi sirvimine (Browse DB).
2. Leidke uuring ja klõpsake Eemalda vaaturist (Remove from Viewer).
3. Klõpsake Uuenda vaaturit (Update Viewer).

ETTEVAATUST! Ärge kustutage hetkel tarkvaras suiteHEART® avatud uuringut.

Et uuringuid vaaturis näha, tuleb need enne tarkvarasse suiteHEART® laadida. Vahetatavate uuringute loendurisse uuringute lisamise 
õppimiseks vt Andmebaasi sirvimise protseduur lk 20.

Tarkvara suiteHEART® sees uuringute vahetamine

1. Klõpsake Fail (File) > Vaheta uuringut (Switch Study).
Kuvatakse olemasolevate uuringute aken koos loendiga kõikidest uuringutest, mis on eelnevalt andmebaasi sirvimise 
protseduuriga laaditud.

2. Valige uuring.
Kui te ei soovi pärast vahetatavate uuringute akna avamist uuringuid vahetada, klõpsake rakendusse tagasipöördumiseks 
ükskõik kuhu väljapoole akent.
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Kujutisehalduse tööriistad

Vaatur
Vaatur võimaldab uuringu kiiret ülevaadet koos ristviidetega. Vaaturi liides kuvab valitud uuringu jaoks seeriate loendi, mis 
on omandatud valitud uuringu jaoks. Iga seeria kuvatakse vaateavas või võrdlusrežiimis. Analüüsi ja vaatamise jaoks 
vaaturi liideses saab luua uusi seeria tüüpe.

JOONIS 1. Vaatur 

1. Kujutise filter, 2. Seeria/kujutise loend, 3. Kujutise vaateavad, 4. Ristviitedd, 5. Ekspordi koostaja, 6. Ekspordi maatriks, 7. Salvesta seeriad, 
8. Ristviitedd, 9. Mõõtmistööriistad, 10. Leia tunnus

1 4

8

5

6

7

2

3

9
10



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3    22

Kujutise/seeriate sirvimine

Klõpsake seerial ja kasutage klaviatuuril klahve Page Up või Page Down, et seeria sees lõike sirvida.

Järgmisele seeriale liikumiseks vajutage paremnooleklahvile ja eelmisele seeriale liikumiseks vasaknooleklahvile.

Liikumisel mitmefaasilisse seeriasse kuvatakse need automaatse paigutusega, ühefaasilised seeriad 
kuvatakse 1×1 paigutusega.

Toetatakse vaateavas hiire kerimisrattaga navigeerimist. 1×1 vaateavas otse vaateavas topeltklõpsamine. Uuesti 
topeltklõpsamine naaseb vaateava taas kõikide piltide juurde. 

Leia tunnus*

1. Ristviidete tööriista kasutamiseks valige . 

Lilla kursor on primaarne kursor, mida saab kujutise peale asetada. 

2. Vajutage klahvi Ctrl ja valige ristlõigete tööriist primaarse kursori aktiveerimiseks. Kuvatakse automaatselt kõik 
lähedal asuva lõike asukohad. 

Peavaatesse ilmuvad ainult need lõigud, kus sekundaarne roheline kursor oli arvutuslikult primaarse lilla kursori 
lähedal. 

MÄRKUS. Vaateavadesse ilmuvad rohelised sekundaarsed ristmärkmed, mis sisaldavad mitteparalleelseid kujutisi ja 
nendes kohtades, mis on arvutatult 10 mm 3D kaugusel esmasest kursorist.

MÄRKUS. Vaateavadesse ilmuvad rohelised sekundaarsed ristmärkmed, mis sisaldavad paralleelseid kujutisi ja 
nendes kohtades, mis on arvutatult 5 mm 3D kaugusel esmasest kursorist.

*USA esmane patenditaotlus nr 62/923,061
Pealkiri: Method and System for Identifying and Displaying Medical Images
Leiutaja(d): Wolff et al.

Seeriate võrdlusrežiim

Uuringu kahe erineva seeria valimiseks valige . Täisrežiimi naasmiseks klõpsake .
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Laienda/kahanda seeriaid

Kõigi seeriate laiendamiseks klõpsake (+); kahandamiseks klõpsake (-). 

JOONIS 2. Laienda seeriaid

Kiirklahv              

Vaaturi funktsioonid

Uute seeriate loomine

Vaatur võimaldab luua uusi seeriate tüüpe, mida saab kasutada Funktsiooni (Function), Müokardi hindamise 
(Myocardial Evaluation), Müokardi perfusiooni (Myocardial Perfusion), T2*, T1 kaardistamise (T1 Mapping) ja T2 
kaardistamise (T2 Mapping) jaoks ning ainult ülevaatamiseks (kohandatud). Loodud seeriad lisatakse selle uuringu 
seeriate loendisse ja on tarkvara suiteHEART® rakenduses vaatamiseks ja analüüsimiseks saadaval.

MÄRKUS. Et seeria analüüsi jaoks sobiks, peab igal lõigu asukohal olema sama arv faase ning samad 
hõiveparameetrid ja skannimistasapinna ettekirjutus.

HOIATUS! Kasutaja vastutab selle eest, et analüüsimiseks loodud uued seeriad sisaldavad analüüsimiseks õigeid 
kujutisi. Ebaõigesti koostatud seeriaid saab analüüsida, kuid see võib anda ebaõigeid tulemusi. 
Kasutaja peab olema saanud südame analüüsimiseks korraliku väljaõppe ja ta peab olema teadlik 
lõikude asukohast, mis on uutesse seeriatesse kopeeritud. Ärge kustutage ära originaalkujutisi, mida 
kasutati DICOM-i importimiseks.

1. Valige seeriate loendist soovitud seeriad või lõikude asukohad.

2. Ühe seeria või lõigu asukoha lisamiseks valige seeriate rühm või lõigu asukoht ja klõpsake sellel kasutades klahvi Shift 
või Ctrl.

3. Klõpsamine ja lohistamine võimaldab kujutisi vaateavades järjestada.

4. Vaateavast kujutise kustutamiseks valige vaateava ja vajutage klaviatuuril kustusklahvi.

5. Valige  Salvesta seeria (Save series) paanil Joonis 3.

Funktsioon Tegevus
Vali vaatamiseks uuesti kõik kujutised Ctrl + A
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JOONIS 3. Seeriate salvestamise paan

6. Sisestage seeria nimi rakenduse seeriate kirjeldusse (Series description). 

7. Valige rippmenüüst seeriale sobivat tüüpi rakendus (Joonis 4). Kui on valitud Kohandatud (Custom), saab seeriatena 
salvestada erineva skannimistasapinnaga ja järjestustüüpidega kujutisi.

JOONIS 4. Uute seeriate salvestamine

Vaatamisprotokollid

Saadaval vaid siis, kui seda taotletakse NeoSoftilt.

Aruandlus

Aruandlusele ligipääsemiseks või vaaturi funktsiooni juurde tagasi pöördumiseks klõpsake .

Ekspordi koostaja

Vahekaart Ekspordi koostaja (Export Composer) võimaldab eksportida piltide, graafikute ja polaargraafikute jaoks video/
kujutise failitüüpe. Lisaks saab luua DICOM-faile, mida saab arhiivida ja PACS-is vaadata. 

1. Valige vahekaart Ekspordi koostaja (Export Composer).

2. Valige maatriksis vaateavade arv.

3. Valige eksporditava faili tüüp. (Joonis 5)

JOONIS 5. Koostaja eksportimise valikud

MÄRKUS. Kui valite suvandi „DICOM“, luuakse sekundaarne hõivefail, mis asub selle uuringu seeriate loendi all. 
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4. Filmide või failivormingute salvestamiseks klõpsake  ja valige kataloog. 

MÄRKUS. Kujutiste eksportimisel AVI- või MOV-failidesse seab tarkvara suiteHEART® maksimaalseks 
kaadrisageduseks 20 kaadrit sekundis, olenemata rakenduses vaatamiseks kasutatavatest seadistustest.

TÄHTIS!  Video kujutiste eksportimisel peab faaside arv ühtima. 

5. Faili leidmiseks valige .

6. Valige seeriate loendist soovitud seeriad või lõikude asukohad.

7. Üksiku kujutise maatriksisse teisaldamiseks vasakklõpsake kujutise vaateavas otse kujutise vaateava ja lohistage 

maatriksile või paremklõpsake ja valige .

8. Seeriate või lõikude asukohtade rühma maatriksisse teisaldamiseks tehke Shift + klõps otse pildi vaateaknas, seejärel 

klõpsake ja lohistage piltide rühm maatriksile või paremklõpsake ja valige . 

9. Graafikute, polaardiagrammide teistest analüüsirežiimidest eksportimiseks paremklõpsake ja valige .

10. Kujutise, graafiku või polaardiagrammi maatriksist eemaldamiseks klõpsake pildi vaateaval ja vajutage klaviatuuril 
klahvi Kustuta või klõpsake nuppu Lähtesta (Reset). 

11. Kujutiste, graafikute või polaardiagrammide eksportimiseks nii, nagu need maatriksis kuvatakse, klõpsake 

.
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Võrdlusrežiim
Võrdlusrežiim annab võimaluse vaadata praeguse või eelneva uuringu kujutisi/seeriaid ühel ajal samas liideses.

MÄRKUS. Eelnevast uuringust aruandlusse saadetud kujutised on võrdlusrežiimis bittrastervormingus. Nende 
kujutiste töötlemine ei ole võimalik.

HOIATUS! Enne uuringute (või uuringu seeriate) ülevaatamist või võrdlemist veenduge visuaalselt, et uuringu 
patsiendi kogu indikaatoriteave on mõlemas vaaturis sama. 

JOONIS 6. Vaaturi võrdlusrežiim

1 2

Vaatur 1

Vaatur 2

3

4 5

6
7 8

10
9

12

11
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Vaatur Tähis Kirjeldus
Vaatur 1 1 Seeriate rippmenüü

2 Seeriate valija
3 Hetkel vaadatava patsiendi uuringu indikaatorrida
4 Kujutise juhtnupp
5 Vaateava paigutuse valikud

Vaatur 2 6 Hetkel vaadatava patsiendi uuringu indikaatorrida
7 Uuringuvalija 
8 Seeriate valija 
9 Vaateava paigutuse valikud

Mõlemad vaaturid 10 Muuda ulatuse sätteid
11 Vaaterežiimi lüliti
12 Video sünkroonimise lülitamine
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Töövoo näidis
1. Topeltklõpsake suvalises analüüsirežiimis redaktori aknal.

2. Valige , et jagada liides kaheks vaaturiks, nagu näitab Joonis 6.

3. Vahetage vaaturis 1 seeriaid, kasutades seeriate valimise rippmenüüd või parem-/vasaknooleklahvi.
• Ülemine vaatur kuvab alati praegust uuringut, mis on varasemalt käivitatud. 

4. Vaaturiga 1 võrdlemiseks valige vaaturile 2 sama uuringu sees olev teistsugune seeria, kasutades seeriate 
rippmenüüd. 

• Kui mistahes vaaturis on vaateava valitud ja lõik on paralleelne näiteks lühikese telje seeriaga, tuuakse lähtuvalt lõigu 
asukohast vastav lõik esile.

JOONIS 7. Seeriate rippmenüü, vaatur 2

5. Kasutage uuringuvalijat, et võrrelda vaaturis 1 olevat praegust uuringut ja vaaturis 2 olevat muud uuringut.

JOONIS 8. Uuringuvalija, vaatur 2

6. Veenduge õige uuringu valikus, kontrollides mõlema vaaturi uuringu indikaatoriteavet.

JOONIS 9. Uuringu indikaatoriteave

7. Kui teete mistahes vaaturil paremklõpsu, avatakse kujutise töötlemise tööriistad.
• Ulatuse valik kehtib mõlemale vaaturile.

MÄRKUS. Kui kujutis on mõnest teisest uuringust, ei sobi kujutise asukoha määramine kujutiste vahekaardilt. 

MÄRKUS. Kui mõlemas vaaturis on valitud seeria jaoks video ja mõlemas seerias on sama arv faase, klõpsake videode 

vaate sünkroonimiseks .
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Eelistuste määramine
Vt Lisa A: kasutaja taseme eelistused lk 202.

Kui valite tarkvara suiteHEART® liidese menüüribal Tööriistad (Tools) > Eelistused (Preferences), kuvatakse viis suvandit: 

• Redigeeri (Edit)
• Redigeeri süsteemi (Edit System) (ainult administraator)
• Impordi (Import) (ainult administraator)
• Kopeeri (Copy)
• Ekspordi (Export)

TÄHTIS! Soovitav on sätestada kasutaja eelistused enne esimese juhu aruandluseks analüüsimist. Et eelistused 
jõustuksid, sulgege praegune uuringu ja sulgege ning taaskäivitage suiteDXT. 

MÄRKUS. Üksiku kasutaja režiimis saab halli värvi suvandeid muuta ainult administraator.

Seadete eelistused
Vahekaart Üldine (Global) – eelistusi saab isikupärastada järgmiste funktsioonide osas. 

• Aruanne
• Vaatur
• Virtual Fellow®
• Aruannete lubatud kinnitajad
• Üldine
• Müokardi hindamine
• Jõudeoleku taimer
• Vool
• Seeria filter

Mallide vahekaart – loob tulemuste parameetrite vahemike mallid aruannetes kasutamiseks.

Makro vahekaart – võimaldab luua teksti eelvalikuid aruande jaotiste Mulje (Impression), Tehnikad (Techniques), 
Anamnees (History) ja Leiud (Findings).

Printimise vahekaart – järjestab ja valib tulemuste parameetrid aruannete jaoks.

Virtual Fellow® vahekaart – valib vaatamise eelistused.

Funktsiooni vahekaart – valib vaatamise ja analüüsimise eelistused.

T1/T2/T2* vahekaart – valib vaatamise ja analüüsimise eelistused.

Aruandluse vahekaart – menüüpõhiste tekstivalikute redigeerimine ja kategooriate vahemike konfigureerimine automaatse 
eeltäitmise funktsiooni jaoks.

 Automaatne seeriate koostamine – T1 ja T2 kaardistamine.
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Vahekaart General (Üldine)

Valik Lähtesta (Reset) vahekaardi ülemises paremas nurgas tühjendab kõik kasutaja valikud.

Aruanne 

Konfigureerige aruande päise teave.

JOONIS 1. Aruande eelistused

Aruande eelistuste valikud

Nende toimingute jaoks on vajalik administraator.

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System). 
2. Valige vahekaart Üldine (General).
3. Paigutage kursor paanil Aruande (Report) soovitud väljale ja sisestage teave. 

Kindla paberisuurusega aruandele ilmuvad pealkirjad, päised ja logo. Aruandest selle teabe väljajätmiseks tühjendage 
märkeruut „Kasuta allpool toodud väljade väärtusi aruandes“ (Use the field values below in Report). See jõustub kõikide 
patsientide aruannete kohta, mis välja prinditakse. 
Märkeruudu „paaris ja paaritute ridade tugi“ (support even and odd row) tõstab liideses ja aruandes esile 
tulemuste read.

4. Aruandesse asukoha logo lisamiseks kasutage JPEG-, PNG- või GIF-vormingus faili ja salvestage see kõvakettale või CD-
ROM-ile. Valige logo jaotise alt Lehitse (Browse) ja leidke süsteemi lehtiseja aknas faili asukoht. Valige õige logoga fail 
ja valige Ava (Open). 

Logo peaks nüüd aruande eelistuste paanile ilmuma.
5. Klõpsake suvandit Uuringu faili nimi (Exam File Name), et konfigureerida eksporditava aruande faili nimi.
6. Valige Salvesta ja välju (Save and Exit). 

Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel). 
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Vaatur

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2. Valige vahekaart Üldine (General).

3. Valige märkeruut Laienda seeriaid vaaturis (Expand series in Viewer).

4. Valige käivitamisel märkeruut Esita video vaaturis (Play cine in Viewer).

5. Kasutage liugurit, et reguleerida faasikontrastsuspiltidel värvülekatte kiirust.
Värvülekatte eemaldamiseks seadke läbipaistmatus 0% peale.

Virtual Fellow®

JOONIS 2. Virtual Fellow® eelistused

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2. Valige vahekaart Üldine (General).

3. Valige märkeruut Ava uuring rakenduses Virtual Fellow® (Open study in Virtual Fellow®), et avada uuring otse 
rakenduses Virtual Fellow®. 

4. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

Aruannete lubatud kinnitajad

Rakendusel on aruannete kinnitamise funktsioon, mis lukustab lõpliku aruande. Kui aruanne on kinnitatud, ei saa seda 
enam muuta. Kinnitajaid saab lisada, muuta ja kustutada.

JOONIS 3. Aruannete lubatud kinnitajad
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Aruannete kinnitajate haldamine

Kinnitajate lisamiseks või kustutamiseks on vajalik administraator.

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System). 

2. Valige vahekaart Üldine (General) ja paigutage kursor paanile Aruannete lubatud kinnitajad (Authorized Report 
Approvers). 

3. Kasutaja nime lisamiseks lubatud kinnitajate nimekirja valige Lisa (Add) vahekaart.
• Sisestage kasutaja nimi.
• Sisestage kaks korda parool.
• Valige sobivad automaatse ekspordi sihtkohad (Auto Export Destinations).

- Eksporditakse automaatselt koos uuringu kinnitamisega. 
• Valige Lisa (Add). 

4. Lubatud kinnitajate loendis oleva kasutaja parooli muutmiseks valige vahekaart Muuda (Modify).
• Valige muutmiseks kasutaja.
• Sisestage vana parool.
• Sisestage kaks korda uus parool.
• Valige Rakenda (Apply).

5. Kasutaja kustutamiseks lubatud kinnitajate loendist valige Kustuta (Delete) vahekaart.
• Valige kustutatav(ad) kasutaja(d).
• Valige Kustuta (Delete).

6. Valige Salvesta ja välju (Save and Exit).
• Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

Üldine

JOONIS 4. Üldised eelistused
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Üldiste eelistuste valikud

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2. Valige vahekaart Üldine (General).

3. Märkuste joone paksuna nägemiseks valige märkeruut Paksu joonega märkus (Thick Line Annotation).

4. Vabakäelise ROI automaatseks muutmiseks punktsplainiks valige märkeruut Automaatne vabakäe konverteerimine 
punktsplainiks (Automatic Free Hand to Point Spline Conversion).

5. Liidese tööriistavihjete nägemiseks valige märkeruut Kuva tööriistavihjed (Display Tooltips).

6. Aruandes patsiendi nime ja ID peitmiseks valige märkeruut Anonümiseeri patsient (Anonymize Patient).
Kõigi patsientide nimedena kuvatakse „anonymous“ ja ID on tühi. Neid muudatusi rakendatakse aruandele ja 
kujutisevaaturile.

7. Aruande eksportimiseks pärast kinnitamist DICOM-failina valige märkeruut Kinnitatud uuringu automaatne eksport 
(Automatically Export Approved Exam). (ainult administraator)

8. Valige märkeruut Mitme lõiguga kujutised aruandesse (Multi-Slice Image to Report), et lisada 
paremklõpsumenüüsse mitmekaadriliste lühikese telje kujutiste rühma lisamise suvand.

9. Kui märkmed on välja lülitatud ja soovite näha lõigu asukohta, valige märkeruut Näita alati lõigu asukohta (Always 
show slice location).

10. Valige vaikimisi FOV jaoks märkeruut Max FOV vaikeväärtus (Default Max FOV).

11. Kasutaja muudetud ROI tagasiasetamiseks pärast levitamist valige märkeruut Asenda kasutaja muudetud ROI 
(Replace User Edited ROI).

12. ROI redigeerimiseks valige redigeerimisrežiimis märkeruut Säilita endo/epi ROI (Persist Endo/Epi ROI edit mode).

13. Määrake ROI redigeerimisrežiim (ROI Edit Mode).

14. Seadistage Ulatuse (Scope) valik kujutise töötlemiseks faili rippmenüüst.

15. Seadistage Mõõtühikute süsteem (Measurement System), valige rippmenüüst Tollmõõdustik (Imperial) või 
Meetermõõdustik (Metric).

16. Seadistage Lineaarse mõõtmise ühik (Linear Measurement Unit) kas cm või mm.

17. Seadistage rippmenüüst Algse märkuse redigeerimise režiim (Initial Annotation Editing Mode). 
Valikus on valikud Ei ühtegi (None), Müksamise tööriist (Nudge Tool) või Tõmbamise tööriist (Pull Tool).

18. Seadistage rippmenüüs Kuupäeva ja kellaaja vorming (Date & Time Format).
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Müokardi hindamine

JOONIS 5. Müokardi hindamise eelistused

Nende toimingute jaoks on vajalik administraator.

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System).

2. Valige vahekaart Üldine (General).

3. Valige analüüsi jaoks suvand Meetod (Method): Automaatne (Auto), Täieliku laiuse poolik maksimum (Full Width 
Half Max), Standardhälve (Standard Deviation).

4. Mõõtetulemuste siltide määratlemiseks vt Mõõtetulemuste siltide määramine lk 122.

5. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

Jõudeoleku taimer 

Paan Jõudeoleku taimer (Idle Timer) seadistab minutites ajavahemiku, mil rakendus peale mittekasutamist sulgub. 

JOONIS 6. Jõudeoleku taimeri seadistused

Jõudeoleku taimeri valikud

Nende toimingute jaoks on vajalik administraator.

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System). 

2. Valige vahekaart Üldine (Global) ja paigutage kursor paanile Jõudeoleku taimer (Idle Timer). 

3. Taimeri funktsiooni lubamiseks valige märkeruut Jõudeoleku taimer (Idle Timer).

4. Lohistage jõudeoleku taimeri marker soovitud ajavahemikule minutites. 

5. Valiku salvestamiseks valige Salvesta ja välju (Save and Exit). 
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel). 
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Vool

JOONIS 7. Voolu eelistused

Voolu eelistuste valikud

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2. Valige vahekaart Üldine (General).

3. 2D ja 4D faasikontrastse automaatse faasivea korrigeerimiseks valige märkeruut Automaatne algtaseme 
korrigeerimine (Auto Baseline Correction). (ainult administraator)

4. Valige märkeruut Regurgitatiivne režiim: Automaatne (Regurgitant Mode: Auto), et arvutada automaatselt 
negatiivset netovoolu (allpool x-telge). (ainult administraator)

5. Korrigeerimise automaatseks rakendamiseks valige märkeruut Diskreetmoonutuse korrigeerimine on vaikimisi sees 
(Aliasing Correction on By Default). (ainult administraator)

6. Määrake Voolu 1 (Flow 1), Voolu 2 (Flow 2), Voolu 3 (Flow 3) või Voolu 4 (Flow 4) kategooria sildid, sisestades uue 
sildi. 

Neid silte kuvatakse voolu liideses kohtspikritena.

7. Valige rippmenüüst sobiv Voolu ühik (Flow Unit) – ml löögi kohta või l/min või mitte ühtegi. (ainult administraator)

8. Valige integreeritud voolu paanil arvutamise meetodi säilitamiseks Vaikemeetod (Default Method). (ainult 
administraator)

9. Kasutage Voolu värvi läbipaistmatuse (Flow Color Opacity) reguleerimiseks liugurit.
Värvülekatte eemaldamiseks seadke läbipaistmatus 0% peale.

10. Valige Salvesta ja välju (Save and Exit).
 Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).
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Seeria filter

Analüüsirežiimi tüüpide põhjal saab analüüsiks sobilike seeriate valimise kiirendamiseks rakendada seeria filtrit. Filtri 
eelistusi saab valida ka analüüsi ajal, klõpsates peamenüü pisipiltide vaate kohal filtri nupul. 

JOONIS 8. Filtri eelistused

Filtri eelistuste seadistamine

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2. Valige vahekaart Üldine (General).

3. Klõpsake igale analüüsitüübile sobiv sisse/välja valik.

4. Valige Salvesta ja välju (Save and Exit). 
• Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel). 

Mallide vahekaart

Administraatorile saadaval lisafunktsioone vt Lisa A: kasutaja taseme eelistused lk 202.

Rakendus pakub tööriista, millega luua malle, mis põhinevad kasutaja määratletud normvahemikel, mis on määratud vanuse 
ja soo järgi. Z-skooride arvutamist ja aruandlust toetatakse kasutaja määratletud malli alusel. Vt soovitatud allikaid.

JOONIS 9. Mallide vahekaart

MÄRKUS. Kui seeriale rakendatakse filtrit ja soovitud seeriat ei ole, 
ilmub tekst: „Valitud analüüsitüübiga seotud seeriaid ei ole“ (There are 
no series associated with the selected analysis type). Klõpsates OK 
filter tühistatakse ja kuvatakse kõik .uuringu seeriad.
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Kaalutlused

Enne analüüsi alustamise tuleb pealiidesest valida kasutaja määratud mall. Klõpsake paremal üleval olevat Vaikimisi 
(Default) nuppu ja valige soovitud mall. Malli muutmine pärast analüüsi tegemist rakendab mallis määratud 
normvahemiku ja/või Z-skoori.

JOONIS 10. Malli muutmine

MÄRKUS. Varasema suiteHEART-analüüsiga imporditud uuringud võivad näidata malli, mida kasutati selles uuringus. 
See mall ei pruugi olla muude uuringute jaoks saadaval.

Kui analüüsiks kasutatakse kahte süsteemi, on soovitatav luua esimeses süsteemis mallieelistuste fail ja seejärel importida 
teise süsteemi. Teisest süsteemist imporditud mallieelistuste failid kirjutavad mallieelistused üle, kui need on selles 
süsteemis juba loodud.

Malli loomine

HOIATUS! Normvahemike ja Z-skooride parameetrite jaoks sisestatud väärtuste sobivuse eest vastutab 
ainuisikuliselt kasutaja. Enne analüüsimist veenduge, et kõik sisestused on õiged. Valed väärtused 
võivad põhjustada valediagnoosi.

Kõik uued mallid luuakse algselt vaikemalli dubleerimise teel. Vaikemall ei ole muudetav. 

1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). 

2. Valige Malli (Template) vahekaart.

3. Klõpsake suvandit Loo uus (Create New), et luua mall või dubleerida seda.
Vanus on vaikemäärang.

JOONIS 11. Mallide valikute loomine

4. Sisestage mallile uus nimi. 
Uue nime sisestamisel lahtrisse Praegune mall on (The Current Template is) uuendatakse rippmenüüd.
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JOONIS 12. Mallide vahekaardi näide – näidatakse lühikese telje funktsiooni

1. Praegune mall, 2. Vanuse vahemiku riba, 3. Tulemuste parameetrid analüüsitüübi kohta, 4. Meeste Z-skoori BSA piirid, 
5. Meeste alumised ja ülemised piirid,  6. Meeste Z-skoori parameetrid, 7. Naiste Z-skoori BSA piirid, 8. Naiste alumised ja ülemised piirid, 
9. Naiste Z-skoori parameetrid

5. Valige soovitud rakenduse analüüsitüüp, millele mall luua.

6. Kui soovite kasutada vanusevahemikke, paremklõpsake vanusevahemiku ribal, et luua vanusevahemiku jaotur.
Vanusevahemiku jaotusribasid saab lohistada ja kohandada soovitud vanusevahemiku jaoks.
Saate luua mitu vanusevahemiku jaotusriba.
Vanusevahemiku jaotusribasid saab kustutada, asetades kursori riba lähedale ja valides paremklõpsumenüüst Kustuta 
vahemik (Delete Range).

7. Sisestage sobiva analüüsirežiimi normvahemiku väärtused ja nii alumine kui ka ülemine piir.

8. Vajadusel eristage meeste ja naiste väärtusi. Kasutage sugude vahel väärtuste kopeerimiseks nooli Kopeeri kõik (Copy 
all). Kasutage kerimisriba, et liikuda selle analüüsitüübi täieliku mõõtmiste loendi juurde.

9. Kui tuleb arvutada z-skoore, peab kasutaja sisestama väärtused a, b ja SD ning BSA piirid.

Aruandluse prioriteet on välja toodud allolevas tabelis. Olenevalt olukorrast kuvatakse mõõtetulemuste tabelites kas 
normvahemik või arvutatud z-skoor.

1

2

3

4
5 6

7
8 9
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HOIATUS! Normvahemike ja Z-skooride parameetrite jaoks sisestatud väärtuste sobivuse eest vastutab 
ainuisikuliselt kasutaja. Enne analüüsimist veenduge, et kõik sisestused on õiged. Valed väärtused 
võivad põhjustada valediagnoosi.

10. Kõikide sissekannete salvestamiseks valige Salvesta ja välju (Save and Exit).
- Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

MÄRKUS. Malli sobivuse tagamiseks tuleb parameetrite väärtused sisestada numbritena, sisestades nii ülemised kui 
ka alumised väärtused. Kui väärtustes leitakse ebakõlasid, kuvatakse järgmine teade „Valitud on sobimatu 
normvahemik (Invalid normal range selected). Parandage ja salvestage uuesti (Please correct and save 
again).” Parandust vajav parameeter tõstetakse esile punasega. Tühja malli salvestamine ei ole lubatud ja 
sel juhul kuvatakse teade „Malle ei saa salvestada“ (Unable to Save Template(s)).

MÄRKUS. Voolu vahekaardile sisestatud normvahemikud kehtivad nii 2D kui ka 4D voolu analüüsi tulemuste kohta.

Soovitatud allikad

Buechel EV, Kaiser T, Jackson C, Schmitz A, Kellenberger CJ. „Normal right- and left ventricular volumes and myocardial mass in 
children measured by steady state free precession cardiovascular magnetic resonance.“ J Cardiovasc Magn Reson. 2009 Jun 
21;11(1):19. doi: 10.1186/1532-429X-11-19. PMID: 19545393; PMCID: PMC2718870.

Kawel-Boehm, N., Hetzel, S.J., Ambale-Venkatesh, B. et al. „Reference ranges (“normal values”) for cardiovascular magnetic resonance 
(CMR) in adults and children: 2020 update.“ J Cardiovasc Magn Reson 22, 87 (2020). https://doi.org/10.1186/s12968-020-00683-3

Aruandest/arvutatud Tingimus

z-skoor; arvutatud Kui z-skoori parameetrid on sisestatud ja BSA on piirides.

Teatatakse normvahemik Kui z-skoor ja normvahemik on sisestatud ja BSA on väljaspool 
piire.

Teatatakse normvahemik Ainult siis, kui normvahemik on sisestatud.

Ei arvutata normvahemikku ega z-skoori Kui z-skoori parameetrid on sisestatud. Normvahemikku ei 
sisestatud ja BSA on piiridest väljas.

Ei arvutata normvahemikku ega z-skoori Sisestatud pole z-skoori parameetreid ega normvahemikku.
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Makro vahekaart

Saate luua kohandatud aruandemakrosid, mida saab automaatselt arvutatud väärtustega täita. Makrod on mallidest 
sõltumatud, kuna loodud makrod on kõigile kasutajatele kättesaadavad.

Makrosid saab luua aruande järgmiste jaotiste jaoks:

• mulje
• tehnika
• anamnees
• leiud

Muljete makro lisamine

MÄRKUS. Ajaloo või tehnika makro loomine käib samade sammude järgu, mis kuvamise makro loomisel.
1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2. Valige vahekaart Makro (Macro).

3. Valige Lisa muljete makro (Add Impressions Macro). 
Makro paanile ilmub uus tekstiväli.

JOONIS 13. Muljete makrode aken

4. Paigutage kursor uuele tekstiväljale ja muutke nime vastavalt soovile.

MÄRKUS. Loodud makrosid saab ümber järjestada. Klõpsake soovitud makrol ja lohistage see loendis uude kohta.

Makro teksti sisestamine
1. Paigutage kursor makro teabe tekstikasti ja sisestage vastav tekst.

2. Parameetri tulemuse sisestamiseks valige mõni allpool olevatest analüüsi vahekaartidest ja valige soovitud 
parameetri nupp, mis sisestatakse automaatselt makro teabesse. Selles näites valiti parameeter LV väljutusfraktsioon 
(LV Ejection Fraction) ja sisestati see teksti lõppu.

JOONIS 14. Makro teave
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JOONIS 15. Makro parameetrite tulemuste valik 

3. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

Makro rakendamine

Makro rakendamise eeltingimusena tuleb analüüsi tulemused genereerida enne tulemuste parameetreid sisaldavate 
makrode rakendamist. Aruande loomise automatiseerimiseks saab luua tehnika- ja muljetemakrosid.

MÄRKUS. Kui makro sisaldab parameetri tulemust, mida on analüüsirežiimis muudetud, peab makro olema 
uuesti valitud, et kajastada uuendatud tulemust.

Makro kustutamine
1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2. Valige vahekaart Makro (Macro).

3. Valige loendist makro. 

Näites on kustutamiseks valitud makro nimega Funktsioon (Function).

JOONIS 16. Makro valimise loend

4. Valige Eemalda valitud makro(d) (Remove Selected Macro(s)).
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Printimise vahekaart

Iga analüüsirežiimi arvutatud tulemusi saab aruandes kaasamiseks ja järjestamiseks konfigureerida Prindi (Print) 
vahekaardil.

JOONIS 17. Printimise eelistused 

1. Valige menüüst Tööriistad (Tools) > Eelistused (Preferences) > Prindi (Print).

2. Valige sobiv analüüsi vahekaart ja valige soovitud tulemus, mida aruandesse lisada.

3. Aruandes loetletud tulemuste järjekorda saab muuta, klõpsates otse tulemusel ja lohistades selle loendis uude kohta. 

4. Tehke samamoodi igal analüüsirežiimi vahekaardil.

5. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

MÄRKUS. Kui printimise valikud tehakse otse rakenduse liideses, ei salvestata neid malliga.

MÄRKUS. Kui mõõtmiste järjekorda muudetakse otse liideses, siis muudatust malliga ei salvestata.

MÄRKUS. Funktsiooni analüüsis Muu (Other) all loodud kasutaja määratud mõõtmised kuvatakse Printimiseelistuste 
vahekaardil Muu (Other). Neid mõõte saab uuesti järjestada.



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3           43

Virtual Fellow® vahekaart

JOONIS 18. Virtual Fellow® eelistused

1.  Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2.  Valige vahekaart Virtual Fellow®.

3. Valige pikitelje vaadeteks Apikaalne suund (Apical Direction). (ainult administraator)

4. Valige müokardi hindamiseks kuvatavad kas Faasi (Phase) või Magnituudi (Magnitude) seeriad.

5. Valige müokardi perfusiooniks kuvatavad kas MOCO, NO MOCO, või KAARDI (MAP) seeriad 

6. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).
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Funktsiooni vahekaart

JOONIS 19. Funktsiooni eelistused

1. Valige kujutisevaaturi menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2. Valige vahekaart Funktsioon (Function).

3. Ainult MAPSE ja TAPSE arvutamiseks valige märkeruut Rakenda MV ja TV rõngas (Apply MV and TV Annulus). (ainult 
administraator)

4. Põhimiku interpoleerimise jaoks rõnga automaatseks sisestamiseks valige märkeruut Rakenda MV rõngas ja TV 
rõngas (Apply MV Annulus and TV Annulus) ning Rakenda põhimikujoone interpoleerimine (Apply Basal Line 
Interpolation). (ainult administraator)

5. Valige märkeruut Vatsakese keskosa interpoleerimine (Mid Ventricular Interpolation) funktsiooni analüüsiks. (ainult 
administraator)

6. Telje vahetamiseks valige märkeruut Vaheta maatriksrežiimi jaoks omavahel teljed x(lõik) ja y(faas) (Flip x(slice) and 
y(phase) axis for matrix mode).

7. Mõlema kõvera kuvamiseks valige märkeruut Võimalda LV (Enable LV) või RV varju kõver (RV Shadow Curve).

8. Funktsiooni segmenteerimiseks valige märkeruut Säilita funktsiooni analüüsi tööriistad automaatselt (Persist 
analysis tools for Function Auto).

9. Redigeerimiseks valige redigeerimisrežiimis märkeruut Säilita endo/epi ROI (Persist Endo/Epi ROI). 
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10. Valige märkeruut Lõikude vahel liikumise korrigeerimise (Motion Correction Between Slices), et pääseda sellele 
funktsioonile juurde funktsiooni analüüsis; vt Liikumise korrigeerimine seeriate vahel lk 73. (ainult administraator)

11. Valige märkeruut Koja mahu silt (Atrial Volume label: MaxV, MinV): MaxV, MinV, et muuta mahusilte.

12. Valige märkeruut Kodade täiustatud mõõtmised (Atria Advanced Measurements), et kuvada kõik kodade 
tulemused. 

13. Valige vahekaart Kuva RV E/A (Display RV E/A) funktsiooni analüüsiks.

14. Valige vahekaart Luba mitme seeria eeltöötlus (Enable preprocessing for multiple series), et eeltöödelda mitu 
funktsiooni seeriat. (ainult administraator)

15. Seadistage alumine ja ülemine piir valikus Piirkonna analüüsi polaardiagrammid (Regional Analysis Polar Plots).

16. Määrake eelistused Kodade kiireks (Atria Fast) analüüsimiseks.

17. Määrake eelistused suvandile Kojad: lühike telg (Ventricles: Short Axis).

18. Määrake eelistused suvandile Kojad: pikk telg (Ventricles: Long Axis).

19. Valiku salvestamiseks valige Salvesta ja välju (Save and Exit). 
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel). 

Pinge eelistused vajavad uurimislepingut. 

T1/T2/T2* vahekaart

JOONIS 20. T1/T2 T2* eelistused

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
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2. Valige vahekaart T1/T2/T2*.

3. Analüüsiks sobiva seeria loomiseks valige hankija tüübi jaoks sobiv suvand, seejärel valige vahekaart Koosta 
analüüsiks automaatselt seeria (Auto Compose Series for Analysis). (ainult administraator)

4. Endo/Epi Nihe (Endo/Epi Offset) on seadistatud 1 ja –1, kus 1 võrdub 0,25 piksliga. (ainult administraator)

5. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

T1 kaardistamine
1. T1 kaardistamisel valige järjestuse tüübiks ajaseeriate analüüsimisel MOLLI või Saturatsiooni taastumine (Saturation 

Recovery). (ainult administraator)

2. Värvikaardi automaatseks kuvamiseks valige Ajaseeriate ülekate (Time Series Overlay) või Kaardi ülekate (Map 
Overlay).

3. Sisestage ICF, vt T1 kaardistamise analüüs lk 136. (ainult administraator)

4. Valige Välja tugevus (Field Strength) ja seadistage värvikaardi tüüp ning skaala väärtused kas 1,5 T või 3 T.

5. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

T2 kaardistamine
1. Ajaseeriate analüüsiks valige sobiv Parameetri sobivuse (Parameter Fit) arvutamine. (ainult administraator)

2. Värvikaardi automaatseks kuvamiseks valige Ajaseeriate ülekate (Time Series Overlay) või Kaardi ülekate (Map 
Overlay).

3. Valige Välja tugevus (Field Strength) ja seadistage värvikaardi tüüp ning skaala väärtused kas 1,5 T või 3 T.

4. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

T2*

Valige Parameetrite sobitamine (Parameter Fit). (ainult administraator)

Aruandluse vahekaart

Nende toimingute jaoks on vajalik administraator.

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System).

2. Valige Aruandluse (Reporting) vahekaart.

3. Klõpsake vastaval väljal, et muuta menüü kirjelduste vaiketeksti, nagu näidatud Joonis 21.

4. Lisage parameetri tulemus koos tekstiga, valides õige analüüsi vahekaardi ja klõpsates soovitud parameetril, nagu 
näidatud Joonis 21. 

5. Parameetri tulemuse eemaldamiseks pange kursor sisestatud tulemuse järele ja vajutage kustutusklahvi.
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JOONIS 21.   Aruandluse eelistused

6. Vaiketeksti taastamiseks klõpsake .

7. Menüü valikuga seotud parameetritulemuse aruannete kategooriate vahemike määramiseks klõpsake .

8. Valige seotud analüüsi vahekaardilt sobiv parameetri tulemus. 

9. Valige Absoluutne (Absolute) või Nihe (Offset) .

Valik Kirjeldus

Absoluutne Vahemikud põhinevad soo absoluutväärtustel olenemata 
vanusest. 

Nihe Vahemikud põhinevad sellel, kui suur on nihe mallis määratud 
normvahemikust vastava vanuse korral.  

Vaiketekst 

Analüüside vahekaart

Parameetri tulemuse valik 

redaktori väljad
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10. Sisestage kategooriate vahemikele sobivad väärtused. Aruande kategooria eemaldamiseks klõpsake värviribal, riba 
muutub halliks ja väärtus kaob. Joonis 22. 

JOONIS 22. Aruande kategooria eemaldamine

MÄRKUS. Kategooriate vahemike täitmine võimaldab aruande automaatset eeltäitmist. Tekst eeltäidetakse vastavalt 
kasutaja määratud väärtustele. Kui aruande tegemise ajal tehakse menüü liidesest valik, siis eeltäitmise 
funktsioon enam ei tööta.

MÄRKUS. Järgmiste parameetritulemuste eeltäidetud teksti jaoks on vaja, et kasutaja teeks vastava analüüsi: kodade 
mahud, hüpertroofia: maksimaalne seina paksus, T2*, klapi stenoos, klapi regurgitatsioon.

11. Aruande kategooriate vahemike lähestamiseks ja väärtuse valimiseks klõpsake .

Hüpertroofia kategooriate määramine

Hüpertroofia aruannet võib edasi määratleda kui kontsentrilist või ekstsentrilist. Kategooriate vahemike jaoks tuleb 
sisestada väärtused ja lisada meeste ning naiste kontsentrilisuse väärtused. Vt Joonis 23.

JOONIS 23. Hüpertroofia kategooria vahemikud ja kontsentrilisus 

Soovitatud allikad
Petersen SE, Khanji MY, Plein S, Lancellotti P, Bucciarelli-Ducci C. „European Association of Cardiovascular Imaging expert consensus 
paper: a comprehensive review of cardiovascular magnetic resonance normal values of cardiac chamber size and aortic root in adults 
and recommendations for grading severity.“ Eur Heart J Cardiovasc Imaging. 2019 Dec 1;20(12):1321-1331. doi: 10.1093/ehjci/jez232. 
Erratum in: Eur Heart J Cardiovasc Imaging. 2019 Dec 1;20(12):1331. PMID: 31544926.

Petersen, S.E., Aung, N., Sanghvi, M.M. et al. „Reference ranges for cardiac structure and function using cardiovascular magnetic 
resonance (CMR) in Caucasians from the UK Biobank population cohort.“ J Cardiovasc Magn Reson 19, 18 (2017). https://doi.org/
10.1186/s12968-017-0327-9

Kontsentrilisuse allikad 
Khouri MG, Peshock RM, Ayers CR, de Lemos JA, Drazner MH. „A 4-tiered classification of left ventricular hypertrophy based on left 
ventricular geometry: the Dallas heart study. Circ Cardiovasc Imaging.“ 2010 Mar;3(2):164-71. doi: 10.1161/
CIRCIMAGING.109.883652. Epub 2010 Jan 8. PMID: 20061518.
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Impordi eelistused 

Nende toimingute jaoks on vajalik administraator. 

MÄRKUS. Importimisel kõik praegused eelistused kustutatakse.
1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Impordi (Import).

JOONIS 24. Impordi eelistused

2. Valige Sirvija (Browse) nupp, valige eelistuste faili asukoht ja valige seejärel nupp Ava (Open).

3. Määratud impordi tegemiseks valige OK.
 Väljumiseks ilma importimata valige Tühista (Cancel).

MÄRKUS. Eelistuste importimist tarkvara suiteHEART® varasematest versioonidest (4.0.4 või vanemad) ei toetata. 
Abi saamiseks eelmiste versioonide eelistuste importimisel võtke ühendust NeoSofti toega e-posti 
aadressil service@neosoftmedical.com.

Eksportimise eelistused
1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Ekspordi (Export).

JOONIS 25. Eksportimise eelistused

2. Valige Sirvija (Browse), valige kaust, kuhu eelistuste fail salvestada ja valige Salvesta (Save).

3. Valige OK.
 Ilma eksportimata väljumiseks valige Tühista (Cancel).



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3              50

Virtual Fellow®

Virtual Fellow® on kujutiste vaatamise standardiseeritud funktsioon südame MR-uuringute jaoks. Funktsioon parandab 
vaatamise töövoogu lihtsustades nii arstidel südame MR-uuringute ülevaatamist. Funktsioon rakendub automaatselt 
kujutise töötlemise tööriistadele nagu akna tasand, suumimine, panoraam ja roteerimine. Praegusi ja varasemaid südame 
MR-uuringuid saab lihtsasti funktsiooniga Virtual Fellow® üle vaadata.

MÄRKUS. Funktsiooni Virtual Fellow® kasutamist koos eeltöötlusega vt suiteDXT kasutusjuhendist.

MÄRKUS. Patsiendi ID peab olema sama nii praegusel kui ka varasemal uuringul, et seda saaks rakenduses Virtual 
Fellow® vaadata. 

MÄRKUS. Funktsiooni Virtual Fellow® kasutamisel ei saa analüüsitulemusi redigeerida, selleks valige sobiv 
redigeerimisrežiim. 

HOIATUS! Kasutaja vastutab Virtual Fellow® loodud vaatamisprotokollide õige pildivaliku kinnitamise eest. 
Praeguste/varasemate vaatamisprotokollide jaoks valesti tuvastatud pilte saab valida käsitsi. 
Kasutaja peab olema saanud korraliku koolituse südame piltdiagnostika tehnikate alal, et tagada, et 
üle vaadatakse sobivad kujutised. Kõigi uuringu jaoks saadud kujutiste ülevaatamiseks kasutage 
režiimi Vaatur (Viewer), mida on selgitatud jaotises Kujutisehalduse tööriistad lk 21.

HOIATUS! Enne uuringute ülevaatamist või võrdlemist veenduge visuaalselt liidese ülaosas, et uuringu 
patsiendi kogu indikaatoriteave oleks sama. #1 tähistab praegust uuringut, #2 tähistab varasemat 
uuringut.

HOIATUS! Virtual Fellow® teostatavad kujutise manipulatsioonid, nagu WW/WL, panoraam, suumimine, 
roteerimine ja ümberpööramine, võivad mõjutada erinevate patoloogiate ilmnemist ja teiste 
anatoomiliste struktuuride eristamist. Vaadake iga vaatamisprotokoll üle ja tehke vastavad 
kohandused.
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Virtual Fellow® abil töötlemine

Seeriate tuvastamine

Automaatne segmenteerimine
(identifitseeritud seeriatel)

Automaatne klapirõnga tuvastamine
(kui on lubatud)

Virtual Fellow® – vaaturi optimeerimine
(kui on lubatud)

Valmis
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Virtual Fellow® liides

Virtual Fellow® valikud

Valik Kirjeldus

Virtual Fellow®

Kuvatakse funktsiooni tulemused

Kuvatakse voolu tulemused

Kuvatakse müokardi hindamise tulemused

Pikitelge ristlõigete
ja tulemuste vaade

Põhivaatur

Kujutisevaaturi juhtnupud

Vaatamise
protokollid
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Ühendamise lüliti, mida kasutatakse nii praegustel kui 
varasematel seeriatel WW/WL-i muutmiseks, 
panoraamimiseks, roteerimiseks ja ümberpööramiseks.

Lahtiühendamise lüliti, mida kasutatakse ühe seeria 
WW/WL-i muutmiseks, panoraamimiseks, 
roteerimiseks ja ümberpööramiseks.
Märkus. Suumi rakendatakse alati nii praegustele kui ka 
varasematele seeriatele. 

Lubamiseks võtke ühendust NeoSofti kasutajatoega 
aadressil service@neosoftmedical.com

Faasi kasutatakse faasitundliku hilisema 
täiustamisega kujutiste vaatamiseks.

Magnituudi kasutatakse magnituudi hilise 
täiustamise vaatamiseks.

MOCO:  müokardi perfusiooni seeria vaatamiseks 
liikumise korrigeerimisega.

NO MOCO:  müokardi perfusiooni seeria vaatamiseks 
ilma liikumise korrigeerimiseta.

Kaart: vaadake muu tootja kaarte.

#1 on praeguse uuringu jaoks kuvatavate seeriate 
indikaator. Seeria muutmiseks tehke vasakklõps otse 
#1 peal. 

#2 on eelnevate uuringuseeriate jaoks kuvatud 
seeriate indikaator. Seeria muutmiseks tehke 
vasakklõps otse #2 peal.

Video juhtnuppe kasutatakse video taasesitamiseks, 
peatamiseks, kaadrite arvu valimiseks sekundis ning 
videofilmi algus- ja lõpukaadri määramiseks.

Ristlõike tööriist, mis tuvastab automaatselt ja kuvab 
kujutised, mis sisaldavad sama asukohta. Selle 
funktsiooni kasutamiseks vt Leia tunnus* lk 22.

Mõõtetööriistu saab kasutada põhivaaturis ja 
pikitelje vaadetel.

Valik Kirjeldus
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Vaatamisprotokollid

Võta tagasi üldised mõõtmiste muudatused.

Vaateava paigutuse suvandid*: 1x1, 1x2, 4x4 and 5x4.
*Sõltub valitud protokollist.

Ulatusel on sama funktsioon, nagu on kirjeldatud 
jaotises Kujutise töötlemise tööriistad lk 12.

Vasaknooleklahv Kasutatakse praeguses/varasemas 
vaatamisprotokollis lõigu asukoha edasi 
liigutamiseks.

Paremnooleklahv Kasutatakse praeguses/varasemas 
vaatamisprotokollis lõigu asukoha 
ümberpööramiseks.

Seeria tüüp

Lühikese telje videofunktsiooniga seeria.

Praegune lühikese telje videofunktsiooniga seeria koos 
varasemaga.

Müokardi hindamine.

Praegune müokardi hindamine varasemaga.

Lühikese telje videofunktsiooniga koos müokardi hindamisega.

Müokardi perfusiooni stressi/puhkuse seeria.

Valik Kirjeldus
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*Aktiivsed klahvid olenevad häälestusparameetritest.

Kiirklahvid – pikitelje vaateavad

Praegune müokardi perfusiooni seeria Stress koos varasemaga.

Praegune müokardi perfusiooni seeria Stress koos müokardi 
hindamisega.

T1 aksiaalne seeria.
(Kasutage järgmistele seeriatele navigeerimiseks vasak- ja 
paremnooleklahve.*)

SSFP T1 koos aksiaalse seeriaga.

Funktsioon Tegevus

Lõigu navigeerimine edasi. Z

Lõigu navigeerimine tagasi. A

Lõigu navigeerimine. Keskmine hiireratas

Seeria tüüp
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Kasutaja tehtud seeriate valik vaatamisprotokollide jaoks

Vaatamisprotokollid on konfigureeritud praeguse uuringu või praeguse ja varasema uuringu kujutiste vaatamiseks. 
Kui kuvatavad kujutised ei ole need, mida sooviti üle vaadata, valige sobiv seeria uuesti, tehes vasakklõpsu otse 
numbermärgise kohal (#1 näitab praegust uuringut, #2 varasemat uuringut) Virtual Fellow® liideses, nagu on näidatud 
Joonis 1. Kuvatakse praeguse uuringu (#1) seeriate loend, valige sealt õige seeria. 

JOONIS 1. Virtual Fellow® liides
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Kasutaja tehtud seeriate valik pikitelje ristlõigete vaateavades

Kui kuvatavad kujutised ei ole need, mida oodati, saab sobiva seeria valida klõpsates otse pikitelje vaateavas ja valides 
seejärel kujutise faili rippmenüüst, nagu on näidatud alloleval joonisel.

MÄRKUS. Kui kasutatakse klaviatuurivalikuid Z või A, ei ole kasutaja valitud kujutis enam vaateavas.

MÄRKUS. Soovitud apikaalse suuna määramiseks valige kujutisevaaturi menüüribal Tööriistad (Tools) > Eelistused 
(Preferences) > Redigeeri (Edit) ja vahekaart Virtual Fellow®.
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Automaatne värskendamine
Automaatse värskendamise funktsioon võimaldab käivitada uuringu selle taustal töötlemisega. Kui kujutisi tuuakse võrgu 
kaudu, kui uuring on juba käivitatud, rakendatakse analüüsi (ja kui on konfigureeritud, siis ka funktsiooni Virtual Fellow®) 
taustal, kui kehtivad seeriatüübid on algoritmiga määratud. Toetatud analüüsirežiimid on järgmised.

• Funktsioon 
• Vool
• müokardi hindamine (ainult lühikese telje hilisem täiustamine)
• T1 kaardistamine
• T2 kaardistamine 
• T2*
• Müokardi perfusioon
• 3D/4D

Automaatse uuendamise konfigureerimiseks vaadake suiteDXT kasutusjuhendit. 

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest.

Töövoog
1. Kui uuringut tuuakse võrgu kaudu või uuring on pooleli ja võrgu kaudu toomisel ja DXT-loendis on helesinine 

indikaatorrõngas (nagu Joonis 1), võib uuringu käivitada.

MÄRKUS. Kui enne automaatset värskendamist tehakse analüüs käsitsi, tulemusi üle ei kirjutata.

MÄRKUS. Kui uuring on suletud, näitab roheline ring, et töötlemine on lõppenud.

JOONIS 1. DXT uuringute loend
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2. Kui uuring avaneb, ilmub Joonis 2 näidatud sõnum. 

JOONIS 2. Uuringu käivitamine

3. Kui seerial tehtud analüüs on lõpetatud, muutub Värskenda (Refresh) indikaator kollaseks, nagu on näidatud 
Joonis 3. Klõpsake, et analüüsirežiimi värskendada. 

Olenevalt analüüsitud seeriatüüpide arvust võib olla vajalik vajutada Värskenda (Refresh) nupule mitu korda.

JOONIS 3. Värskenda (Refresh) indikaator 

MÄRKUS. Kui peale uuringu sulgemist tuuakse võrgu kaudu seeriatüüpe juurde, võib töötlemine toimuda.
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Kontuuride redigeerimine

Kontuuride redigeerimine, mida kirjeldatakse selles jaotises, on võimalik kõigis analüüsirežiimides. See funktsioon on 
olemas nii Redaktori (Editor) aknas kui ja Ülevaatamise (Review) aknas.

ROI punktsplain
1. Tehke Redaktori (Editor) aknas kontuuril vasakklõps. Valimisel muutub kontuur lillaks.

2. Kontuuri liigutamiseks tehke vasakklõps kontuuri keskosal ja lohistage seda, nagu näidatud joonisel Joonis 1.
• Kui valitud kontuur loodi punktsplaini meetodil, kuvatakse redigeerimiseks punktid. Kontuuri suuruse ja kuju muutmiseks 

tehke vasakklõps mis tahes punktil ja lohistage seda, nagu näidatud joonisel Joonis 1.
• Kui valitud kontuur loodi vabakäe joone tööriista abil, tehke vasakklõps ja redigeerige kontuuri vabakäeliselt.

Lisafunktsioonid

• Alt+ vasakklõps loob nurgapunkti.
• Esimesel punktil klõpsamine sulgeb kontuuri.
• Kontuuril klõpsamine loob punkti otse.
• Kustutusklahv + kursor punktil eemaldab punkti.
• Punkti lohistamine naaberpunkti lähedale eemaldab naaberpunkti.
• Kui punktide arv jääb alla 3, siis ROI kustutatakse.

JOONIS 1. Tavapärane kontuuri redigeerimine
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Müksamise tööriist
1. Müksamise tööriista aktiveerimiseks tehke kontuuri valimiseks sellel vasaklõps. Seejärel tehke paremklõps ja valige 

hüpikmenüüst müksamise tööriist, nagu näidatud Joonis 2.
• Kui rakendatakse müksamise tööriista, muutub valitud punktsplaini ROI automaatselt vabakäe ROI-ks.

JOONIS 2. Müksamise tööriista aktiveerimine

2. Kursor kuvatakse ruuduna. Pange kursor ROI-st eemale ning vajutage ja hoidke all vasakut hiireklahvi. Ilmub 
müksamise tööriist, nagu näidatud Joonis 3.

MÄRKUS. Müksamisringi suuruseks on vaikimisi suurus, mis võrdub kaugusega kursorist valitud ROI-ni. Suuruse 
muutmiseks pange kursor teise kohta.

JOONIS 3. Müksamise tööriist



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3                                   62

3. Müksamise tööriista deaktiveerimiseks tehke kontuuril vasakklõps, seejärel paremklõps ja valige rippmenüüst 
müksamise tööriist, nagu näidatud Joonis 4.

JOONIS 4. Müksamise tööriista deaktiveerimine

MÄRKUS. Müksamise tööriista vaikimisi sees/väljas oleku saab seadistada Eelistustest (Preferences).

Kontuuri tõmbamise tööriist
1. Tõmbamise tööriista aktiveerimiseks tehke kontuuril selle valimiseks vasakklõps. Seejärel tehke paremklõps ja valige 

hüpikmenüüst tõmbamise tööriist, nagu on näidatud joonisel 5. See võimaldab kontuuri segmenti kohandada, 
lohistades kontuuri osi väikeste kohanduste tegemiseks.

JOONIS 5. Tõmbamise tööriista aktiveerimine
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2. Tehke vasakklõps otse redigeeritava kontuuri segmendil. Musta katkendliku segmendi pikkust saab muuta keskmise 
hiirerattaga. Hiirekursori kaugus mustast katkendjoonest juhib kontuuri vastava segmendi redigeerimist.

JOONIS 6. Tõmbamise tööriist

3. Tõmbamise tööriista deaktiveerimiseks tehke kontuuril vasakklõps, seejärel paremklõps ja valige rippmenüüst 
tõmbamise tööriist, nagu näidatud joonisel 7.

JOONIS 7. Tõmbamise tööriista deaktiveerimine
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Kontuuri  kustutamine
1. Kontuuri valimiseks tehke sellel vasakklõps ja vajutage klaviatuuril kustutusklahvi.

või

2. Tehke kontuuri valimiseks sellel vasakklõps, seejärel paremklõps ja valige  ühe kontuuri kustutamiseks või 

 kõikide faaside või kõikide ajapunktide kontuuride kustutamiseks, nagu näidatud joonisel 8.

JOONIS 8. Kontuuri kustutamine

MÄRKUS. Punktsplaini funktsioon kehtib kõikide analüüside puhul, välja arvatud 3D/4D voolu vaatur. 

Järgmised kopeerimise/kleepimise ja muutmise funktsioonid on saadaval kõigis analüüsirežiimides, välja arvatud 
PFO-analüüsis.

• Ctrl + C = ROI kopeerimine
• Ctrl + V = ROI kleepimine
• Ctrl + S = ROI silumine

ROI läviväärtuse tööriist

ROI loomiseks läviväärtust kasutades valige , seejärel vajutage hoidke Alt-klahvi ning vasakklõpsake kujutisel ja 
lohistage hiirt.

MÄRKUS. Läviväärtuse tööriista olek põhineb funktsioonide segmenteerimise töötlemata või sujuval režiimil. 

MÄRKUS. Läviväärtuse tööriist on optimeeritud funktsionaalsete SSFP tehnikate jaoks.
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Täiendava redigeerimise tööriist 

Redaktori vaateavas kuvatakse valikuid kolme redigeerimisrežiimi vahel lülitamiseks. 

Tööriist Kirjeldus
Piiranguga ROI

Piiranguta ROI

Ülekate
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Funktsiooni analüüs
Kasutaja vastutab kõikide huvipakkuvate piirkondade (ROI-de) täpse ja täieliku paigutamise (ja õige määratlemise) 
eest, kaasa arvatud nende eest, mille on genereerinud või mida on muutnud automaatse segmenteerimise algoritm. 
Kvantitatiivsed väärtused, mille on genereerinud tarkvara, sõltuvad sellest, kui täpselt ja täielikult on huvipakkuvad 
piirkonnad paigutatud (ja õigesti määratletud).

Uuringu eeltöötluse funktsioon võimaldab funktsiooni analüüsi eeltöödelda. Vt suiteDXT kasutusjuhendit.

Selles jaotises kirjeldatakse südamefunktsiooni analüüsi tüüpilisi samme. Näidistöövood annavad ülevaate sammudest, 
mida rakenduses südamefunktsiooni analüüsi tegemiseks kasutatakse. Toimingud kirjeldavad, kuidas teha
kvantitatiivset analüüsi.

TÄHTIS! Soovitatav on omada kvalifikatsiooni südameanalüüsi tegemiseks, kui analüüsitulemusi kavatsetakse kasutada 
diagnoosimiseks.

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.

- ROI paigutamine/tuvastamine
- ED/ES-i määramine
- MV/TV rõngaste paigutus
- RV sisestamise koht

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

HOIATUS! Vale skannimistasapind võib põhjustada ebatäpseid analüüsitulemusi. Vt Lisa B, lk 207.

MÄRKUS. Retrospektiivsed 2D seeriad, mis on loodud 4D voolu põhjal, võivad vajada käsitsi segmenteerimist.

MÄRKUS. Funktsionaalanalüüsi toetatakse mitme seeria puhul. Aruandes olevad tulemused kajastavad 
funktsionaalanalüüsi käigus valitud praegusi seeriaid.

Valige . Analüüsil on kolm kategooriat.

 - Sisaldab vasaku vatsakese (LV) ja parema vatsakese (RV) mahu analüüsi.

 - Sisaldab vasaku koja (LA) ja parema koja (RA) mahu analüüsi.

 - Sisaldab eelmääratletud lineaarseid mõõtmisi ja lisada saab muid kasutaja määratud mõõtmisi.
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 Vatsakesed
Valige analüüsi tüüp.

 Kontuuride kustutamiseks klõpsake .

MÄRKUS. Kontuuride kustutamiseks võib kasutada maatriksrežiimi.

Indeksmõõtude arvutamine

1. Klõpsake .

2. Sisestage patsiendi Pikkus (Height) ja Kaal (Weight).

Lõppdiastoolse mahu indeksi, lõppsüstoolse mahu indeksi, lõppdiastoolse massi indeksi, lõppsüstoolse massi 
indeksi, faasi massi indeksi, südame minutimahu indeksi ja südamelöögi mahu indeksi mõõtetulemused 
arvutatakse Mõõtmiste (Measurement) tabelis.

MÄRKUS. Keha pindala (BSA) arvutusmeetodi saab valida Aruandluse (Reporting) liideses.

Automaatne LV ja RV segmenteerimine

Automaatse segmenteerimise funktsioon arvutab südamefunktsiooni standardparameetrid ilma anatoomilise sisendita. 
Pärast segmenteerimise tulemuste genereerimist saab valida, milliseid ROI tüüpe vaatamisel kuvada. Kasutaja sisestuste 
abil saab ka segmente redigeerida. 

MÄRKUS. Piirkondliku analüüsi jaoks tuleks kõigi lõikude ja kõigi faaside jaoks läbi viia mittesünkroonsuse ning klapi 
tasandi analüüsi segmenteerimine. 

LV ja RV segmenteerimise alustamiseks tehke järgmist. 

1. Valige lühikese telje seeria ja kohandage akent/tasandit.

2. Klõpsake .

3. Automaatseks segmenteerimiseks klõpsake .

4. Tehke segmenteerimise menüüribal vajalikud valikud nagu näidatud Joonis . 

Lühike telg Pikitelg
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JOONIS 1. Segmenteerimise tööriistariba

5. Klõpsake  nii LV kui ka RV automaatne segmenteerimine. Kasutage suvandit  ainult LV jaoks ja  
ainult RV jaoks.

MÄRKUS. Optimaalse RV segmenteerimise jaoks valige mõlemad, nii epikardiaalsed kui ka endokardiaalsed 
kontuurid.

Segmenteerimise täpsuse ja redigeerimise ülevaatamine
1. Vaadake lühikese telje seeriat videorežiimis ja kontrollige kontuuride täpsust.

2. Redigeerige kõiki ebatäpseid kontuure.

MÄRKUS. Papillaarlihastega režiimi puhul on kontuuride redigeerimine toetatud. Redigeerige kontuuri ja valige 
automaatse segmenteerimise alustamine.

ED või ES uuesti määramiseks klõpsake nuppu ED või ES ja valige maatriksi lahtri vasak või parem pool. 
Vt Maatriksvaade lk 75.

MÄRKUS. ED ja ES-i faaside määramised määratakse segmenteerimisega. Suurimale arvutatud mahule omistatakse 
ED ja väikseimale arvutatud mahule ES.

3. Vaadake igal lõigul üle madalama RV sisestuspunkti asukoht. Vajadusel kohandage seda iga lõigu jaoks.

4. Vaadake üle maatriksrežiim ja veenduge ED ja ES-i määrangutes.

Tabel 1.  Automaatse segmenteerimise kontuuride tüübid

Papillaarlihas-
tega režiim – 
kaasab 
vatsakeste 
mahtu papil-
laarlihased. 

Papillaarlihas-
teta režiim – 
välistab 
vatsakeste 
mahust papil-
laarlihased. 

Papillaarlihaste-
ta LV, papillaar-
lihastega RV.

Papillaarli-
hastega LV, 
papillaarli-
hasteta RV

Näitab 
endokardi ja 
epikardi 
kontuure. 

Näitab 
endokardi 
kontuure.

Näitab 
kõõluskeeli-
kut.
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*Laiendamise funktsioonid vahetatakse välja, kui märgitakse eelistus x-telje (lõik) ja y-telje (faas) jaoks maatriksrežiimis.

Automaatne segmenteerimine kõikidel lõikudel ühes faasis
1. Valige lühikese telje seeria ja kohandage akent/tasandit.

2. Klõpsake .

3. Klõpsake .

4. Valige segmenteerimise menüüribalt kas papillaarlihastega  või papillaarlihasteta režiim .

5. Müokardi massi tulemuste genereerimiseks valige .

6. Vaadake üle lühikese telje kujutised ja valige lõppdiastoolne faas.

7. Valige kõikide lõikude jaoks ühes faasis .

8. Klõpsake  nii LV kui ka RV automaatne segmenteerimine. Kasutage suvandit  ainult LV jaoks ja  
ainult RV jaoks.

9. Vaadake üle lühikese telje kujutised ja valige lõppsüstoolne faas, korrake segmenteerimiseks sammu 9.

Segmenteerimise täpsuse/redigeerimise ülevaatamine
1. Vaadake lühikese telje seeriat videorežiimis ja kontrollige kontuuride täpsust.

2. Redigeerige kõiki ebatäpseid kontuure.

3. Vaadake üle maatriksrežiim ja veenduge ED ja ES-i määrangutes.

4. Vaadake mõõtmiste tabelis üle kõik tulemused.

Tabel 2.  Automaatse segmenteerimise laiendamise* tüübid

Laienda kõikidele lõikudele 
kõikides faasides või kuva kõik 
lõigud kõikides faasides

Laienda kõikidele 
lõikudele; üks faas

Laienda kõikidele 
faasidele; üks lõik

Laienda, näidates ainult 
ED/ES faaside kontuure

Tabel 3.  Segmenteerimise kuva

Parem vatsake Vasak vatsake 
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LV ja RV funktsiooni käsitsi analüüsimise protseduur
MÄRKUS. Soovitatav on kasutada lõppdiastoolset ja lõppsüstoolset faasi. Töötlemist peaks algustama lõppdiastoolse 

faasiga. Analüüsi töövoog viiakse tavaliselt läbi põhimikust tipuni.

1. Valige .

2. Valige kujutisevaaturist sobiv lühikese telje seeria. 

3. Klõpsake .

4. Mahu mõõtmiseks klõpsake nupul .

5. Lokaliseerige lõppdiastoolne faas.

Endokardi määramine

1. Valige LV jaoks  või RV jaoks . 

2. Joonistage endokardi kontuur.

3. Liikuge järgmise lõigu juurde , kasutades vasakule või paremale nooleklahvi, hiire kerimisratast või valige 
pisipilt.

4. Korrake samme 2 ja 3, kuni kogu vasak ja/või parem vatsake on segmenteeritud.

Endokardi kontuuri tööriist jääb mitme lõigu segmenteerimise kiirendamiseks valituks.

5. Leidke lõppsüstoolne faas.

6. Korrake samme 2 ja 3 lõppsüstoolses faasis, kuni kogu vasak ja/või parem vatsake on segmenteeritud.

MÄRKUS. Tarkvara määratleb automaatselt suurima mahuga faasi lõppdiastoolse faasina ja väikseima mahuga faasi 
lõppsüstoolse faasina. Lõppdiastoolse ja lõppsüstoolse faasi määratlusi uuendatakse segmenteerimise 
käigus.

Segmenteerimise täpsuse ja redigeerimise ülevaatamine
1. Vaadake lühikese telje seeriat videorežiimis ja kontrollige kontuuride täpsust.

2. Redigeerige kõiki ebatäpseid kontuure.

3. Vaadake üle maatriksrežiim ja veenduge ED ja ES-i määrangutes.

4. Vaadake mõõtmiste tabelis üle kõik tulemused.
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LV ja RV müokardi massi käsitsi määramise protseduur
1. Valige sobiv südametöö faas.

2. Valige LV epikardi jaoks  või RV epikardi jaoks . 

3. Joonistage epikardi kontuur.

4. Liikuge järgmise lõigu juurde, kasutades  või <-- ja --> või valige pisipilt.

5. Korrake samme 3 ja 4 kuni kogu vasaku ja/või parema vatsakese epikard on segmenteeritud.
Massitulemusi uuendatakse automaatselt, kui epikardi kontuurid on määratletud.

Segmenteerimise täpsuse/redigeerimise ülevaatamine
1. Vaadake lühikese telje seeriat videorežiimis ja kontrollige kontuuride täpsust.

2. Redigeerige kõiki ebatäpseid kontuure.

3. Vaadake üle maatriksrežiim ja veenduge ED ja ES-i määrangutes.

4. Vaadake mõõtmiste tabelis üle kõik tulemused.

Põhimiku interpoleerimine

Põhimiku lõikude interpoleerimiseks tuvastage pikitelje vaates, kas mitraal- või trikuspidaalklapi rõngas. 

MÄRKUS. Automaatse põhimiku interpoleerimise funktsioon on lülitatud välja, v.a juhul, kui Rakenda MV ja TV 
rõngas (Apply MV and TV Annulus) ning Rakenda põhimikujoone interpoleerimine (Apply Basal Line 
Interpolation) on eelistes märgitud. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri 
süsteemi (Edit System). (Ainult administraator)  

1. LV põhimiku interpoleerimise jaoks valige ristlõigete režiimis 2-kambriline vaade.

2. Valige .

3. Määrake MV rõngas nagu Joonis 2. Vaadake üle joone paigutus sobivas lõppsüstoolses ja lõppdiastoolses faasis, 
kasutades video juhtnuppe.

MÄRKUS. Toetatakse mitmetasandilist põhimiku interpoleerimist. Näiteks MV rõngast saab tuvastada 2-kambrilisel ja 
4-kambrilisel vaatel; sobitamine tehakse kahe tasapinna vahel.  

MÄRKUS. MV või TV rõnga asukohaga seeria lokaliseerimiseks klõpsake  või , mis asuvad vaateavas all 
vasakul. 
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JOONIS 2. MV rõngas

4. Vaadake uuendatud arvutus üle, vaadates üle reaga seotud ristlõiked. 

Nagu näha Joonis 3, põhineb interpoleeritud mahu arvutamine joone ja lõigu (roosa joon) ristumiskoha suhtel, see maht 
on nüüd kaasatud mahu tulemustesse. Tegelikku huvipakkuvat piirkonda ei kuvata. Kujutise vasakus nurgas näidatakse 
interpoleeritud lõikudel mahu hulka koos interpolatsiooni protsendiga, nagu näidatud Joonis 3.

JOONIS 3. Mahu arvutamine

5. RV põhimiku interpoleerimise jaoks valige ristlõigete režiimis 4-kambriline vaade.

6. Valige .

7. Määrake TV rõngas nagu Joonis 4. Vaadake sobivas lõppsüstoolses ja lõppdiastoolses faasis üle joone asukoht 
kasutades video juhtnuppe.
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JOONIS 4. TV rõngas

8. Vaadake uuendatud arvutused üle, vaadates üle ristlõikude lõigud, mis on seotud joonega ja maatriksvaates ED ja 
ES-i määratlused.   

9. Tulemuse algväärtuse taastamiseks tehke paremklõps ja hoidke kustutamiseks otse real või tehke real vasakklõps ja 
kasutage klaviatuuri kustutusklahvi. 

Täpsuse üle vaatamine
1. Vaadake pikitelje seeriat videorežiimis ja kontrollige kontuuri asukohta.

2. Kohandage vajadusel joone asukohta.

3. Kui kasutatakse automaatset sisestamist, kontrollige, et valitud on õige seeria ja et joone asukoht on õige. Kui asukoht 
ei ole õige, tehke joonel paremklõps ja kustutage see.

Liikumise korrigeerimine seeriate vahel

Liikumise korrigeerimine seeriate vahel kompenseerib südame translatsiooni, mis võib tekkida pika telje kujutiste ja 
lühikese telje hõivamise vahel. Kambrite mahtudes võivad tekkida vead, kui klapirõngaste tasapinnad saadakse pikitelje 
kujutistest, mis ei registreeru ruumiliselt lühikese telje kujutistega, mis sisaldavad mahuanalüüsiks kasutatavaid endokardi 
kontuure. Viga võib ilmneda juhul, kui lühikese ja pika telje kujutised saadakse hingamistsükli erinevates etappides või kui 
patsient muudab pika ja lühikese telje kujutise hõivamise vahel asendit (st liigub küljele). Kui on valitud Liikumise 
korrigeerimine seeriate vahel (Motion Correction Between Series), määratakse atrioventrikulaarse klapi tasandi 
lõppdiastoolne keskpunkt kõige põhimikupoolsem lõppdiastoolse vatsakese endokardi kontuuriga. Klapirõnga tasapinna 
nurk ja selle keskpunkti suhteline asend teiste südamefaaside suhtes määratakse rõngaste joonte nurga ja rõnga 
keskpunktide suhtelise asendi järgi, nagu on määratletud pikitelje kujutistel. 

MÄRKUS. Funktsioonile ligipääsemiseks funktsiooni analüüsi režiimis. Valige Tööriistad (Tools) > Eelistused 
(Preferences) > Redigeeri süsteemi (Edit System). (ainult administraator)
Valige Funktsiooni alt Liikumise korrigeerimine seeriate vahel (Motion Correction Between Series).

1. Tehke LV ja RV automaatne segmenteerimine kõikides faasides ja kõikides lõikudes.

2. Tehke LV ja RV põhimiku interpoleerimine. 

3. Valige .
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4. Nõustumine kinnitatakse, kui katkendjoon kuvatakse MV rõngas joone asukoha peal, nagu on näidatud joonisel 5 
(vasakul).

JOONIS 5. Kinnitatud nõustumine (vasakul) ja südame translatsioon (paremal)

5. Joonisel 5 (paremal) on kujutatud tühimik pideva ja katkendliku rõnga joone vahel. 

6. Pidev joon tähistab pikitelje kujutisele joonistatud rõnga tasapinda. Katkendjoon tähistab rõnga transleeritud 
tasapinda, mis põhineb kõige põhimikupoolsemal endokardi kontuuri asukohal. 

MÄRKUS. Kasutaja vastutab pideva ja katkendjoone vahelise tühimiku põhjuse väljaselgitamise eest ning vajadusel 
analüüsi korrigeerimise eest. Tühimiku võimalikud põhjused on järgmised.
- Lühikese telje kujutise kõige põhimikupoolsem endokardi kontuur ei ole joonistatud õigele lõigule. Kui seda ei 

parandata, kompenseerib tarkvara translatsiooni valesti. 
- Rõnga joon ei tähista rõnga asukohta. Kui seda ei parandata, kompenseerib tarkvara translatsiooni valesti. 
- Südame translatsioon pika ja lühikese telje kujutise hõivamise vahel.

Kui kõige põhimikupoolsem endokardi kontuur on joonistatud õigele lõigule ja rõnga kontuur on joonistatud 
pikitelje kujutisel õigesti, siis pidev- ja katkendjoone vaheline tühimik tähistab tõelist südame translatsiooni ja 
tarkvara korrigeerib selle.

7. Kui RV segmenteerimine on tehtud ja TV rõngas on asetatud, vaadake translatsioon üle. 
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Maatriksvaade 

MÄRKUS. X-telje (lõik) ja y-telje (faas) saab omavahel ümber vahetada. Valige Tööriistad (Tools) > Eelistused 
(Preferences) > Redigeeri (Edit). Valige Funktsiooni (Function) alt Vaheta maatriksrežiimi jaoks omavahel teljed x(lõik) ja 
y(faas) (Flip X (slice) and Y (phase) axis for matrix mode). Kui eelistust muudetakse, tuleb rakendus taaskäivitada.

Maatriksit kasutatakse lõppsüstoolse ja lõppdiastoolse faasi ülevaatamiseks ja määramiseks ning faaside ja lõikude 
sirvimiseks. Määratud ED ja ES-i faasid on näidatud ühevärviliste plokkidena, ED puhul punaselt ja ES-i puhul siniselt, nagu 
näidatud Joonis 6.

JOONIS 6. LV ja RV maatriksvaade

Vatsakese määramine

Vasaku vatsakese ED (Joonis 7) või ES (Joonis 8) määratakse valides maatriksi üksikvälja parema poole. 

Parema vatsakese ED (Joonis 9) või ES (Joonis 10) määratakse valides maatriksi üksikvälja vasaku poole. 

JOONIS 7. JOONIS 8.

JOONIS 9. JOONIS 10.

Määratud ES faas

Määratud ED faas
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Kodade määramine

Vasaku koja ED (Joonis 11) või ES (Joonis 12) määratakse valides maatriksi üksikvälja parema poole.

Parema koja ED (Joonis 13) või ES (Joonis 14) määratakse valides maatriksi üksikvälja parema poole.

Maatriksi funktsioonid

Kontuure saab kustutada, valides faasi või lõigu rea või üksiku maatriksi välja ja tehes hiirega paremklõpsu.

Interpolatsiooni märgivad värvitud indikaatorid. Interpolatsiooni saab rakendada järgmistel tingimustel. 

• Kui sama südamefaasi jälgitakse kas süstoli või diastoli lõpu lõikude vahel ja üks osa on vahele jäetud.
• Kui samas südamefaasis jälgitakse lõikusid kas süstoli või diastoli lõpu osas ja/või üks lõik on vahele jäetud, võib rakendada 

basaalinterpolatsiooni.

MÄRKUS. Lõigu interpolatsiooni rakendamiseks valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). 
Valige märkeruut Rakenda vatsakese keskosa interpoleerimine (Apply Mid Ventricular Interpolation). 

Kuvamise suvandid

JOONIS 11. JOONIS 12.

JOONIS 13. JOONIS 14.

Kuvatakse LV/RV maatriks Kuvatakse RA/LA maatriks
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Valikud 

*Vt märkust jaotise Kojad lk 83 all.

Kambrite indikaatorid 

Vatsakese segmentatsiooni indikaatorid 

Koja segmentatsiooni indikaatorid 

Üks südamelöök lõigu kohta Analüüsirežiim ühekordseks südamelöögi hõivamiseks.

Mitu südamelööki lõigu kohta Analüüsirežiim mitme südamelöögi hõivamiseks.

Üldine ED/ES Kui on valitud üldine, põhineb kombineeritud maht sama faasi ED ja ES-i 
määrangutel.

Üksik ED/ES Kui on valitud üksik, põhineb kombineeritud maht iga lõigu suurimal ja 
vähimal mahul lõigu kohta. Aktiveerimiseks tuleb valida režiim Laienda 
kõikidele lõikudele, kõikidele faasidele (Propagate All Slices, All Phases). 
Põhimiku interpoleerimist selles režiimis ei toetata. 

Põhimiku interpoleerimine Valige sisse/välja lülitamiseks Sees (On) või Väljas (Off). Näidatakse otse 
mahukõveral. 

ED Lõppdiastoolse faasi määramiseks klõpsake RV jaoks otse maatriksi välja 
vasakul poolel või LV jaoks välja paremal poolel.

Lõppdiastoolse faasi määramiseks klõpsake RA jaoks otse maatriksi välja 
vasakul poolel või LA jaoks välja paremal poolel.

ES Lõppsüstoolse faasi määramiseks klõpsake RV jaoks otse maatriksi välja 
vasakul poolel või LV jaoks välja paremal poolel.

Lõppsüstoolse faasi määramiseks klõpsake RA jaoks otse maatriksi välja 
vasakul poolel või LA jaoks välja paremal poolel.

Max

 

Valik koja maksimaalse mahu jaoks*

Min

 

Valik koja minimaalse mahu jaoks*

LV endokard LV epikard RV endokard RV epikard

RA endokard LA endokard
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Vatsakeste funktsiooni analüüsi tulemused

JOONIS 15. Vatsakese automaatse segmenteerimise tulemused

1. Mahumeetrilised tulemused, 2. Mahu kõver, 3. Maatriks

Mahu kõver

Kui automaatne segmenteerimine viiakse läbi kõikides faasides ja kõikides lõikudes kas LV või RV jaoks, luuakse vatsakeste 
mahu ja aja suhte kõver, nagu näidatud Joonis 15. Mahu kõvera lisamiseks aruandesse tehke paremklõps.

• Punane ring tähistab diastoli lõppu (kujutise vaateavas märgistatud kui ED).
- Klõpsake ja lohistage punast ringi, et ED uuesti määrata.

• Sinine ring tähistab süstoli lõppu (kujutise vaateavas märgistatud kui ES).
- Klõpsake ja lohistage punast ringi, et ES uuesti määrata.

• Roheline kursor näitab maksimaalset väljutuskiirust (PER) ml/s. (Interaktiivne vertikaalne kursor).
• Kollane kursor näitab maksimaalset täitumiskiirust (PFR) ml/s. (Interaktiivne vertikaalne kursor).
• Vastavat kujutise faasi valikut näitab valge ring mahu kõveral.
• E/A kõvera vaatamiseks klõpsake LV E/A või RV E/A vahekaarti.

Mahulisi tulemusi kuvatakse mõõtemiste tabelis. 

• Vatsakese massi tulemuste või massi indeksi ülevaatamiseks tehke vasakklõps LV või RV ümberpööratud kolmnurgal.
• Faaside loendist valitud faas kuvatakse aruandes. Vaikemäärang on ED.

1

2

3
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JOONIS 16. Massi tulemused

JOONIS 17. Kambrite mahtude tabel

LV ja RV mahud kuvatakse Kambrite mahtude (Chamber Volume) tabelis. 
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Vasaku vatsakese piirkondlik analüüs

LV piirkondlik analüüs võimaldab vaadata seina liikumist, seina paksust, seina paksenemist ja seina paksuse tulemusi.

MÄRKUS. Kui nii LV kui ka RV nupud on funktsiooni lühikese telje jaoks valimata või pikitelje kambri valimise nupp on 
valimata, ei saa kasutada nuppu Alusta automaatset laiendamist (Start Auto Propagation). 

1. Tehke automaatne LV segmenteerimine kõikides lõikudes ja kõikides faasides (vt lk 69).

2. Vaadake üle RV sisestuspunkti asukoht igal lõigul ja kohandage RV sisestuspunkti põhimiku lõikude jaoks.

3. RV sisestuspunkti lisamiseks lõigu asukohal klõpsake RV sisestuspunktil , valige automaatselt segmenteeritud 
lõik ja sisestage RV sisestuspunkt. 

4. Veenduge põhimiku, keskosa ja tipu klassifitseerimises. 

5. Klõpsake piirkondlikul analüüsil . Paksust, paksenemise protsenti ja seina liikumist kuvatakse diagrammi, 
graafiku või tabeli vormis.

JOONIS 18. Piirkondlikud analüüsid
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Mittesünkroonsuse analüüs

Mittesünkroonsus on piirkondliku analüüsi tulemuste laiendus, mis võimaldab arvutada seina paksuse ajalise ühtsuse 
(TUWT), mis põhineb piirkondlikul analüüsil saadud ümbermõõdu teabel. 

Mittesünkroonsuse analüüsimise protseduur
1. Tehke LV automaatne segmenteerimine (Vt Automaatne segmenteerimine kõikidel lõikudel ühes faasis lk 69.).

2. Valige piirkondlikud analüüsid .

3. Valige mittesünkroonsuse vahekaart.

4. Mõõtmiste tabelis kuvatakse iga lõigu tulemusi ja keskmist üldist tulemust.

5. Üldise tulemuse arvutamine on optimaalne, kui kaasatakse ainult LV keskosa lõigud. Lõigu tulemuse eemaldamiseks 
üldisest tulemuste arvutamisest klõpsake otse paremas äärmises veerus (Joonis 19) täidetud märkeruudul.

JOONIS 19. Üldiste tulemuste arvutamine

Soovitatud allikad

Bilchick et al, „Cardiac Magnetic Resonance Assessment of Dyssynchrony and Myocardial Scar Predicts Function Class Improvement 
Following Cardiac Resynchronization Therapy“, JACC, Vol.1:No 5: 2008 p.561-8

Helm RH, Leclercq C, Faris OP, Ozturk C, McVeigh E, Lardo AC, Kass DA. „Cardiac dyssynchrony analysis using circumferential versus 
longitudinal strain: implications for assessing cardiac resynchronization.“ Circulation. 2005 May 31;111(21):2760-7. doi: 10.1161/
CIRCULATIONAHA.104.508457. Epub 2005 May 23. PMID: 15911694; PMCID: PMC2396330.
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Automaatne segmenteerimine pikiteljel

1. Valige .

2. Valige pikitelje seeria.

MÄRKUS. Kui eeltöötlus on tehtud, kasutatakse analüüsiks AUTO_FUNCTION_LAX seeriat. Erinevate pika telje 
vaadete eelistamisel saab vaaturis luua uued seeriad.

MÄRKUS. Faaside arv peab ühtima kõigi pika telje vaadetega. Kui need ei ühti, segmenteeritakse ainult 4 kanalit.

3. Valige .

4. Kõikidele lõikudele ja faasidele laiendamiseks valige .

5. Klõpsake  nii LV kui ka RV automaatne segmenteerimine. Kasutage suvandit  ainult LV jaoks ja  
ainult RV jaoks.

MÄRKUS. Mahu tulemused hangitakse ainult kanalitest 2 ja 4. Tüveanalüüsi jaoks kasutatakse segmenteerimist 3-
kanalilise LV ja 4-kanalilise RV jaoks (ainult uuringud). Mittetäielik muudetav ala (FAC) saadakse 4-
kanaliliselt RV-lt.

6. Vaadake üle kõik jooned. 

7. Käsitsi keskjoone tõmbamiseks klõpsake vasaku vatsakese endokardi puhul  ja parema vatsakese endokardi 

puhul  nii diastoli kui ka süstoli lõpu jaoks.

8. Massi arvutamiseks valige vasaku vatsakese epikard .

JOONIS 20. Pika telje segmenteerimine

Tulemusi kuvatakse mõõtmiste tabelis.

MÄRKUS. Keskjoon kuvatakse ainult siis, kui algoritm ei leia rõnga joont. 
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 Kojad
MÄRKUS. Kodade mahtude vaikimisi mõõtetulemuste sildid on EDV, mis viitab maksimaalsele koja mahule, ja ESV, mis 

viitab minimaalsele koja mahule. Siltide MaxV ja MinV seadistamiseks valige Tools (Tööriistad) > 
Preferences (Eelistused) > Edit (Redigeeri). Valige Koja mahu silt (Atrial Volume Label): MaxV, MinV) 
jaotises Funktsioon (Function).

LA ja RA käsitsi analüüsimine
1. Valige kujutistevaaturist sobiv seeria. 

MÄRKUS. Optimaalsete tulemuste jaoks on soovitav kasutada 4 kambri analüüsi. 4 kambri vaade kujutab kodade 
anatoomiat paremini.

2. Klõpsake .

3. Valige nuppe .

4. Lokaliseerige lõppdiastoolne faas.

Endokardi määramine

1. LA endokardi jaoks valige  või RA endokardi jaoks .

2. Joonistage endokardi kontuur.

3. Liikuge järgmise lõigu juurde , kasutades vasakule või paremale nooleklahvi, hiire kerimisratast või 
klõpsates pisipilti.

4. Korrake samme 2 ja 3 kuni kogud koda on segmenteeritud.

5. Leidke lõppsüstoolne faas.

6. Korrake lõppsüstoolses faasis samme 2 ja 3, kuni kogu koda on segmenteeritud.

MÄRKUS. Tarkvara määratleb automaatselt suurima mahuga faasi lõppdiastoolse faasina ja väikseima mahuga faasi 
lõppsüstoolse faasina. Lõppdiastoolse ja lõppsüstoolse faasi määratlusi uuendatakse segmenteerimise 
käigus.

7. Kui kasutatakse lühikese telje vaadet, tuvastage MV ja/või TV rõngas.
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LA või RA automaatne analüüsimine

1. Klõpsake .

2. Valige pikitelje seeria.

MÄRKUS. Kui eeltöötlus on tehtud, kasutatakse analüüsiks AUTO_FUNCTION_LAX seeriat. Erinevate pika telje 
vaadete eelistamisel saab vaaturis luua uued seeriad. 

3. Valige .

4. Kõikidele lõikudele ja faasidele laiendamiseks valige .

5. Klõpsake  nii LA kui ka RA automaatne segmenteerimine. Kasutage suvandit  ainult LA jaoks ja  
ainult RA jaoks.

6. Vaadake üle kõik jooned. 

MÄRKUS. Keskjoon kuvatakse ainult siis, kui algoritm ei leia rõnga joont. 

7. Joone käsitsi tõmbamiseks klõpsake RA endokardiumi puhul  ja LA endokardiumi puhul  nii diastoli kui ka 
süstoli lõpus jaoks.

JOONIS 21. Keskjoone paigutamine
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Kodade mõõtmised

1. Klõpsake .

2. Valige sobiv seeria.

3. LA mõõtmiseks klõpsake otse tabelis ED AP DIM:3ch veerul ja seejärel pange paika kaks punkti. Vt Joonis 22.

4. Üksikasjalikumateks tulemusteks valige märkeruut .

JOONIS 22. Kodade mõõtmine

MÄRKUS. Kodade ED-alad hangitakse automaatselt ED määramiselt. Kasutage muutmiseks maatriksit. 
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Kasutaja määratud mõõtmised
Rakendus võimaldab teha lineaarsete ja pindala mõõtude aruande. Tööriistad on saadaval, kui panna kursor tabelis 
toodud mõõdule.

JOONIS 23. Vaikemõõtmised

1. Automaatne seina max paksus, 2. Tekstiväli perikardi jaoks, 3. Lisa/eemalda kohandatud mõõtmine, 4. Kustuta kõik mõõtmised

Tehke mõõtmine

1. Valige .

2. Valige seeria. 

3. Klõpsake nupul .

MÄRKUS. Seina maksimaalne paksus mõõdetakse automaatselt. Mõõtmise leidmiseks klõpsake otse tulemusel. Kui 
tehakse endo või epi muudatusi, mõõtmiskohta uuendatakse.

4. Lokaliseerige kujutis, mille anatoomiat soovite mõõta.

5. Klõpsake soovitud mõõtmisel, mis tõstetakse esile, näidates, et valik on aktiivne. 

1

2

3 4
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ETTEVAATUST! Joone täpne asukoht on mõõtmistulemuste jaoks ülioluline. Tekkida võib valediagnoos, 
kui mõõtmised on ebatäpsed. Mõõtmisi peaks tegema ainult nõuetekohaselt koolitatud ja 
kvalifitseeritud kasutaja.

6. Redigeerimiseks klõpsake märkmel ja kui värv muutub lillaks, on see aktiivne. Paigutage kursor ühe lõpp-punkti kohale 
ja kohandage lõpp-punkti. 

Mõõdetud kauguse väärtust uuendatakse tabelis Mõõtmised (Measurements) vastavalt siis, kui liigutate kursori 
Kujutiseredaktori (Image Editor) aknast välja.

Kogu kauguse mõõtmise joone teise kohta viimiseks asetage kursor keskmise markeri kohale.

MÄRKUS. Mõõtmise lähtestamiseks valige kauguse mõõtmise joon ja avage paremklõpsumenüü ning valige prügikast; 
või kasutage klaviatuuril kustutusklahvi. 

MÄRKUS. Kohandatud mõõtmisi saab järjestada ümber eelistustes vahekaardil Prindi teised eelistused (Print 
Preferences Other), valides Tööriistad (Tools) > 
Eelistused (Preferences) > Redigeeri (Edit) ja seejärel vahekaardi Prindi (Print).

Mõõtmiste kustutamine

Kõikide mõõtmiste kustutamiseks klõpsake .

Kohandatud mõõtmise lisamine

1. Klõpsake . 

2. Sisestage hüpikaknasse Lisa kohandatud mõõt (Add Custom Measure) kordumatu silt.

3. Valige mõõtmise tüüp, kas lineaarne või pindala.

4. Valige OK. 

Kohandatud mõõtmise eemaldamine

1. Klõpsake . 

2. Valige kohandatud mõõtmine, mida loendist eemaldada.

3. Valige Vali (Select).

MÄRKUS. Loodud kohandatud mõõtmised ilmuvad kõikidele tulevastele analüüsidele, kuni neid pole loendist 
eemaldatud.
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Aordiklapi tasapinna analüüs
Aordiklapi tasapinna analüüsi funktsioon võimaldab arvutada aordiklapi maksimaalset kiirust, tipprõhu gradienti ja 
keskmist rõhugradienti.

LV automaatse segmenteerimise tulemusi kasutades arvutatakse rõhugradient südame minutimahu põhjal, 
võttes aluseks vasaku vatsakese süstoolse mahu kaader-kaadri kohased muutused.

Aordiklapi tasapinna analüüsimise protseduur
1. Tehke LV automaatne segmenteerimine kõikidel lõikudel ja kõikides faasides (vt lk 69).

2. Valige seeria, mis näitab klapi anatoomiat.

3. Valige mõõtmiste tabelist Aordiklapi pindala (Aortic Valve Area) (Joonis 24) ja tehke aordiklapi planimeetria, 
nagu näidatud Joonis 25.

JOONIS 24. Aordiklapi pindala 

4. ROI määramise järel uuendatakse tabelis tulemusi ja kuvatakse graafik, mis näitab rõhu gradienti ajas.

Kõikide mõõtmiste kustutamiseks klõpsake .
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JOONIS 25. Aordiklapi tasapinna analüüs

HOIATUS! Soovitatav on omada kvalifikatsiooni südameanalüüsi tegemiseks, kui analüüsitulemusi kavatsetakse 
kasutada diagnoosimiseks.

MÄRKUS. Aordiklapi tasapinna analüüsi funktsiooni abil saadud maksimaalse kiiruse, tipprõhu gradiendi ja keskmise 
rõhugradiendi tulemused pole mitraalregulatsiooni või šundiga patsientide puhul kehtivad.

Soovitatud allikad

Hakki, A. H. et al. „A Simplified Valve Formula for the Calculation of Stenotic Cardiac Valve Areas.“ Circulation 63 (1981): 1050–1055.

Patel, K., Uretsky, S., Penesetti, S. et al. „COVA (cardiac output valve area): a reliable method for determining aortic transvalvular 
pressure gradients that does not use phase contrast imaging.“ J Cardiovasc Magn Reson 16 (Suppl 1), P247 (2014). https://doi.org/
10.1186/1532-429X-16-S1-P247



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3                     90

Müokardi kontraktsiooni fraktsioon

Müokardi kontraktsiooni fraktsioon (MCF) vajab lühikese telje täielikku endo ja epi LV segmenteerimist ning see on esitatud 
lühikese telje funktsiooni tulemuste tabelis. Kasutaja vastutab MCF-i jaoks oma tavapärase vahemiku kehtestamise eest. 

Soovitatud allikad

Abdalla M, Akwo EA, Bluemke DA, Lima JAC, Shimbo D, Maurer MS, Bertoni AG. „Association between reduced myocardial contraction 
fraction and cardiovascular disease outcomes: The Multi-Ethnic Study of Atherosclerosis.“ Int J Cardiol. 2019 Oct 15;293:10-16. doi: 
10.1016/j.ijcard.2019.07.040. Epub 2019 Jul 11. PMID: 31327521; PMCID: PMC7175692.

Arenja N, Fritz T, Andre F, Riffel JH, Aus dem Siepen F, Ochs M, Paffhausen J, Hegenbart U, Schönland S, Müller-Hennessen M, 
Giannitsis E, Kristen AV, Katus HA, Friedrich MG, Buss SJ. „Myocardial contraction fraction derived from cardiovascular magnetic 
resonance cine images-reference values and performance in patients with heart failure and left ventricular hypertrophy. Eur Heart J 
Cardiovasc Imaging. 2017 Dec 1;18(12):1414-1422. doi: 10.1093/ehjci/jew324. PMID: 28165128.

Maurer MS, Packer M. „How Should Physicians Assess Myocardial Contraction?: Redefining Heart Failure With a Preserved Ejection 
Fraction. JACC Cardiovasc Imaging.“ 2020 Mar;13(3):873-878. doi: 10.1016/j.jcmg.2019.12.021. PMID: 32139035.

Hinnanguline LVFP (vasaku vatsakese täiterõhk) 
MÄRKUS. See parameeter kehtib ainult teatud tüüpi südamepuudulikkuse korral, kuid ei kehti hüpertroofilise 

kardiomüopaatia või mitraalpuudulikkuse korral. Kasutaja vastutab kliinilise tõlgenduse määramise eest.

Hinnanguline LVFP nõuab vasaku vatsakese massi ja kodade kahetasandilise tulemuse jaoks lühikese telje täielikku endo ja 
epi LV segmenteerimist. Tulemus on esitatud funktsiooni mõõtmise tabelis. Kasutaja vastutab kliinilise tõlgenduse 
määramise eest.

CMR PCWP (mmHg) = 5,7591 + (0,07505 * LAV) + (0,05289 * LVM) – (1,9927 * sugu)

Kus

sugu [naine = 0, mees = 1] 
LAV on vasaku koja maksimaalne maht 
LVM on vasaku vatsakese mass diastoolis

Soovitatud allikad

Pankaj Garg, Ciaran Grafton-Clarke, Gareth Matthews, Peter Swoboda, Liang Zhong, Nay Aung, Ross Thomson, Samer Alabed, Ahmet 
Demirkiran, Vassilios S Vassiliou, Andrew J Swift, „Sex-specific cardiac magnetic resonance pulmonary capillary wedge pressure“, 
European Heart Journal Open, Volume 4, Issue 3, May 2024, oeae038, https://doi.org/10.1093/ehjopen/oeae038

Thomson R. J., Grafton-Clarke C., Matthews G., Swoboda P. P., Swift A. J., Frangi A., Petersen S. E., Aung N., and Garg P. (2024) Risk 
factors for raised left ventricular filling pressure by cardiovascular magnetic resonance: Prognostic insights, ESC Heart Failure, doi: 
https://doi.org/10.1002/ehf2.15011
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MAPSE/TAPSE
MAPSE/TAPSE analüüsimise funktsioon võimaldab hinnata vatsakese funktsiooni. 

MAPSE kasutab lõppsüstoolse mitraalrõnga tasandi keskpunkti ja lõppdiastoolse tasandi ristsuunalist kaugust. TAPSE 
kasutab lõppsüstoolse lateraalse trikurspidaalrõnga tasandi ja lõppdiastoolse tasandi ristsuunalist kaugust.

E' tulemused tuletatakse vatsakeste mahu kõverast koos rõngajoone paigutusega 4-kambrilisel SSFP video vaates. 

MÄRKUS. Eeltöötluse ajal MAPSE/TAPSE tulemuste hankimiseks valige Tööriistad (Tools) > Eelistused (Preferences) > 
Redigeeri süsteemi (Edit System). (Ainult administraator) Valige märkeruut Rakenda MV ja TV rõngas 
(Apply MV and TV Annulus) jaotises Funktsioon (Function). Lühikese telje jaoks põhimiku interpoleerimise 
automaatseks rakendamiskes valige märkeruut Rakenda põhimikujoone interpoleerimine (Apply Basal 
Line Interpolation).

 

Tabel 4.  Terminoloogia

Parameeter
MAPSE Mitraalrõnga tasandi süstoolne kõikumine 
TAPSE Trikuspidaalrõnga tasandi süstoolne kõikumine
E/A (LV ja RV) E-laine ja A-laine suhtarv LV mahu kõvera derivaadist (Joonis 26)
Lateraalne e' Kõige negatiivsem kiirus lõppdiastoolse ajaintervalli läheduses, kasutades mitraalrõnga joone lateraalset otsa (Joonis 27)
Septaalne e' Kõige negatiivsem kiirus lõppdiastoolse ajaintervalli läheduses, kasutades mitraalrõnga joone septaalset otsa (Joonis 27)
Keskmine e' Lateraalse e' ja septaalse e' keskmine (Joonis 27) 
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Analüüsimise protseduur
1. Tehke LV automaatne segmenteerimine 4-kambrilise vaate kõikidel lõikudel ja kõikides faasides (vt Automaatne LV ja RV 

segmenteerimine lk 67).

MÄRKUS. MAPSE/TAPSE tulemuste automaatseks hankimiseks valige Tööriistad (Tools) > Eelistused (Preferences) > 
Redigeeri süsteemi (Edit System) (Ainult administraator). Valige märkeruut Rakenda MV ja TV rõngas 
(Apply MV and TV Annulus) jaotises Funktsioon (Function). (vt Põhimiku interpoleerimine lk 71)

2. E (sinise) tähistuse muutmiseks klõpsake otse sinisel punktil ja liikuge graafikul teise faasi punkti. (Joonis 26)  

3. A (punase) tähistuse muutmiseks klõpsake otse punasel punktil ja liikuge graafikul teise faasi punkti. (Joonis 26)

JOONIS 26. LV pika telje E/A kõver 

4. Valige vahekaart e’, klõpske otse sinist täppi Lateraalse (Lateral) või punast täppi Septaalse (Septal) jaoks ja lohistage 
soovitud faasi, et vajaduse korral uuesti määrata (vt joonis 27). 

e’ on määratletud kui kõige positiivsem kiirus. Tulemused kuvatakse pika telje tulemuste tabelis, nagu on näidatud Joonis 28.

JOONIS 27. e' kõver  
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JOONIS 28. Pika telje tulemuste tabel 

Soovitatud allikad
Bulluck, H., Ngamkasem, H., Sado, D. et al. „A simple technique to measure TAPSE and MAPSE on CMR and normal values.“ J 
Cardiovasc Magn Reson 16 (Suppl 1), P22 (2014). https://doi.org/10.1186/1532-429X-16-S1-P22

Reaalajas analüüsimine 
Vajalikud kujutised: Lühikese telje SSFP hõivamised koos mitme südamelöögiga lõigu kohta ilma südame või hingamise 
lüüsimiseta. 

Soovitatav on kujutada iga lõiku piisavalt kaua, et katta vähemalt üks täielik sisse- ja väljahingamise hingamistsükkel. 
Ajaline resolutsioon peaks olema südame liikumise visualiseerimiseks piisav. 

Tarkvara tuvastab faaside arvu põhjal automaatselt reaalajas mitme südamelöögi hõivamise. 

MÄRKUS. Pikka telge, pinget, düssünkrooniat, aordiklapi tasapinna analüüsi, põhimiku interpoleerimist ja 
automaatset seina paksust reaalajas hõivamise puhul ei toetata. 

MÄRKUS. Pct paksenemist ja seina liikumise piirkondlikku analüüsi toetatakse ainult lõppsüstoolse puhul. 
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Analüüsimise protseduur
1. Tehke kõikide lõikude kõikide faaside lühikese telje automaatne segmenteerimine, vt lk 67.

2. Kui tuvastatakse reaalajas hõive, kuvatakse maatriksil , nagu on näidatud Joonis 29.

JOONIS 29.

3. Vaadake üle vahekaart Hingamine (Resp), soovitatav on lõpus väljahingamise analüüs, nagu näidatud Joonis 30. 

4. Hingamise kõverat saab vaadata iga lõigu asukoha kohta, muutes lõiku. Kui hingamise akent muudetakse, võivad ED 
ja ES-i määramised samuti muutuda, et need oleksid selles uues aknas. Graafiku vertikaalsete joonte klõpsamine ja 
lohistamine muudab hingamise akent ainult praeguse lõigu jaoks ja see alistab üldised hingamise seadistused. 

5. Kaasatavat hingamistsükli osa saab muuta kõigi lõikude jaoks samaaegselt liuguri abil (vaikimisi 50%), välja arvatud 
need lõigud, mida on käsitsi muudetud.

JOONIS 30. Hingamiskõvera näited kahest erinevast lõigust  

6. Maatriksi vaade näitab kasutatud piirväärtusi,  on algus ja punane nool  näitab analüüsis kasutatud 
hingamistsükli osa lõppu. 

7. Klõpsake vahekaardil LV või RV, et vaadata üle iga lõigu ED ja ES-i määramised (Joonis 31). 
ED ja ES-i faasid tuvastatakse iga lõigu jaoks automaatselt. ED või ES-i faaside määramist saab muuta, klõpsates või 
lohistades ED või ES-i ringi. (RV määramine põhineb LV faasi määramisel.)



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3                     95

JOONIS 31. LV mahu kõvera näited kahest erinevast lõigust. Punane punkt = ED; sinine punkt = ES 

MÄRKUS. Igal lühikese telje lõigul on ülevaatamiseks oma mahu kõver.

8. Südame minutimahu arvutamiseks sisestage südame löögisagedus ja klõpsake otse tulemuste tabelis. 

Soovitatud allikas
Chen C, Chandrasekaran P, Liu Y, Simonetti OP, Tong M, Ahmad R. „Ensuring respiratory phase consistency to improve cardiac function 
quantification in real-time CMR.“ Magn Reson Med. 2022 Mar;87(3):1595-1604. doi: 10.1002/mrm.29064. Epub 2021 Oct 31. PMID: 
34719067; PMCID: PMC8776600.
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Voolu analüüs
Voolu analüüsi režiim toetab nii 2D- kui ka 4D-voolu hõivamisi. Toetatakse nii käsitsi kui ka täisautomaatset 
segmenteerimist vooluhulga, -kiiruse, tagasivoolu mahu, rõhugradiendi, rõhu poolaja ja Qp/Q-de määramisega. Olenevalt 
kasutusmeetodi(te)st saadakse aordi-, mitraal-, kopsu- ja trikuspidaalregurgitatsiooni automaatne arvutamine. Täpsed 
voolutulemused sõltuvad sellest, kas kujutiste hõivamisel kasutatakse õiget skannimistasapinda, sobivaid 
hõiveparameetreid ja tasandipõhist voolukodeeringut.

MÄRKUS. Kui kujutise kvaliteet on halb, võib automaatne segmenteerimine olla vähem täpne. Sellistel juhtudel 
vastutab kasutaja kontuuride muutmise või käsitsi segmenteerimise eest.

MÄRKUS. Kui on tehtud nii 2D-faasikontrastne kui ka 4D-voolu analüüs, on kõik tulemused saadaval voolu analüüsi 
režiimis.

Eeltöötluse funktsioon toetab veresoone tüüpide tuvastamist 2D-faasikontrastsuse jaoks, nagu on loetletud tabelis 1, ning 
automaatse diskreetmoonutuse tuvastamist ja korrigeerimist. Vt suiteDXT kasutusjuhendit.

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.

- ROI paigutust 
- iga kategooria jaoks õige veresoone identifitseerimist
- Algtaseme korrigeerimine
- Automaatne diskreetmoonutuse korrigeerimine ja tuvastamine

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutamise ja õige kategooria 
määramise eest, kaasa arvatud need, mis on loodud või muudetud automaatse 
segmenteerimisalgoritmide abil. Tarkvara genereeritud kvantitatiivsed väärtused sõltuvad kõigi 
huvipakkuvate piirkondade täpsest paigutamisest ja õigest veresoone kategooria määramisest.

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.
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JOONIS 1. Voolu analüüsi liidese ülevaade

1. Veresoone kategooriad, 2. Valik Täiskasvanu/pediaatria, 3. Aktiivse ROI valik, 4. Graafiku ümberpööramine, 5. Valikute levitamine, 
6. Kustutamise suvandid, 7. Algtaseme korrigeerimise rippmenüü 8. Nihe: faas, dilatatsioon, vool, 9. Mürapikslite välistamine, 
10. Värvi läbipaistmatuse reguleerimine, 11. Diskreetmoonutuse korrigeerimine, 12. Kõvera režiimi valikud, 13. Automaatne diskreetmoonutus, 
14. Tulemuste tabeli valikud, 15. Kõvera tulemus/kuva, 16. Regurgitatsioonirežiim, 17. Redigeerimise tööriistad, 18. Integreeritud analüüs

MÄRKUS. Voolu analüüs kuvab magnituudi- ja faasikujutisi kõrvuti asetseva kujutise kuvana. Muid samast 
skannimiskohast saadud kujutise tüüpe ei kuvata ja need tuleks vaaturis üle vaadata.

MÄRKUS. Südame löögisageduse saab teada liigutades kursorit kõvera kuval voolutulemuse kohal.

1
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Voolu analüüs automaatse segmenteerimisega
Kui eeltöötlus on lõpetatud, tehakse uuringus sisalduva 2D faasikontrastsuse seeria põhjal segmenteerimine automaatselt 
2D faasikontrastsuse seeriatele ja määratakse vastavasse veresoone kategooriasse (tabel 1). Automaatne 
segmenteerimine ei nõua esialgse ROI paigutamist veresoonele, lihtsalt valige sobiv veresoone kategooria ja õige seeria, 
mis seda veresoont kuvab. Kui eeltöötlust ei tehta, on oluline valida sobiv kategooria, mis vastab saadud veresoone 
anatoomiale.

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õige kategooria 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus. 

MÄRKUS. Kui ühe vahekaardi kohta on faasikontrastsuse jaoks saadud rohkem kui kuus veresoont, jätab 
eeltöötlusfunktsioon alles ainult kuus kõige värskemat tulemust.

MÄRKUS. Netovoolu tulemus kuvatakse iga veresoone kategooria all. Kui veresoone kategoorias on rohkem kui üks 
voolumõõtmine, kuvatakse keskmist tulemust. Selle väärtuse peitmiseks valige Tööriistad (Tools) > 
Eelistused (Preferences) > Redigeeri süsteemi (Edit System) (ainult administraator) ja määrake voolu 
ühikuks PUUDUB (NONE) jaotises Vool (Flow). 

Tabel 1.  Veresoonte kategooriad

Veresoone kategooria Tööriista vihje Silt

LVOT Vasaku vatsakese väljavoolutrakt (pediaatria) 

pAAo Proksimaalne ülenev aort

mAAo Keskmine ülenev aort

pDAo Proksimaalne alanev aort
(Pediaatria)

SVC Ülemine õõnesveen
(Pediaatria)

MPA Peamine kopsuarter

RPA Parem kopsuarter
(Pediaatria)
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Automaatne või käsitsi segmenteerimine 
(Proksimaalse üleneva aordi segmenteerimise näide)

1. Valige Täiskasvanu või pediaatria .

2. Valige  kategooria.
3. Valige sobiv faasikontrastne seeria, mis näitab proksimaalset ülenevat aorti, nagu on näidatud Joonis 2.

JOONIS 2. Proksimaalne ülenev aort

4. Valige aktiivse ROI värv, nagu on näidatud Joonis 3.

JOONIS 3. Aktiivse ROI valimine

LPA Vasak kopsuarter
(Pediaatria)

IVC Alumine õõnesveen
(Pediaatria)

dDAo Distaalne alanev aort
(Pediaatria)

Vool 1, vool 2

Vool 3, vool 4

Kasutaja määratud kategooriad. Tehke paremklõps ja 
sisestage uus kategooria silt. Silti kuvatakse kohtspikrina. 

Tabel 1.  Veresoonte kategooriad

Veresoone kategooria Tööriista vihje Silt
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Võimalik on teha 6 ROI-d, numbritega 1–6. Värvikood jääb kogu analüüsi vaates, kujutiste vaateavades ja graafikutel 
samaks.

5. Valige .

6. Vaadake üle veresoone segmenteerimine. Veenduge, et segmenteeriti õige veresoon. 
Kui segmenteeriti vale veresoon, tehke segmenteerimine käsitsi.

7. Käsitsi segmenteerimiseks valige .

8. Looge veresoone ümber kontuur, paigutades 4 punkti huvipakkuva veresoone ümber ja viige kursor redaktori aknast 
väljapoole, et ROI saaks kinnitatud.

• Valige automaatseks segmenteerimiseks kõikides lõigu faasides 

või

• valige , et laiendada sama kontuuri kõikidele lõigu faasidele. See on kasulik, kui analüüsitakse väikseid statsionaarseid 
sooni.

9. Redigeerimiseks klõpsake kontuuril, redigeerige ja klõpsake . Vt Kontuuri redigeerimine lk 101.

10. Voolu tulemused kuvatakse graafikul ja tulemuste tabelites. Seotud kõvera graafikult eemaldamiseks valige voolu 
tulemuse kõrval olev märkeruut. 

11. Valige faili rippmenüüst suvand Algtaseme korrigeerimine (Baseline Correction).
Kõveratel, millel on tehtud algtaseme korrigeerimine, on tugevad faasi andmete punktid, nagu on näidatud Joonis 4. 
Vt Algtaseme korrigeerimise suvandid lk 103.

JOONIS 4. Voolu graafik – korrigeerimata (vasakpoolne graafik), korrigeeritud (parempoolne graafik)

Kõik genereeritud voolukõverad kuvatakse positiivses suunas. Ümberpööratud kõveraid tähistatakse nii .
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Veresoone kategooria teisaldamine

Kui pärast ülevaatamist nähtub, et tehtud voolutulemus ei ole õiges veresoone kategoorias, saab seda sobivasse 
kategooriasse liigutada.

Tehke vasakklõps kontuuril, seejärel paremklõps ja laske lahti. Viige kursor veresoonte tüüpidele ja valige õige kategooria, 
nagu on näidatud Joonis 5. (Näidatud on vaid pediaatria kategooriad). Voolu tulemus ilmub nüüd selle kategooria alla.

JOONIS 5. Veresoone kategooria teisaldamise valikud

Kontuuri redigeerimine
1. Valige faas, mida soovite redigeerida.

2. Tehke kontuuril vasakklõps, et see redigeerimiseks aktiveerida.
Kontuur muutub lillaks, mis näitab, et seda saab redigeerida.

3. Kui kuvatakse, redigeerige kontuuri, liigutades punktsplaini kontuuri punkte.

4. Tehke muudatused vaba käega, kasutades klõpsamist ja jooni. 

5. Valimiseks tehke kontuuril vasakklõps ja seejärel paremklõps tööriistade kasutamiseks, nagu on kirjeldatud tabelis 2. 

6. Kasutage vaateava redigeerimise tööriistu, nagu on kirjeldatud tabelis 3.

Tabel 2.  Paremklõpsu suvandid

Tööriist Kirjeldus

Kustuta praegusest faasist üks ROI

Kustuta kõikidest faasidest kõik ROI-d
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Faasivahemike redigeerimine
1. Valige soovitud lõik.

2. Valitud lõigu asukoha kõikide faaside vaateakende kuvamiseks valige .

3. Valige redigeeritavate faaside vahemiku esimene faas.

4. Vajutage ja hoidke all Shift-klahvi ning valige redigeeritava vahemiku viimane faas.

5. Redigeerige kontuuri Kujutiseredaktori (Image Editor) aknas.

6. Tühistage kontuuri valik, klõpsates kujutisel valitud kontuurist eemal või liigutades kursorit redaktori aknast 
väljapoole.

Müksamise tööriista valik

Tõmbamise tööriista valik

Näidatakse praegust veresoone kategooriat. Liiguta voolu tulemus teise kategooriasse

Tabel 3.  Vaateava redigeerimise tööriistad 

Tööriist Kirjeldus

Kopeeri muudatus faaside lõppu 

Kopeeri muudatus faaside algusesse 

Kopeeri ROI eelmisest faasist 

Kopeeri ROI järgmisse faasi 

Vähenda ROI suurust 

Tabel 2.  Paremklõpsu suvandid

Tööriist Kirjeldus
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Algtaseme korrigeerimise suvandid

2D-faasikontrastsuse voolu algtaseme korrigeerimiseks on kolm meetodit. Voolukõveratel, millel on rakendatud 
korrigeerimismeetodit, on tugevad faasi andmete punktid.

MÄRKUS. Analüüsiks kasutatavatel faasikontrastsetel kujutistel ei tohiks olla kujutise faaside kokkupakkimist. 
Kujutisel olev faaside kokkupakkimine muudab automaatse algtaseme korrigeerimise kehtetuks.

Automaatne algtaseme korrigeerimine

Automaatne algtaseme korrigeerimine parandab kujutise hõivamisel tekkivaid faasivigu, uurides faasivigu kaugemates 
fikseeritud organites (nt rindkere seinas, maksas jne) ja sobitades andmeid ruumiliselt lineaarse või kõrgema taseme 
interpolatsiooni abil.

MÄRKUS. Kui 2D magnituudi- ja faasiseeriad luuakse 3D/4D voolu vaaturi abil, loob rakendus ühe korrigeerimata 
seeria ja teise seeria, millele on rakendatud faasivea parandust. Ärge kasutage seeriatel, millel on silt 
Korrigeeritud (Corrected), algtaseme korrigeerimise rippmenüüs valikut Automaatne (Auto).

1. Genereerige voolukõver kasutades sobivat faasikontrastsuse seeriat.

2. Valige algtaseme korrigeerimise rippmenüüst valik Automaatne (Auto).

MÄRKUS. Automaatset algtaseme korrigeerimist rakendatakse 2D ja 4D jaoks automaatselt, kui Eelistustes on valitud 
Automaatne algtaseme korrigeerimine (Auto Baseline Correction). (ainult administraator)

3. Parandust rakendatakse uuendatud tulemustel, mis kuvatakse otse voolugraafikul.

4. Seeriad, millel sobivuse analüüs ebaõnnestub, tähistatakse hoiatussümboliga, nagu on näidatud Joonis 6.

Laienda ROI suurust

Liigu eelmisse ja järgmisesse faasi

Nihuta ROI-d paremale või vasakule

Nihuta ROI-d üles või alla 

Tabel 3.  Vaateava redigeerimise tööriistad 

Tööriist Kirjeldus
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MÄRKUS. Pildil olev faasi kokkupakkimine põhjustab ebatäpseid voolutulemusi, nagu on näidatud Joonis 7. 
Vooanalüüsiks kasutatavatel 2D-video faasikontrastsetel kujutistel ei tohiks olla kujutise faaside 
kokkupakkimisi, nagu on näidatud Joonis 8.

JOONIS 7. Faasi kokkupakkimisega kujutiste näidis (valged nooled)

JOONIS 8. Faasi kokkupakkimiseta kujutiste näidis

JOONIS 6. Algtaseme korrigeerimise ebaõnnestumine

Ebaõnnestumise tüübid:

1 – Kokkupakkimine kujutisel
2 – Müra kujutisel
3 – Kujutis on sobimatu
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Fantoomiga korrigeerimine

Faasikontrastsuse tulemuste täpsuse parandamiseks ja algtaseme faasinihke vigade parandamiseks saab selle vea 
arvutamiseks kasutada fantoomvõtet.

MÄRKUS. Fantoomkorrektsiooni seeriad peavad olema saadud samade skannimisparameetrite ja ettekirjutusega 
nagu algsed faasikontrastsed seeriad. Statsionaarselt objektilt tulev signaal peab täitma fantoomseerias 
kogu kontuuri.

1. Genereerige voolukõver kasutades sobivat faasikontrastsuse seeriat.

2. Valige Algtaseme korrigeerimise (Baseline Correction) rippmenüüst vastav fantoomseeria.

3. Parandust rakendatakse uuendatud tulemustel, mis kuvatakse otse voolugraafikul.

Taustakontuuri korrigeerimine

Seda korrigeerimismeetodit võib kaaluda veresoonte puhul, mis on ümbritsetud liikumatu koega.

MÄRKUS. Optimaalseks korrigeerimiseks tuleb taustakontuur asetada liikumatusse koesse, mis on vahetult 
voolupiirkonna kõrval ja ümbritseb seda.

1. Genereerige voolukõver kasutades sobivat faasikontrastsuse seeriat.

2. Valige algtaseme korrigeerimise rippmenüüst Tausta ROI (Backround ROI).

3. Kontuuri joonistamiseks klõpsake  .

4. Parandust rakendatakse uuendatud tulemustel, mis kuvatakse otse voolugraafikul.

Voolu tööriistad

Nihke suvandid 

Faili rippmenüüs on 3 suvandit: Faas, vool ja dilatatsioon

Tabel 4.  Nihke suvandid

Valik Kirjeldus

Faas Muudab voolukõver ordinaati.

Vool Muudab voolukõvera abstsissi väärtust, mis muudab voolutulemuste algtaseme väärtusi.

Dilatatsioon Muudab kõigis faasides segmenteeritud veresoone raadiust ühtlaselt määratud pikslite arvu 
võrra, et kaasata sobivad voolupikslid.
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Mürapikslite välistamine

See suvand tuvastab väikese intensiivsusega pikslid (suured kiiruste kõikumised), kui need ROI-s esinevad, märgib need 
roosa ülekattega, nagu on näidatud Joonis 10, ja jätab need voolu arvutamisest välja. Mürapikslite protsenti saab 
reguleerida liuguri abil.

JOONIS 9. Mürapikslid

JOONIS 10. Roosa ülekattega märgitud mürapikslid

Värvülekate

Punase/sinise värvülekatte kuvamiseks, mis näitab magnituudikujutistel kiirust, klõpsake ja lohistage värvi läbipaistmatuse 
liugurit. Kohandage kiirusvahemikku, määrates sinised või punased markerid, nagu on näidatud Joonis 11. Värvi 
läbipaistmatuse kohandamiseks valige vahekaardil Üldine (Global) jaotises Vool (Flow) suvand Tööriistad (Tools) > 
Eelistused (Preferences) > Redigeeri (Edit). Värvülekatte eemaldamiseks seadke läbipaistmatus 0% peale.

JOONIS 11. Värvülekatte juhtnupp
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Kiiruse diskreetmoonutuse automaatne korrigeerimine

Diskreetmoonutust saab korrigeerida ilma, et ROI-d kujutisel oleks. Kui seerias on rohkem kui üks lõigu asukoht, mõjutab 
automaatne või käsitsi toiming kõiki lõigu asukohti. Virnas ühe lõigu asukoha muutmiseks käsitsi korrigeerimisel kasutage 
liuguri juhtnupu muutmisel Ctrl- või Alt-klahvi.

JOONIS 12. Käsitsi korrigeerimine

MÄRKUS. Käsitsi korrigeerimist saab teha liuguri juhtmarkerit kasutades. Kui rakendatud on automaatne toiming, siis 
käsitsi korrigeerimine on keelatud.

Automaatse diskreetmoonutuse tuvastamise / korrigeerimise konfigureerimine

MÄRKUS. Kasutaja vastutab faasi pildi visuaalse ülevaatamise eest, et kinnitada diskreetmoonutuse korrigeerimine. 
Võib juhtuda, et tuvastatakse veresoone servas olevad mürapikslid, mis ei ole tõesed diskreetmoonutused.

MÄRKUS. Võib juhtuda, et diskreetmoonutust ei saa korrigeerida, mistõttu tuleb hõivamine teha kõrgema VENC-ga. 

Kui eeltöötluse või automaatse segmenteerimise käigus tuvastatakse diskreetmoonutus, tähistatakse see kollase kolmnurgaga, 
nagu on näidatud Joonis 13. 

1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System). (Ainult administraator) 

2. Valige jaotises Vool (Flow) märkeruut Automaatne diskreetmoonutuse tuvastamine (Aliasing Automatically 
Detected). 

Eeltöötlemisel hinnatakse iga 2D faasi kontrastsuse seeriat ja 4D voolu diskreetmoonutuse suhtes.

Kui diskreetmoonutus tuvastatakse, kuvatakse see kollase kolmnurgana: 

JOONIS 13. Tuvastatud on diskreetmoonutus (üks kollane kolmnurk)
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3. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System). (Ainult administraator) 

4. Valige jaotises Vool (Flow) märkeruut Diskreetmoonutuse korrigeerimine on vaikimisi sees (Aliasing Correction 
On By Default). 

Eeltöötlemise ajal tuvastatud diskreetmoonutus korrigeeritakse automaatselt.

Kui korrigeerimine on rakendatud, kuvatakse voolu tulemuses kollane kolmnurk. 

JOONIS 14. Diskreetmoonutus on tuvastatud ja korrigeeritud (kollane kolmnurk kuvatakse voolu tulemuse juures ja 
esiletõstetud ikooniga)

MÄRKUS. Kui korrigeerimise eelistus pole sisse lülitatud, klõpsake nuppu , et rakendada korrigeerimine. 

Kui see on valitud, tõstetakse ikoon esile sinise kontuuriga, nagu on näidatud. 

Soovitatud allikas

Phase unwrapping in 4D MR flow with a 4D single-step laplacian algorithm - Loecher - 2016 - Journal of Magnetic Resonance Imaging 
- Wiley Online Library.

https://onlinelibrary.wiley.com/doi/10.1002/jmri.25045
https://onlinelibrary.wiley.com/doi/10.1002/jmri.25045
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Kasutaja määratud tippkiirus
1. Valige südametsükli sobiv faas.

2. Kursori paigutamiseks faasi kujutisele kasutage .
Kursor sünkroonitakse nii magnituudi- kui faasikujutisega. Kiiruse tulemused ilmuvad faasi kujutisel kursori kõrval 
ühikuga mm/s.

JOONIS 15. Voolukiirus pikslil

Kõverarežiimi valikud

Tabel 5.  Kõvera režiimi valikud

Valik Režiim Kirjeldus

Vool Kõver kujutab iga faasi voolumahtu kogu südametsüklis 
(vaikimisi). Iga kõvera punkt kujutab selle faasi voolu. Kuvatakse 
netovoolu tulemused.

Histogramm Kuvab iga piksli kiiruse diagrammi igas huvipakkuvas piirkonnas 
südametsükli igas faasis. Kuvatakse tipp- ja keskmise 
rõhugradiendi tulemused.

Rõhu poolaeg (PHT) Aeg, mis kulub maksimaalse transmitraalse rõhugradiendi 
vähenemiseks poole võrra. Võimaldab tuvastada graafiku kalde, 
et arvutada PHT ja mitraalklapi pindala (MVA).

Võrdlus Võimaldab kuvada kahe erineva kategooria kõveraid. 

Regurgitatsioon Arvutab negatiivse netovoolu (x-telje all). 
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Histogrammirežiim

Valige histogrammirežiim, et kuvada kiiruste diagramm piksli kohta ning tipp- ja keskmise rõhugradiendi arvutamine.

1. Genereerige voolukõver kasutades sobivat faasikontrastsuse seeriat.

2. Valige .

3. Klõpsake otse graafikul, et aktiveerida faasikujutisel niitrist-kursor, mis näitab piksli asukohta.

4. Kasutage graafiku allosas olevaid topeltnoole nuppe, et leida kiiruse suurima või madalaima väärtuse asukoht 
(Joonis 16).

5. Kasutage üksiknoole nuppe, et suurendada veidi kiiruse väärtusi, nagu on näidatud Joonis 16.

MÄRKUS. Seeria asukoha määramise funktsioon on histogrammirežiimis keelatud, kui klõpsate otse voolukõveral. 
Asukoha määramise funktsiooni lubamiseks lülitage ümber voolurežiimile.

MÄRKUS. Et olla kindel, et kuvatakse õiget magnituudi- ja faasikujutist, töötage ühe voolukõveraga korraga, tühistage 
graafiku kuval teised histogrammikõverad.

MÄRKUS. Tarkvara suiteHEART® varasema versiooniga histogrammirežiimis analüüsitud uuringuid võib olla vaja 
uuesti analüüsida.

JOONIS 16. Histogrammirežiim

Rõhu poolaeg

Rõhu poolaeg (PHT) saadakse, kui mõõdetakse mitraalklapi faasikontrastsete kujutistel E-laine aeglustuskaldeid. See 
režiim võimaldab tuvastada graafiku kalde, et arvutada PHT ja mitraalklapi pindala (MVA).

1. Genereerige voolukõver, kasutades sobivat mitraalklapi faasikontrastset seeriat.

2. ROI laiendamiseks kasutage kopeerimise ja kleepimise suvandit.

3. Valige .

4. Kõvera aeglustusosa suurima kiiruse tuvastamiseks klõpsake otse diagrammil.
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5. Klõpsake kõvera kalde arvutamiseks lõpp-punktil, nagu on näidatud Joonis 17.

6. Arvutuse lähtestamiseks paigutage kursor lõpp-punkti kohale, tehke paremklõps ja valige prügikast.

JOONIS 17. Rõhu poolaja tulemused

MÄRKUS. Mitraalklapi pindala (MVA) ja rõhu poolaja (PHT) tulemused ei kehti aordipuudulikkusega, südame šundi või 
vähenenud ventrikulaarne vastavusega patsientidel.

MÄRKUS. Otse voolukõveral klõpsates on seeria asukoha määramise funktsioon PHT-režiimis keelatud. Asukoha 
määramise funktsiooni lubamiseks lülitage ümber voolurežiimile.

Soovitatud allikas

http://www.csecho.ca/mdmath/?tag=mvaph

Voolu tulemuste vaatamine

Valige voolu tulemuste vaatamiseks tabeli vormingus üks järgmistest suvanditest.

Tabel 6.  Tulemuste tabeli suvandid

Valik Silt Kirjeldus

Integreeritud 
analüüs

Kuvab analüüsitulemused voolu paanilt. Kaasab tulemused 
aordi, mitraalklapi, kopsu ja trikuspidaalse regurgitatsioonis ja 
Qp/Qs kohta. Vt Integreeritud analüüs lk 113.

Voolu analüüs Kokkuvõtlikud tulemused voolukõvera kohta. 

Andmete tabel Loendab üksikasjalikud voolu parameetrid iga faasi ja 
voolukõvera kohta.
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Voolu kategooria sildi muutmine
Muuta saab vaid Voolu 1 (Flow 1) kuni Voolu 4 (Flow 4) kategooriate silte.

JOONIS 18. Vool 1 kuni vool 4

Sildi muutmine

1. Paremklõpsake  (nagu on näidatud Joonis 18).
2. Sisestage uus sildi nimi (Joonis 19).
3. Uusi silte kuvatakse kohtspikritena. 

MÄRKUS. Kõvera tingmärkide sildile määratakse sama silt. 

JOONIS 19. Kategooria sildi redigeerimine 

MÄRKUS. Voolu kategooria sildi muutmine muudab voolu päise silti aruandes.

Kõvera tingmärkide redigeerimine 

1. Tehke paremklõps voolugraafiku allservas tähisel Vool 1:1 (Flow 1:1) (Joonis 20).

MÄRKUS. Kui kategooria silti muudeti, näidatakse seda silti.

JOONIS 20. Kõvera tingmärkide redigeerimine
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2. Sisestage uus sildi nimi.

JOONIS 21. Voolukõvera tingmärkide siltide muutmine

MÄRKUS. Uued voolukõvera tingmärgid salvestatakse praeguse malliga.

Integreeritud analüüs 
Lähtudes kasutaja valitud meetodist arvutab integreeritud analüüs Qp, Qs, Qp/Qs, aordi-, mitraalklapi-, kopsu- ja 
trikuspidaalse regurgitatsiooni mahud ja regurgitatsiooni fraktsioonid (RF%).

HOIATUS! Kasutaja vastutab Qp, Qs, aordi-, mitraalklapi-, kopsu- ja trikuspidaalse regurgitatsioooni mahtude ja 
regurgitatsiooni fraktsioonide määramise meetodi valimise eest. 

HOIATUS! Mõned või ükski meetod ei pruugi olla sobiv, olenevalt patsiendi patoloogiast. Kasutaja vastutab 
selle eest, et määrata, milline meetod on tõlgendamiseks sobiv.

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õige kategooria 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus.

MÄRKUS. Kasutaja saab määrataintegreeritud analüüsi jaoks vaikearvutusmeetodi, valides Tööriistad (Tools) > 
Eelistused (Preferences) > Redigeeri (Edit) faili rippmenüüst. Vaikemeetodi valikud on järgmised: 
Mitte ühtegi (None), Kõik (All) või Viimane (Last). 
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Integreeritud analüüsi ülevaade (näidatud on täiskasvanu kohta)

• Ühiku valik ml/löök või l/min
• BSA valiku indeks (pikkus ja kaal tuleb sisestada aruandluse liideses)
• Positiivse voolutulemuse valik

Qp ja Q valikud
• Qp: kuvab voolu väärtused MPA kategooriast 
• Qs: kuvab voolu väärtused kas pAAo või mAAo kategooriast
• Qp/Qs tulemus
• LV ja RV löögimahu tulemusi kuvatakse lühikese telje funktsiooni analüüsist.

Allajoonitud Qp või Qs väärtusi saab käsitsi sisestada. Lähtestamiseks kustutage 
väärtus ja vajutage sisestusklahvi.

Arvutusmeetodi saab valida järgmiste kohta: 
• 1 – Aordi regurgitatsioon ja RF%
• 2 – Mitraalklapi regurgitatsioon ja RF%
• 3 – Kopsu regurgitatisoon ja RF%
• 4 – Trikuspidaalne regurgitatsioon ja RF%

Allajoonitud regurgitatsiooni väärtusi saab käsitsi sisestada. Lähtestamiseks 
kustutage väärtus ja vajutage sisestusklahvi. 

1

2

3

4
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Tabel 7.  Qp/Qs valikud

MÄRKUS.  Kui veresoone kategoorial on rohkem kui üks mõõtmine, kasutatakse keskmist.

MÄRKUS. Qp või Qs jaoks saadakse väärtus ühest või kombineeritud valikust nagu on kirjeldatud tabelis.

Tulemus Valik Kirjeldus

Qp Voolu tulemus MPA kategooriast. 

Qp
(Pediaatria)

Voolu tulemus LPA-st + RPA-st.

Qs Voolu tulemus pAAo või mAAO kategooriast. Qs keskmise tulemuse jaoks valige 
mõlemad veresoone tüübid. 

Qs
(Pediaatria) 

Voolu tulemus LVOT kategooriast.

Qs
(Pediaatria) 

Voolu tulemus SVC + pDAo

Qs
(Pediaatria)

Voolu tulemus SVC + IVC

Qs
(Pediaatria)

Voolu tulemus SVC + dDAo

Qp/Qs= Tulemus põhineb eelnevatel valikutel.
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Qp/Qs arvutamine

1. Integreeritud analüüsi funktsiooni kasutamiseks valige üleval paremal VOOL (FLOW), nagu on näidatud Joonis 22.

JOONIS 22. Voolu vahekaart

2. Enne integreeritud analüüsi kasutamist veenduge, et kõik veresooned on õigesti määratud ja kontuurid on täpsed 
kõigis kategooriates.

• Kui segmenteeritud veresoon on vales kategoorias, tehke paremklõps ja liigutage see õigesse kategooriasse.

• Kui segmenteeritud veresoon on selle kategooria jaoks vale veresoon, kustutage aktiivne ROI ja klõpsake .
• Kui on tehtud automaatne segmenteerimine ja veresoon ei ole õigesti määratletud, tehke segmenteerimine käsitsi. 

Vt Automaatne või käsitsi segmenteerimine lk 99.

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õige kategooria 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus.

3. Qp jaoks valige .

4. Qs jaoks valige  või  või mõlemad veresoone kategooriad (kahe kategooria väärtustest võetakse keskmine).

5. Qp/Qs tulemus arvutakse nagu on näidatud Joonis 23.

JOONIS 23. Qp/Qs tulemused (näidatud täiskasvanu kohta)
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Arvutatud regurgitatsioonimaht ja regurgitatsiooni fraktsioon (RF%)

1. Integreeritud analüüsi funktsiooni kasutamiseks valige üleval paremal VOOL (FLOW), nagu on näidatud Joonis 24.

JOONIS 24. Voolu vahekaart

2. Enne integreeritud analüüsi kasutamist veenduge, et kõik veresooned on õigesti määratud ja kontuurid on täpsed 
kõigis kategooriates.

• Kui segmenteeritud veresoon on vales kategoorias, tehke paremklõps ja liigutage see õigesse kategooriasse. 

• Kui segmenteeritud veresoon on selle kategooria jaoks vale veresoon, kustutage aktiivne ROI ja klõpsake .
• Kui on tehtud automaatne segmenteerimine ja veresoon ei ole õigesti määratletud, tehke segmenteerimine käsitsi. 

Vt Automaatne või käsitsi segmenteerimine lk 99.

Tabel 8.  Regurgitatsioonimahu arvutamise meetodid

Valik Klapi tüüp Meetodi kirjeldus

Aordi Otse voolukõveralt (proksimaalne)

Aordi Otse voolukõveralt (keskmine)

Aordi
(Pediaatria)

LVOT positiivne voolukiirus – Qp

Mitraal Kaudne 
(Kasutatud LVSV saadakse lühikese telje funktsiooni tulemustest) 

Mitraal Kaudne
(Kasutatud LVSV väärtus saadakse lühikese telje funktsiooni tulemustest)

Kopsu Otse voolukõveralt (MPA)

Kopsu
(Pediaatria)

Otse voolukõveralt 
LPA + RPA negatiivne vool 

Trikuspidaal Kaudne
(Kasutatud RVSV saadakse lühikese telje funktsiooni tulemustest)

Trikuspidaal Kaudne
(Kasutatud RVSV saadakse lühikese telje funktsiooni tulemustest)
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HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õige kategooria 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus.

3. Valige arvutamise režiim. Joonis 25 näidatud aordi regurgitatsioon ja regurgitatsiooni fraktsioon arvutatakse valikuga 

 ning kopsu regurgitatsioon ja regurgitatsiooni franktsioon arvutatakse valikuga .

JOONIS 25. Aordi- ja kopsuregurgitatsiooni meetodi valikud (näidatud täiskasvanu kohta)

4. Regurgitatsiooni maht ja RF% arvutatakse nii, nagu on näidatud Joonis 26. Kasutatud nimetaja väärtus on aordi ja 
mitraalklapi jaoks LVSV ning trikuspidaalklapi ja kopsu jaoks RVSV. Teistsuguse väärtuse sisestamiseks tehke 
vasakklõpsa kolmnurgal ja sisestage väljale uus väärtus. Algväärtuse lähtestamiseks tühjendage lihtsalt väli ja vajutage 
sisestusklahvi, nagu on näidatud Joonis 26.

JOONIS 26. RF-i nimetaja

5. Kui on valitud rohkem kui üks arvutusmeetod, võetakse regurgitatsiooni mahu tulemuste väärtustest keskmine. 
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6. Mitraalregurgitatsiooni ja RF% arvutamiseks tuleb valida Qp, Qs ja aordi regurgitatsiooni meetod, nagu on näidatud 
Joonis 27.

7. Trikuspidaalregurgitatsiooni ja RF% arvutamiseks tuleb valida Qp, Qs ja pulmonaalse regurgitatsiooni meetod, 
nagu on näidatud Joonis 27.

8. Negatiivseid tulemusi peetakse kehtetuteks tulemusteks ja neid näidatakse kollase kolmnurgana, nagu Joonis 27. 

JOONIS 27. Meetodi valik (näidatud täiskasvanu kohta)
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Integreeritud analüüsi tulemuste ülevaatamine

Kõikide tulemuste ülevaatamiseks valige . 

MÄRKUS. Voolu ühikute valik on integreeritud analüüsi paani ülaosas, valige ml/löök või l/min.

MÄRKUS. Tulemusi saab indekseerida BSA-sse, valides integreeritud analüüsi paani ülaosas valiku BSA indeks 
(Index to BSA). Nii pikkus kui ka kaal tuleb sisestada vahekaardile Ajalugu. 

JOONIS 28. Integreeritud tulemused



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3         121

Müokardi hindamine 
Kasutaja vastutab huvipakkuvate piirkondade (ROI) korrektse ja täieliku paigutamise eest, kaasa arvatud nende eest, mis 
genereeritakse või muudetakse automaatse segmenteerimise algoritmi poolt. Kvantitatiivsed väärtused, mille genereerib 
tarkvara, sõltuvad nende huvipakkuvate piirkondade täpsest ja täielikust paigutamisest ja rakendatud lävedest.

Uuringu eeltöötlemise funktsioon võimaldab Hilisemat täiustamist (Late Enhancement) eeltöödelda. Vt suiteDXT 
kasutusjuhendit.

Müokardi hindamise (ME) analüüsi tööriist aitab erineva signaaliintensiivsusega piirkondi müokardis kvantitatiivselt 
määratleda. 

Olemas on neli analüüsi vahekaarti.

• Hiline täiustamine – määrab suurenenud ja madala signaaliintensiivsusega müokardi segmendid.
• T2 – määrab suurenenud signaali intensiivsusega müokardi segmendid musta verevoolu piltdiagnostika tehnikaga.
• Signaali diferentsiaal – kuvab taastumismassi tulemused kasutades Hilist täiustamist ja T2 analüüsi ja T2 signaali 

intensiivsuse (SI) suhet.
• Varane täiustamine – määrab müokardi signaali intensiivsuse ja absoluutse müokardi täiustamise protsendi suhte T1 

kaalutud kujutistest.

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.

- ROI paigutamine/tuvastamine
- RV sisestamise koht
- Signaali intensiivsuse läve

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

Analüüsi vahekaart



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3         122

Mõõtetulemuste siltide määramine
Kasutaja saab mõõtetulemuste silte määrata; vaikimisi silt on Täiustamine (Enhancement).

1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System). (ainult administraator)

2. Sisestage lisasildid tühjadele väljadele, nagu näidatud Joonis 1.

3. Valige vaikimisi silt. 
Seda silti kasutatakse kõikidel uutel analüüsidel. 

4. Klõpsake Salvesta ja välju (Save and Exit).

JOONIS 1. Siltide defineerimine

Mõõtmiste tabelis sildi muutmiseks tehke noolel vasakklõps, et valida uus silt. 

JOONIS 2. ME mõõtetulemuste sildid

Hilisema täiustamise analüüsimise protseduur

1. Valige .
2. Valige vahekaart Hiline täiustamine (Late Enhancement).
3. Valige sobiv lühikese telje seeria.

4. Automaatseks segmenteerimiseks valige .
5. Vaadake üle kõik endokardi ja epikardi jooned, RV sisestuspunkt ja iga lõigu lävi. 

Vajadusel muutke läve.
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JOONIS 3. Müokardi hindamise analüüs

1. Tulemuste tabel, 2. Polaardiagrammi valik, 3. Polaardiagrammi kuva, 4. Tulemuste tabeli kuva, 5. Kustuta, 6. Läbipaistmatus, 7. Polaardiagramm

6. Käsitsi segmenteerimiseks joonistage LV endokard põhimiku kõige kaugemas lõigus, valides .

7. Joonistage LV epikard valides .

8. Paigutage alumine RV sisestuspunkt, valides . 
9. ROI lõpetamiseks viige kursor redaktori aknast väljapoole.
10. Korrake samme 6–9, kuni kogu vatsake on segmenteeritud.
11. Veenduge põhimiku, keskosa ja tipu klassifitseerimises. 

1

2 

3

5 
6

4

7
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Algoritmi valimine

1. Valige faili rippmenüüst sobiv algoritm (Joonis 4).

JOONIS 4. Algoritmi valimine

2. Kui vaja, klõpsake , et lõigu läve väärtust maksimeerida. Klõpsake , et rakendada seda väärtust 

kõikidele lõikudele. Vajadusel kasutage liugurit, et iga lõigu läve algoritmi kohandada. Klõpsake , et läviväärtus 
lähtestada. 

3. Standardhälbe jaoks valige .

4. Paigutage normaalne ROI  normaalse müokardi segmenti. See ROI kopeeritakse kõikidesse lõikudesse, kui 
märkeruut Levita normaalset ROI-d (Propagate Normal ROI) on valitud.

5. Suvandi Automaatne (Auto) puhul annab läve reguleerimine täiustamise tõenäosuse. 

Läve muutmine

1. Kõrge intensiivsusega piirkondade lisamiseks valige . 

2. Madala intensiivsusega piirkondade lisamiseks valige .

3. Kummagi intensiivsusega piirkonna kustutamiseks valige  väike kustutamise tööriist või  suur kustutamise 
tööriist.

Polaardiagrammi kuvavormingud

ME analüüsi tööriistal on 2 polaardiagrammi vormingut: 16 segmendiga ja kontsentriline.

Suvand 1: 16 segmendiga polaardiagramm

1. Valige 16 segmendi (16 Segment) vahekaart .

2. Valige 2 värvi, 4 värvi või pidev.

Värvide kasutamist saab määrata värvide skaalaribal klõpsates.

Väärtuse protsendi muutmiseks klõpsake ja lohistage otse värvijaotajal.
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JOONIS 5. Polaardiagrammid

3.  Polaardiagrammi koondtabeli kuvamiseks valige  .

Suvand 2: lõik-lõigu haaval vorming

1. Valige vahekaart Kontsentriline (Concentric). 

JOONIS 6. Kontsentriline vahekaart

Kontsentriline vahekaart pakub eelistusi, mis muudavad polaardiagrammi vormingu lõik-lõigu haaval vormingule, kus iga 
rõngas tähistab lõiku. Rõngaste arvu määrab analüüsitud lõikude arv.

2. Valige sektorite arv.

3. Valige alamsektorid, mis näitavad ROI massiprotsendi muutusi sektori kohta.

Alamsektorite valimisel rakendatakse silumisfunktsiooni.

4. Valige märkeruut Pidev (Continuous), et muuta polaardiagramm signaali intensiivsuse protsendiks ja kodeerida 
värvidega pideva spektri väärtused vahemikus 0–100%.

Kontuuride kustutamiseks klõpsake .

2 värviga polaardiagramm 4 värviga polaardiagramm Sujuva värviüleminekuga polaardiagramm
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MÄRKUS. Hilise täiustamise analüüsi poolautomaatne lävi töötab optimaalselt kõrge kvaliteediga müokardi 
hindamise kujutistel, nagu näidatud allpool (illustratsioon A). Kujutistel, mis saadakse ilma signaalita 
verekogumilt (illustratsioon B) või vale inversiooni ajaga, peab kasutaja subjektiivselt läve sätestama. 

JOONIS 7. Müokardi hilise täiustamise kujutised

T2 analüüs
1. Valige vahekaart T2.

2. Kui hilise täiustamise seeriat on eelnevalt analüüsitud, saab ROI-d T2-seeriasse kopeerida, valides koopia (vt Joonis 8).

MÄRKUS. ROI-de kopeerimiseks peab täpsete tulemuste saamiseks lõikude arv iga seeria jaoks kokku langema; kui 
lõikude arv ei lange kokku, ei ole kopeerimisnupp saadaval. Kasutada saab DICOM-i importimist, et luua 
vastavad seeriad, mis sisaldavad sama arvu lõike. 
Parimate tulemuste saavutamiseks peaksid hõivamise parameetrid, nagu maatriks ja vaateväli (FOV), olema 
iga seeria jaoks samad. Pärast kopeerimist vaadake hoolikalt üle kõigi lõikude asukohtade ROI-d ja tehke 
vajalikud muudatused. 

JOONIS 8. Kopeerimise nupp

3. Kui varasemat hilise täiustamise analüüsi ei ole, saab ROI-d luua käsitsi.
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4. Joonistage LV endokard kõige põhimikupoolsele lõigule, valides .

5. Joonistage LV epikard valides .

6. Märkige alumine RV sisestuspunkt, valides .

7. ROI lõpetamiseks viige kursor redaktori aknast väljapoole.

8. Korrake samme 4–7, kuni kogu vatsake on segmenteeritud.

9. 2 standardhälbe läve jaoks valige Lisa normaalne ROI (Add Normal ROI)  ja pange ROI normaalsesse müokardi 
segmenti. See ROI kopeeritakse kõikidesse lõikudesse, kui märkeruut Levita normaalset ROI-d (Propagate Normal ROI) 
on valitud. Vaadake üle iga lõigu asukoht ja vajadusel kohandage ROI-d.

MÄRKUS. Kui skeletilihaste ROI ja normaalne ROI on saadud, teostab tarkvara järgmise arvutuse:
Normaliseeritud müokardi T2 SI = müokardi SI / skeletilihase SI; 
Läve arvutamine: Lävi = 2 * STD NORMAL + AVG NORMAL

10. Valige esimene põhimiku lõik ja kasutage lõikude klassifikatsiooni rippmenüüd, et valida Põhimik (Base). Kinnitage 
ülejäänud viilude klassifikatsioonid. Vajadusel kasutage liugurit, et iga lõigu läve algoritmi kohandada.

11. T2 signaali intensiivsuse analüüsi tegemiseks valige Lisa skeletilihase ROI (Add Skeletal muscle ROI)  ja pange 
ROI skeletilihasesse. See ROI kopeeritakse kõikidele kujutistele. Vaadake üle iga lõigu asukoht ja vajadusel kohandage 
ROI-d. 

MÄRKUS. Musta vere kujutistel võib olla ebapiisav voolu summutamine, mis võib põhjustada signaali intensiivsuse 
ebatäpset analüüsi ja läve. Ebapiisav voolu summutamine võib põhjustada signaali kõrge intensiivsuse, 
mida võidakse segamini ajada müokardi tursega. Madala signaali intensiivsusega artefaktid võivad 
põhjustada vale madala tulemuse.

Redigeerimine

Kõrge T2 signaali intensiivsusega piirkondade lisamiseks valige .

Kõrge T2 signaali intensiivsusega piirkondade eemaldamiseks valige väike kustutustööriist  või suur 

kustutustööriist .

Kontuuride kustutamiseks klõpsake .
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Kombineeritud analüüs

Hiline täiustamine ja T2

Kombineeritud analüüsirežiim võimaldab hilise täiustamise ja T2 (turse) kujutiste jaoks kõrvuti analüüsi koos 
redigeerimise tööriistadega.

MÄRKUS. Kombineeritud analüüsirežiimi lubamiseks tuleb vahekaardi Hiline täiustamine abil esmalt lõpule viia 
lühikese telje hilise täiustamise seeria analüüs. T2 (turse) kujutised peavad olema samas uuringus. 

1. Valige .

2. Valige sobiv uuring nii Hilise täiustamine kui ka T2 (turse) kujutistega. Viige lõpule hilise täiustamise analüüsimise 
protseduur.

MÄRKUS. Enne kombineeritud analüüsirežiimi valimist vaadake vahekaardil Hiline täiustamine üle iga lühikese telje 
lõigu lävi. 

3. Valige vahekaart T2 ja viige läbi T2-seeria analüüsimise protseduur.
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4. Kombineeritud analüüsi alustamiseks valige , nagu on näidatud Joonis 9.

JOONIS 9. Kombineeritud analüüsirežiim

5. Valiku tegemisel ilmuvad režiimi vaate aknasse varem analüüsitud hilise täiustamise seeriad. Sellest aknast saab siis 
redaktori aken hilise täiustamise kujutiste jaoks.

6. Hilise täiustamise kujutiste redigeerimiseks kasutage redigeerimise tööriistu, mis asuvad kujutise vaateava all, nagu 
on näidatud joonisel 10.

MÄRKUS. Kinnitage kõik tulemuste uuendused otse vahekaardil Hiline täiustamine (Late Enhancement).

MÄRKUS. Kui LV endokardi või LV epikardi ROI-d on kustutatud, minge joonistamiseks uuesti vahekaardile Hiline 
täiustamine.

T2 (turse) Hiline
Täiustamine
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JOONIS 10. Hilise täiustamise redigeerimise tööriistad

7. Vasaku T2 (turse) seeria redigeerimiseks kasutage redigeerimise tööriistu, mis asuvad kujutise vaateava kohal, 
nagu näidatud Joonis 11.

JOONIS 11. T2 (turse) analüüsitööriistad



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3         131

8. Kasutage miinus- ja plussnuppe, et navigeerida hilise täiustamise seeria erinevale lõigutasemele, nagu on näidatud 
Joonis 12.

• Lõigu asukohateave asub iga vaateava alumises paremas nurgas.

MÄRKUS. Hilise täiustamise jaoks kuvatav lõigu asukoht määratakse T2 (turse) redaktori aknas lõigu asukoha järgi. 
Selle valiku tühistamiseks kasutage miinus-/plussnuppe. 

JOONIS 12. Hilise täiustamise lõikude sirvimise juhtnupud 

9. Teisele lõigutasandile navigeerimiseks nii hilise täiustamise kui T2 (turse) seeriatel kasutage T2 (turse) redaktori 
vaateava all olevaid miinus- ja plussnuppe, nagu näidatud Joonis 13. 

MÄRKUS. Kombineeritud analüüsirežiimis vasakul olevad miinus- ja plussnupud on ühised sirvitava lõigu mõlema 
vaateava jaoks.

JOONIS 13. Kombineeritud lõigu sirvimise juhtnupud

Lõigu asukoht Lõigu asukoht
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Signaali diferentsiaali tulemused

Valige signaali diferentsiaali vahekaart

MÄRKUS. Taastumismassi tulemuste saamiseks tuleb lõpule viia Hiline täiustamine ja T2 analüüs. T2 analüüs tuleb 
lõpetada skeletilihase ROI paigutamisega T2 signaali intensiivsuse (SI) analüüsi jaoks.

MÄRKUS. Kui T2 (turse) tulemus on väiksem kui hilise täiustamise tulemus (infarkt + MVO), on taastumismassi 
tulemus tühi.

JOONIS 14. Signaali diferentsiaali vahekaart
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Varase täiustamise analüüs
Analüüsiks on vajalikud lühikese telje kujutised, mis kasutavad väravatega spin-kaja T1 järjestust, eel- ja järeltäiustamist. 
Analüüs võimaldab algses seerias epikardi ja endokardi käsitsi segmenteerida kasutades kopeerimisfunktsiooni absoluutse 
võimenduse % (AE) ja Varase Gd täiustamise suhte (EGEr) arvutamiseks. Müokardi piirkondade analüüsimiseks saab 
kasutada kohalikku ROI-d. 

MÄRKUS. Musta vere kujutistel võib olla ebapiisav voolu summutamine, mis võib põhjustada signaali intensiivsuse 
ebatäpset analüüsi ja läve.

1. Valige vahekaart Varane täiustamine (Early Enhancement).

2. Valige sobiv lühikese telje T1 kaalutud seeria. 

3. Joonistage LV endokard kõige põhimikupoolsele lõigule, valides .

4. Joonistage LV epikard valides .

5. Märkige alumine RV sisestuspunkt, valides .

6. ROI lõpetamiseks viige kursor redaktori aknast väljapoole.

7. Korrake samme 3–6, kuni kogu vatsake on segmenteeritud. 

8. Lisage skeletilihase ROI, valides .

9. Valige põhimiku lõigu asukoht. Klõpsake rippmenüüd Lõigu klassifitseerimine (Slice Classification) ja valige Põhimik 
(Base). 

10. Veenduge iga lõigu põhimiku, keskosa ja tipu klassifitseerimises. 
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11. Konkreetse müokardi piirkonna analüüsimiseks valige  ja joonistage müokardi ROI.

JOONIS 15. Lõikude klassifikatsioon ja seeriatüübi valik

12. Valige seeriatüüp Eelnev (Pre). 
Kui Varane Post (Early Post) seeria segmenteeriti kõigepealt, valige Varane Post (Early Post).

13. Valige sobiv lühikese teljega T1 kaalutud Varane Post (Early Post) seeria tüüp. 
Kui Varane Post (Early Post) seeria segmenteeriti kõigepealt, valige eelseeria (Pre series).

14. Valige Kopeeri.

15. Vaadake üle kõik endokardi ja epikardi jooned, RV sisenemine ja skeletilihaste paigutused ning redigeerige neid 
vastavalt vajadusele.

16. ROI-sid saab kopeerida ainult siis, kui kõik ROI-d ja RV-de sisenemised, lõikude klassifikatsioon, seeriatüüp 
(sammud 3-12) on valitud seerias lõpetatud.

MÄRKUS. Kui endokardi või epikardi joon on kustutatud, kasutage Tühista (Undo).

MÄRKUS. Skeleti ROI-d saab reguleerida iga lõigu asukoha puhul. Kustutamise korral tuleb analüüs uuesti teha. 

17. Klõpsake  valige KÕIK (ALL): Varane täiustamine (Early Enhancement) kõikide analüüside eemaldamiseks.

MÄRKUS. ROI-de kopeerimiseks peab täpsete tulemuste saamiseks lõikude arv iga seeria jaoks kokku langema; kui 
lõikude arv ei lange kokku, ei ole kopeerimisnupp saadaval. Kasutada saab DICOM-i importimist, et luua 
vastavad seeriad, mis sisaldavad sama arvu lõike.

MÄRKUS. Parimate tulemuste saavutamiseks peaksid hõivamise parameetrid, nagu maatriks ja vaateväli (FOV), olema 
iga seeria jaoks samad. Pärast kopeerimist vaadake hoolikalt üle kõigi lõikude asukohtade ROI-d ja tehke 
vajalikud muudatused.
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Lokaalne ROI tööriist
1. Valige sobiv täiustamiseelne lühikese teljega T1 kaalutud seeria. 

2. Joonistage konkreetses müokardi piirkonnas lokaalne ROI, valides .

3. Lisage skeletilihase ROI, valides .

4. Valige õige lõigu klassifikatsioon ja seeria tüüp nagu näidatud Joonis 16.

JOONIS 16. Lõikude klassifikatsioon ja seeriatüübi valik

5. Valige sobiv lühikese teljega T1 kaalutud Varane Post (Early Post) seeria tüüp.

6. Valige Kopeeri. 

7. Klõpsake  valige KÕIK (ALL): Varane täiustamine (Early Enhancement) kõikide analüüside eemaldamiseks.

Soovitatud allikad

Abdel-Aty H, Boyé P, Zagrosek A, Wassmuth R, Kumar A, Messroghli D, Bock P, Dietz R, Friedrich MG, Schulz-Menger J. 
„Diagnostic performance of cardiovascular magnetic resonance in patients with suspected acute myocarditis: comparison 
of different approaches.“ J Am Coll Cardiol. 2005 Jun 7;45(11):1815-22. doi: 10.1016/j.jacc.2004.11.069. PMID: 15936612.

Amado LC, Gerber BL, Gupta SN, Rettmann DW, Szarf G, Schock R, Nasir K, Kraitchman DL, Lima JA. „Accurate and 
objective infarct sizing by contrast-enhanced magnetic resonance imaging in a canine myocardial infarction model.“ J Am 
Coll Cardiol. 2004 Dec 21;44(12):2383-9. doi: 10.1016/j.jacc.2004.09.020. PMID: 15607402.

Berry C, Kellman P, Mancini C, Chen MY, Bandettini WP, Lowrey T, Hsu LY, Aletras AH, Arai AE. „Magnetic resonance 
imaging delineates the ischemic area at risk and myocardial salvage in patients with acute myocardial infarction. Circ 
Cardiovasc Imaging.“ 2010 Sep;3(5):527-35. doi: 10.1161/CIRCIMAGING.109.900761. Epub 2010 Jul 14. PMID: 20631034; 
PMCID: PMC2966468.

Ferreira VM, Schulz-Menger J, Holmvang G, et al. „Cardiovascular Magnetic Resonance in Nonischemic Myocardial 
Inflammation: Expert Recommendations.“ J Am Coll Cardiol. 2018;72(24):3158-3176. doi:10.1016/j.jacc.2018.09.072.

Galea N, Francone M, Fiorelli A, Noce V, Giannetta E, Chimenti C, Frustaci A, Catalano C, Carbone I. „Early myocardial 
gadolinium enhancement in patients with myocarditis: Validation of “Lake Louise consensus” criteria using a single bolus 
of 0.1mmol/Kg of a high relaxivity gadolinium-based contrast agent.“ Eur J Radiol. 2017 Oct;95:89-95. doi: 10.1016/
j.ejrad.2017.07.008. Epub 2017 Jul 27. PMID: 28987703.
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T1 kaardistamise analüüs
See funktsioon võimaldab mõõta pikisuunalise spinn-võre relaksatsiooniaja (T1) signaali. Rakendus toetab T1 analüüsi nii 
algsete (täiustamata) kui ka täiustusjärgsete kujutiste jaoks ning ekstratsellulaarse mahufraktsiooni (ECV) arvutamist.

Vajalikud kujutised: erinevate inversiooniaegadega (TI) inversiooni või küllastuse taastamise kujutised või järjestusesisesed 
kaardid. Analüüsiks soovitatakse seeriaid, millel on rakendatud liikumise korrektsiooni. Soovitatavad on vasaku vatsakese 
põhimiku, keskosa ja tipu tüüpilised lõikude asukohad.

Täiendavate juhiste saamiseks T1 kaardistamise teostamise kohta vaadake järgmist artiklit.

Messroghli, D.R., Moon, J.C., Ferreira, V.M. et al. Clinical recommendations for cardiovascular magnetic resonance 
mapping of T1, T2, T2* and extracellular volume: A consensus statement by the Society for Cardiovascular Magnetic 
Resonance (SCMR) endorsed by the European Association for Cardiovascular Imaging (EACVI). J Cardiovasc Magn Reson 
19, 75 (2017). https://doi.org/10.1186/s12968-017-0389-8

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.

- ROI paigutamine/tuvastamine
- RV sisestamise koht

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt mõõdetavaid tulemusi. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutamise eest, sealhulgas 
automaatse segmenteerimisega loodud piirkondade eest.

MÄRKUS. T1 kaardistamise eelistuste seadistamiseks valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri 
(Edit). Valige vahekaart T1/T2/T2*.

MÄRKUS. Soovitav on oma skanneri tüübi eelistustes seadistada Automaatne seeriate koostamine analüüsiks (Auto 
Compose Series for Analysis). Analüüsiks on vaja, et kõik lõigu asukohad oleksid ühes seerias. Valige 
Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). Valige vahekaart Automaatne seeriate 
koostamine (Auto Compose Series).
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JOONIS 1. T1 kaardistamise liides

1. Automaatne segmenteerimine, 2. T1 tulemused, 3. Hematokriti sisestamine, 4. Järjestuse tüübi valimine, 
5. Värvikaardi ülekatte valikud, 6. Värvikaardi suvandid, 7. Kuvatava sektori ülekate, 8. Redigeerimise levitamine, 9. Endo/Epi nihe, 
10. Kõver või 16 segmendiga polaardiagramm või tabel, 11. T1 kõverad, polaardiagrammid, tabelid 

Analüüsi tegemine

1. Valige .
2. Valige sobiv ajaseeria või kaardiseeria.

3. Klõpsake nuppu , et teha vajaduse korral liikumise korrektsioon. Luuakse uus seeria sildiga MOCO. Seda seeriat 
saab kasutada analüüsimiseks.

MÄRKUS. Liikumise korrektsiooni saab eeltöötluse jaoks konfigureerida.
4. Värvikaart kuvatakse automaatselt, kui ülekatte eelistus on valitud.
5. Erineva värviskaala valimiseks kasutage faili rippmenüüd.

6. Üleüldise T1 tulemuse loomiseks valige .

7. Vaadake üle kõik endokardi ja epikardi jooned, RV sisestuspunkt ja verekogumi paigutus.

8. Redigeerige ebatäpseid kontuure.

9

34

1
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9. Kasutage kontuuride muutmiseks nihkenuppu Endo (punane) või Epi (roheline). 

 Levita nihet kõikidele lõikudele.  Ühe lõigu nihe.

10. Ühe inversiooniaja redigeerimiseks tühjendage märkeruut .

11. Kinnitage lõikude klassifikatsioon iga lõigu ja seeriatüübi jaoks.

MÄRKUS. Kui lühikese teljega kujutiste virn on segmenteeritud, võetakse T1 tulemuse keskmine põhimiku, keskosa 
või tipu ja 16-segmendiliste polaardiagrammi sektorite jaoks lõikude klassifikatsiooni alusel. Verekogumi T1 
tulemuse puhul ei võeta keskmist.

12. ECV arvutamiseks tehke automaatne segmenteerimine nii algseeriale kui ka täiustamisjärgsetele seeriatele.
13. Vaadake üle kõik endokardi ja epikardi jooned, RV sisestuspunkt ja verekogumi paigutus mõlemas seerias.

14. Müokardi segmendi mõõtmiseks valige .

MÄRKUS. Lokaalse ROI kopeerimiseks kasutage kopeerimist/kleepimist algkujutiselt täiustamisjärgsele kujutisele, kui 
ECV arvutatakse.

MÄRKUS. Saab luua kuni viis lokaalse ROI mõõtmist põhimiku, keskosa ja tipu jaoks.

15. Verekogumi ROI paigutamiseks valige  , kui vaja. 

16. Sisestage hematokriti (HCT) väärtus.

17. ECV tulemus (%) kuvatakse tulemuste tabelis.

18. Käsitsi segmenteerimine on võimalik. 

• Joonistage LV endokard valides .

• Joonistage LV epikard valides .

• Märkige RV sisestuspunkt, valides .

• Kui arvutatakse ECV paigutage verekogumi ROI valides .

• Kinnitage lõikude klassifikatsioon iga lõigu ja seeriatüübi jaoks.

Soovitatud allikas 

Wong. et al,. „Association Between Extracellular Matrix Expansion Quantified by Cardiovascular Magnetic Resonance and 
Short-Term Mortality.“ Circulation (2012):126:1206-1216.
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16 segmendiga polaarkaart

MÄRKUS. ECV polaardiagrammiks peab ECV analüüsi olema lõpule viidud.

1. Lõpetage põhimiku, keskosa ja tipu T1 üldine analüüs.

2. Kinnitage RV sisestuspunkt iga lõigu asukoha jaoks. 

3. Kinnitage õige lõikude klassifikatsioon ja seeria tüüp.

4. Valige 16-segmendiga polaardiagramm .

5. Sektori ülekatte kuvamiseks otse kujutisel valige .

6. Kui analüüsiti ajaseeriat, valige T1 kõverate juurde naasmiseks Graafikud .

T1 tulemuste väärtuste vorming

MÄRKUS. Globaalne tulemus on T1 väärtuste keskmine pikslite kaupa. 

Tulemus DICOM-i kujutised Kaardi kujutised

Üldine keskmine +/– std keskmine +/– std

Põhimik/keskosa/tipp väärtus +/– viga keskmine +/– std

Kohalikud ROI-d väärtus +/– viga keskmine +/– std

Kohalik keskmine +/– std keskmine +/– std

Verekogum väärtus +/– viga keskmine +/– std
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Kontuuride kustutamine

Valitud seeria KÕIKIDE (ALL) kontuuride kustutamiseks valige .

Ühe kontuuri kustutamiseks tehke kontuuril vasakklõps ja seejärel paremklõps või valige , et kustutada kontuurid 
kõikides ajapunktides.

T1 kõvera ülevaatamine 
1. Kõverale sobivad tulemused näitavad kujutise andmete signaali käitumist. Valest registreerimisest, hingamisest või 

arütmiatest tingitud kujutise artefaktide korral ei pruugi kõvera sobivus olla optimaalne.

2. Signaali intensiivsuse punkti saab arvutusest välja jätta, klõpsates otse graafiku vastaval punktil ja valides kujutisel 
kontuuri, mis muutub lillaks.

3. Valige paremklõpsumenüüst kustutamine (klõpsake ja hoidke all) või vajutage klaviatuuril kustutusklahvi.

MÄRKUS. Kõvera kuva genereeritakse ainult analüüsiks kasutatavate ajaseeriate abil.

HOIATUS! T1 kõverale sobivad tulemused peaks üle vaatama nõuetekohaselt koolitatud ja kvalifitseeritud 
kasutaja. 

Soovitatud allikas 

*Messroghli D. R. et al,. „Modified Look-Locker Inversion Recovery (MOLLI) for High Resolution T1 Mapping of the Heart.“ 
Magnetic Resonance in Medicine (2004) 52: 141–146. 

Tulemus Võrrand Sobivuse tüüp

T1 Look-Locker (MOLLI) y=A-B exp(-t/T1*) Mittelineaarne kõvera sobivus, mis kasutab Levenberg-Marquardt 
algoritmi*
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Siemens MyoMaps inversiooni korrigeerimise faktor (ICF)
Skanneri genereeritud T1 kaardiga sarnaste ajaseeriate kujutiste analüüsimisel T1 tulemuste saamiseks kinnitage 
MyoMaps MOLLI protokollide jaoks kasutatud efektiivsuse inversiooniimpulss. Soovitatav on inversiooniparanduse tegur 
ICF = 1,0365, kui skanneril on jaotises Magn Preparation Contrast/Common kaardi all märgitud „Non-sel IR T1 Map“. 
Täiendava selgituse saamiseks on soovitatav võtta ühendust oma Siemensi rakenduste tugispetsialistidega.

Ajaseeriate kujutiste analüüsimiseks sisestage eelistustes sobiv ICF, nagu on näidatud Joonis 2.

1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System). (Ainult administraator)

2. Valige vahekaart T1/T2 kaardistamine (T1/T2 Mapping).

3. Tarnijast lähtuvalt sisestage ICF.

JOONIS 2. T1 kaardistamise eelistused

Soovitatud allikas

Kellman, P., Hansen, M.S. „T1-mapping in the heart: accuracy and precision.“ J Cardiovasc Magn Reson 16, 2 (2014).
https://doi.org/10.1186/1532-429X-16-2
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T2 kaardistamise analüüs
See funktsioon võimaldab T2 lõõgastusaja signaali mõõta. T2 kaardistamine on kudede iseloomustamise tehnika.

Vajalikud kujutised: T2 ettevalmistuse järjestus stabiilse oleku vaba pretsessiooni näiduga koos varieeruvate kajaaegadega 
(TE) või järjestusesisesed kaardid. Analüüsiks soovitatakse seeriaid, millel on rakendatud liikumise korrektsiooni. 
Soovitatavad on vasaku vatsakese põhimiku, keskosa ja tipu tüüpilised lõikude asukohad.

Mittelineaarse 2-punktilise võrrand on y = a * exp(-TE/T2), kus TE on kajaaeg või T2 ettevalmistuse kestus, olenevalt 
järjestusest.

Mittelineaarse 3-punktilise võrrand on y = a * exp(-TE/T2) + c, kus a, T2 ja c on koefitsiendid (parameeter tuleb arvestada 
sobivuse järgi).

Lineaarse 2-punktilise võrrand on Y = A – TE/T2, kus Y = log(y) ja A = log(a).

MÄRKUS.  Lineaarse ja mittelineaarse 2-punktilise sobitamise korral tausta lahutamist ei tehta.

Täiendavate juhiste saamiseks T2 kaardistamise teostamise kohta vaadake järgmist artiklit.

Messroghli, D.R., Moon, J.C., Ferreira, V.M. et al. Clinical recommendations for cardiovascular magnetic resonance 
mapping of T1, T2, T2* and extracellular volume: A consensus statement by the Society for Cardiovascular Magnetic 
Resonance (SCMR) endorsed by the European Association for Cardiovascular Imaging (EACVI). J Cardiovasc Magn Reson 
19, 75 (2017). https://doi.org/10.1186/s12968-017-0389-8

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.

- ROI paigutamine/tuvastamine
- RV sisestamise koht

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt mõõdetavaid tulemusi. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutamise eest, sealhulgas 
automaatse segmenteerimisega loodud piirkondade eest.

MÄRKUS. T2 kaardistamise eelistuste seadistamiseks valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri 
(Edit). Valige vahekaart T1/T2/T2*.

MÄRKUS. Soovitav on oma skanneri tüübi eelistustes seadistada Automaatne seeriate koostamine analüüsiks 
(Auto Compose Series for Analysis). 
Analüüsiks on vaja, et kõik lõigu asukohad oleksid ühes seerias. Valige Tööriistad (Tools) > Eelistused 
(Preferences) > Redigeeri (Edit). 
Valige vahekaart Automaatne seeriate koostamine (Auto Compose Series).
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JOONIS 1. T2 kaardistamise liides

1. Automaatne segmenteerimine, 2. T2 tulemused, 3. Parameetrite sobitamise valikud 4. Värvikaardi ülekatte valikud, 5. Värvikaardi suvandid,
6. Kuvatava sektori ülekate, 7. Redigeerimise levitamine, 8. Endo/Epi nihe, 9. kõver või 16 segmendiga polaardiagramm või tabel, 
10. T2 kõverad, polaardiagrammid, tabelid 
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Analüüsi tegemine

1. Valige .
2. Valige sobiv ajaseeria või kaardiseeria. 
3. Ajaseeriate analüüsimisel valige sobitamismeetod.

MÄRKUS. Mittelineaarse sobitamise algoritm ei võta arvesse taustamüra. 

MÄRKUS. T2 tulemuste hankimiseks, kasutades Siemensi originaalseid DICOM-i kujutisi, mis on sarnased loodud 
Siemensi skanneri T2 kaardiga, valige Lineaarne sobitamine (Linear Fitting).

4. Kui soovite, seadistage värvikaardi eelistus automaatselt värvikaarti kuvama.
5. Erineva värviskaala valimiseks kasutage faili rippmenüüd.

6. Üleüldise T2 tulemuse loomiseks valige .
7. Vaadake üle kõik endokardi ja epikardi jooned ning RV sisestuspunkt.

8. Redigeerige ebatäpseid kontuure.

9. Kasutage kontuuride kohandamiseks Endo (punane) või Epi (roheline) nihet 

.

 Levita nihet kõikidele lõikudele.  Ühe lõigu nihe.

10. Ühe ajakaja redigeerimiseks tühjendage märkeruut .

11. Kinnitage lõikude klassifikatsioon iga lõigu ja seeriatüübi jaoks.

MÄRKUS.  Kui lühikese teljega kujutiste virn on segmenteeritud, võetakse T2 tulemuse keskmine põhimiku, keskosa 
või tipu ja 16-segmendiliste polaardiagrammi sektorite jaoks lõikude klassifikatsiooni alusel.

12. Müokardi segmendi mõõtmiseks valige .

MÄRKUS. Saab luua kuni viis lokaalse ROI mõõtmist põhimiku, keskosa ja tipu jaoks.

13. Käsitsi segmenteerimine on võimalik. 

• Joonistage LV endokard valides .

• Joonistage LV epikard valides .

• Märkige RV sisestuspunkt, valides .

• Kinnitage lõikude klassifikatsioon iga lõigu asukoha kohta.
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16 segmendiga polaarkaart
1. Lõpetage põhimiku, keskosa ja tipu T2 üldine analüüs. 

2. Kinnitage RV sisestuspunkt iga lõigu asukoha jaoks.

3. Kinnitage õige lõigu klassifitseerimine.

4. Valige 16-segmendiga polaardiagramm .

5. Sektori ülekatte kuvamiseks otse kujutisel valige .

6. Kui analüüsiti ajaseeriat, valige T2 kõverate juurde naasmiseks graafikud .

T2 tulemuste väärtuste vorming

Tulemus DICOM-i kujutised Kaardi kujutised

Üldine keskmine +/– std keskmine +/– std

Põhimik/keskosa/tipp väärtus +/– viga keskmine +/– std

Kohalikud ROI-d väärtus +/– viga keskmine +/– std

Kohalik keskmine +/– std keskmine +/– std
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Kontuuride kustutamine

Valitud seeria KÕIKIDE (ALL) kontuuride kustutamiseks valige .

Ühe kontuuri kustutamiseks tehke kontuuril vasakklõps ja seejärel paremklõps või valige , et kustutada kontuurid 
kõikides ajapunktides.

T2 kõvera ülevaatamine 
1. Kõverale sobivad tulemused näitavad kujutise andmete signaali käitumist. Kokkupakkimisest, valest registreerimisest, 

hingamisest või arütmiatest tingitud kujutise artefaktide korral ei pruugi kõvera sobivus olla optimaalne.

2. Signaali intensiivsuse punkti saab arvutusest välja jätta, klõpsates otse graafiku vastaval punktil ja valides kujutisel 
kontuuri, mis muutub lillaks.

3. Valige paremklõpsumenüüst kustutamine (klõpsake ja hoidke all) või vajutage klaviatuuril kustutusklahvi.

MÄRKUS. Kõvera kuva genereeritakse ainult analüüsiks kasutatavate ajaseeriate abil.

HOIATUS! T2 kõverale sobivad tulemused peaks üle vaatama nõuetekohaselt koolitatud ja kvalifitseeritud 
kasutaja. 
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Müokardi perfusioon 

Müokardi perfusiooni analüüsirežiim võimaldab kasutajal vaadata ja analüüsida müokardi perfusiooni kujutisi. Analüüsiks 
soovitatakse seeriaid, millel on rakendatud liikumise korrektsiooni.

MÄRKUS. Toetatakse poolkvantitatiivset analüüsi. Kui on olemas kahe järjestusega seeria, saab rakendada varjutuse 
korrigeerimist. 

MÄRKUS. Soovitatav on luua üks stressperfusiooniga ja liikumise korrigeerimisega kujutiste seeria ning üks 
puhkeoleku liikumise korrigeerimisega kujutiste seeria.

ETTEVAATUST! Tõusu ja suhtelise tõusu parameetrid ei pruugi olla täpsed kujutistel, millel pole varjutuse 
korrigeerimist tehtud. 

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

JOONIS 1. Müokardi perfusiooni analüüsi liides
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Tabel 1.  Analüüsitööriistad

Tehke liikumise korrektsioon.

Levita kõikidele lõikudele, kõikidele faasidele.

Levita kõikidele faasidele, ühele lõigule.

Tee automaatne segmenteerimine.

Arvuta analüüs pärast redigeerimist uuesti. (Ainult automaatse segmenteerimise 
korral.)

Kopeeri/kleebi kontuurid kõikidele faasidele. 

Arvuta analüüs pärast redigeerimist uuesti. (Ainult, kui on kopeeritud/kleebitud.)

Varjutuse korrigeerimine rakendatud.

Kuva segmendi värvülekate.

Kuva ilma ülekatteta.

Kuva arvutatud parameetri piksli kaupa värvülekate.

Kuva R–R-intervall.

Kuva stressi- ja rahuoleku graafik.

Kuva graafik.

Kuva parameetri tulemuste tabel.

16, 32, 48, 96 segmendiga või kontsentrilise polaardiagrammi valimine.

2, 4 või sujuva värviüleminekuga polaardiagrammi värvide valimine.

Kontsentrilise polaardiagrammi valikud.
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Müokardi perfusiooni analüüsi tegemine

1. Valige .

2. Valige Stressi (Stress) või Rahuoleku (Rest) vahekaart. 

   

3. Valige müokardi perfusiooni seeria.

4. Klõpsake nuppu , et teha vajaduse korral liikumise korrektsioon. Luuakse uus seeria sildiga MOCO. Seda seeriat 
saab kasutada analüüsimiseks.

MÄRKUS. Liikumise korrektsiooni saab eeltöötluse jaoks konfigureerida.

5. Automaatseks segmenteerimiseks ja analüüsi arvutamiseks valige .

6. Vaadake üle iga lõigu endokardi ja epikardi jooned, RV sisestuspunkt ja vajadusel redigeerige.

7. Veenduge põhimiku, keskosa ja tipu klassifitseerimises.

8. Käsitsi segmenteerimiseks valige , et joonistada endokardi kontuur ühele või kõikidele lõikudele.

9. Valige , et joonistada epikardi kontuur ühele või kõikidele lõikudele.

10. Valige , et kopeerida/kleepida kontuurid kõikidele faasidele.

11. Paigutage alumine RV sisestuspunkt, valides .

12. Vaadake üle iga lõigu endokardi ja epikardi jooned, RV sisestuspunkt ja vajadusel redigeerige.

13. Veenduge põhimiku, keskosa ja tipu klassifitseerimises.

14. Analüüsiks kasutatavad algus- ja lõpukaadrid määratakse automaatselt saabumisaja ja tippaja järgi. Kohandamiseks 

valige .

• Algusfaasi määramiseks klõpsake , seejärel klõpsake otse maatriksi lahtrile. 

• Lõppfaasi määramiseks klõpsake , seejärel klõpsake otse maatriksi lahtrile.
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Kontuuri redigeerimine

Pärast redigeerimist tuleb analüüs uuesti arvutada. Ilmub redigeerimise hoiatusmärk. Klõpsake , et uuesti 
arvutada.

Tulemuste ülevaatamine
1. Arvutatud parameetri polaardiagrammi vormingus ülevaatamiseks valige see faili rippmenüüst. Vt Joonis 2.

Kui panna kursor polaardiagrammil segmendi kohale, tõstetakse esile vastava segmendi graafik.

JOONIS 2. Arvutatud parameetrite rippmenüü

Graafiku/tabeli tulemuste ülevaatamine

1. Klõpsake , et vaadata üle RR-intervalli graafikut.

2. Nii stress- kui rahuolekukõverate kuvamiseks klõpsake .

3. Graafiku kuvamiseks klõpsake .

Segmendi värvülekatte kuvamisel tõstab kursori asetamine otse värvilisele segmendile esile selle segmendi 
vastava graafiku.

4. Parameetrite tulemuste kuvamiseks klõpsake .

5. Graafiku tulemuste ülevaatamiseks valige see rippmenüüst, Joonis 3, mis asub graafiku kuva all vasakul.

JOONIS 3. Graafiku tulemused



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3             151

Suhtelise tõusu (RU) ja reservi indeksi (RI) arvutamine
1. Verekogumi ROI paigutatakse automaatse segmenteerimise ajal automaatselt.

2. Verekogumi lõigu asukoha muutmiseks kasutage pisipiltide vaadet, et valida mõni muu lõigu asukoht. Uue 

verekogumi ROI automaatseks loomiseks valige  või .

3. Verekogumi ROI käsitsi paigutamiseks valige , joonistage ROI ja seejärel valige  või .

Soovitatav on põhimiku lõigu tase.

4. Verekogumi ROI kustutamiseks tehke paremklõps ja valige 

MÄRKUS. Reservi indeksi arvutamiseks peab olema olemas nii stressi- kui rahuoleku analüüs.

ETTEVAATUST! Südamelihase perfusiooni tõusu ja suhtelise tõusu parameetrid ei pruugi olla täpsed kujutistel, 
millel pole varjutuse korrigeerimist tehtud. 
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Müokardi perfusiooni kõvera alusel arvutatud paremeetrite definitsioonid 
    

 

Saabumisaeg aeg (sekundites) algtaseme ja tõusu ristumisel

Tippaeg aeg (sekundites), mil signaali intensiivsus saavutab oma maksimumi 

SI suhe SI(tippaeg – algtase)/ algtase

Tõus Tõus arvutatakse kaalutud lineaarse sobitamise abil, kasutades saabumisaja ja tippaja 
vahelisi punkte

Suhteline tõus RU = müokardi tõus / verekogumi tõus

Reservi indeks Müokardi reservi indeks (RU) defineeritakse nii:
                    RI = RU STRESS / RU RAHUOLEK

Signaali intensiivsus

Tõus

Täiustamine

Algtase

Saabumisaeg Tippaeg
Aeg
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Avatud ovaalmulgu (PFO) analüüs

PFO analüüsi tööriist võimaldab genereerida signaali-aja kõvera, mis näitab PFO tuvastamise varajast tippu. 

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

PFO käivitamine

1. Valige Fail (File) > Vali analüüs (Select Analysis) > PFO.

 

2. Valige reaalaja seeria.
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JOONIS 1. PFO analüüsimise aken

1. PFO redigeeritavad vahekaardid, 2. Aktiivsed ROI-d, 3. Kustuta, 4. Alusta ja lõpeta faas, 5. Signaali intensiivsuse ja faasi suhte kõver, 
6. PFO analüüsi ikoonid

Koja anatoomia valimine

Valige kujutis, kus saab vasaku koja (LA) ja parema koja (RA) anatoomiat hinnata. 

Vasaku koja (LA) intensiivsuse kõvera genereerimine

1. Joonistage kõver, valides . 

2. Joonistage Kujutiseredaktori (Image Editor) aknas LA kontuur. 

3. Viige kursor Kujutiseredaktori (Image Editor) aknast väljapoole.

4. Genereerige LA intensiivsuse kõver.

LA signaali intensiivsuse kõver genereeritakse automaatselt.

Parema koja (RA) intensiivsuse kõvera genereerimine

1. Genereerige RA intensiivsuse kõver järgides samu samme, mis loetletud LA intensiivuse kõvera jaoks, 

kasutades .

Kõverad asetatakse üksteise peale ja kuvatakse kõvera tulemuste aknas.

MÄRKUS. Kui ROI on näiteks paigutatud faasi 1 ja algusfaasi muudetakse, on kasutaja joonistatud ROI endiselt 
originaalkujutisel olemas seal, kuhu ROI paigutati.

1
3

5

6

2

4
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JOONIS 2. PFO kõvera tulemused

Kõvera tulemuste ülevaatamine ja faasivahemiku valimine

1. Vaadake aruande aknas kõverad üle ja kohandage Algusfaasi (Start Phase) ja Lõpufaasi (End Phase).

2. Kasutage üles- ja allanooli, et valida Algusfaas (Start Phase) ja Lõppfaas (End Phase) kõvera kuvamise vahemiku 
seadistamiseks.

Algus- ja lõppfaaside kohandamine mõjutab PFO-kõvera kuvamist.

Graafiku mingil punktil klõpsamine uuendab kuvatavad faasid Kujutiseredaktori (Image Editor) aknas.

JOONIS 3. Algus- ja lõppfaasi valimise kuva

MÄRKUS. Kui samas seerias on kaks hõivamist, saate määrata esimese hõivamise algus- ja lõppfaasi, joonistada LA ja 
RA ROI-d (mille tulemuseks on kõverate automaatne genereerimine) ja seejärel korrata protsessi teisel PFO 
vahekaardil teise kujutiste komplekti jaoks. Kõik PFO vahekaardi sildid on redigeeritavad.

Kontuuride redigeerimine

Mitme faasi redigeerimine ühes lõigu asukohas.

1. Valige lõigu asukoht

2. Valige 

3. Valige redigeeritavate faaside vahemiku esimene faas.
4. Vajutage ja hoidke all Shift-klahvi ning valige redigeeritava vahemiku viimane faas.

Valitud pisipilte kuvatakse esiletõstetuna ja punase servaga.
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5. Redigeerige kontuuri Kujutiseredaktori (Image Editor) aknas.
6. Tühistage kontuuri valik, klõpsates kujutisel valitud kontuurist eemal või liigutades kursorit redaktori aknast 

väljapoole.

ROI redigeerimist saab juhtida ulatuse määramisega.

Valige kujutisevaaturis sobiv ulatuse funktsioon.

 Ulatus kõik (Scope All) – rakendab ROI muudatused kõikidele faasidele.

 Ulatus praegune kuni lõpp (Scope Current to End) – rakendab ROI muudatused praegusest faasist lõpuni.

 Ulatus ainult praegune (Scope Current Only) – rakendab ROI muudatused ainult praegusele faasile.

Kontuuride kustutamine

KÕIKIDE (ALL) kontuuride kustutamiseks klõpsake .

Kõikides ajapunktides kontuuride kustutamiseks tehke kujutisel vasakklõps ja seejärel paremklõps valimaks .

Lõplike kõveratulemuste ülevaatamine

Kontuurist lähtuvalt genereeritakse pikslite intensiivsuse-aja graafik. Aruandesse saatmiseks tehke paremklõps .
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T2*

T2* analüüsi tööriist arvutab T2* koe väärtused mitme kajaga kiire gradiendi kajajada järgi.

T2* kõver on signaali intensiivsuse ja kajaaja graafik, mis kasutab eksponentsiaalse sumbumiskõvera valemit. T2* 
sobitusalgoritm põhineb Levenberg-Marquardti mittelineaarsel vähimruutude algoritmil.

T2* sumbumiskõvera arvutus on järgmine:   y = a *exp(-TE/T2*) + c

 Kus

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

Tabel 1.  

y on signaali intensiivsus ajahetkel TE

a on ristmagnetiseeritus ajahetkel 0 (null)

TE on kajaaeg

T2* on sumbumise konstant ja

c on taustamüra
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Südame analüüsimise protseduur
JOONIS 1. T2* analüüsi liides

1. Valige . 

2. Valige sobiv seeria.

3. Automaatseks segmenteerimiseks valige .

4. Vaadake üle septaalse ROI paigutus. 

5. Käsitsi segmenteerimiseks joonistage kontuur, mis hõlmab vatsakeste vaheseina kasutades .

Arvutatakse T2* ja R2*, mida kuvatakse tulemuste tabelis.

Arvutatakse R2 väärtus, mida kuvatakse graafikus.
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Müokardi värvikaardi loomine

1. Joonistage LV endokard valides .

2. Joonistage LV epikard valides . 

T2*/R2* värvikaart pannakse kujutise peale. 

3. R2* värvikaardi väärtust saab muuta.

MÄRKUS. T2* puhul on 1,5 T kujutiste vaikevahemik 5–500 ms. T2* puhul on 3,0 T kujutiste vaikevahemik 
2,5–1000 ms. 

4. Paremklõps ja valige , et muuta värvikaardi dünaamilist värvivahemikku. 

Värvülekate aknas Kujutiseredaktor (Image Editor) muutub dünaamiliselt.

Hz ja ms väärtused muutuvad samuti dünaamiliselt.

5. T2* and R2* väärtusi saab määrata valides nupu  ja pannes selle kujutisel värvikaardi ülekatte peale.

Parameetrite sobitamine
T2* sumbumiskõverale valige 2 parameetriga või 3 parameetriga sobitamine. 

JOONIS 2. Parameetrite sobitamine

Kahe parameetriga sobitamine on ekspertkirjanduse põhjal laialdaselt aktsepteeritud [1]. Selles mudelis arvutatakse 
taustmüra c histogrammipõhise algoritmi abil ja lahutatakse signaali intensiivsusest, mille järel tehakse mittelineaarne 
sobitamine.

3 parameetriga sobitamine on samuti saadaval, nagu on viidatakse ekspertkirjanduses [2]. See mudel on mittelineaarne 
lähenemine, mis töötab otse algse sisendsignaaliga.

Mõlema mudeli puhul hinnatakse algset T2* väärtust, kasutades lineaarse testsobitamist.

1. D.J Pennell, et al. „Cardiovascular T2-star (T2Star) magnetic resonance for the early diagnosis of myocardial iron 
overload,“ Eur Heart J 2001; 22: 2171–2179.

2. Ghugre NR, et al. „Improved R2* Measurements in Myocardial Iron Overload,“ Journal of Magnetic Resonance 
Imaging 2006; 23: 9–16.
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T2* tulemuste ülevaatamine
1. Vaadake üle kõikide kujutiste kontuuri asukoht. 

2. Tabelis on loetletud üksikud T2*/R2* mõõtmised ja arvutatakse ka keskmine väärtus.

MÄRKUS. T2* kõver on signaali intensiivsuse ja kajaaja graafik, mis kasutab eksponentsiaalse sumbumiskõvera 
valemit. Mõnikord võib kõvera paremaks sobitamiseks osutuda vajalikuks hilisemad kajapunktid 
lagunemiskõveralt eemaldada. See võib ilmneda äärmuslikel raua ülekoormuse juhtudel, kui signaali 
intensiivsus võib olla väga madal.

Kujutiselt üksiku kontuuri kustutamiseks

1. tehke vasakklõps valitud kontuuril, mis muutub lillaks.

2. Prügikasti valimiseks tehke paremklõps või kasutage kontuuri eemaldamiseks klaviatuuril kustutusklahvi.
• Kontuur kustutatakse ja kõvera sobivus arvutatakse uuesti.

JOONIS 3. T2* kõver

HOIATUS! T2* kõvera tulemuste sobivuse peab üle vaatama koolitatud ja kvalifitseeritud kasutaja.

Koefitsienti 1000 kasutatakse, kuna T2 ja T2* on esitatud millisekundites (ms) ning R2 ja R2* hertsides (või s-1).

Tabel 2.  R2*/T2* konversioonid

Tulemus Ühik Konversioon

R2* Hz R2*=1000/T2*

T2* ms T2*=1000/R2*
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3D/4D voolu vaatur
Pakub 3D- ja 4D-voolu kujutiste interaktiivset kaldu ümbervormindamist. Vahekaart Veresoon (Vessel) võimaldab rindkere 
aordi automaatset segmenteerimist koos redigeerimise ja mõõtmise aruannete tööriistadega. On olemas tööriistad 2D 
faasikontrastsuse ja 2D funktsiooni kujutiste loomiseks 4D-st, mida saab analüüsida. Järjestusvoolu analüüsi saab teha 
veresoonte automaatse segmenteerimisega. 

MÄRKUS. Isomeetriliste vokslite ja kattuvate lõikudega 3D-seeria parandab ümbervormindatud kujutiste kvaliteeti.

MÄRKUS. 3D/4D voolu vaatur kuvab 4D-seeriaid ainult siis, kui 4D on litsentsitud.

MÄRKUS. Kui on tehtud nii 2D faasikontrastsuse kui ka järjestuse 4D voolu analüüs, on kõik tulemused saadaval voolu 
analüüsi režiimis. 

ETTEVAATUST! 3D- või kujutise ümbervormindamised annavad ainult täiendavat lisateavet diagnoosi tegemisel 
ja neid tuleks alati kasutada koos tavapäraste piltdiagnostika tehnikatega.

HOIATUS! Suhtestage kõik 3D ümbervormindamised alati algsete hõivamiste andmetega.

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.
- ROI paigutust
- Iga kategooria jaoks õige veresoone identifitseerimist
- Algtaseme korrigeerimine

JOONIS 1. 3D/4D vahekaardid 

Tabel 1.  3D/4D vahekaardid (vt Joonis 1)

Vahekaart Kirjeldus
Kuva (Display) Kujutise vaate visualiseerimise tööriistad ja DICOM-i kujutise salvestamine. 
Veresoon (Vessel) Automaatse segmenteerimise ja redigeerimise tööriistad
Analüüsid (Analysis) Inline 4D voolu analüüs.
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Vahekaart Display (Kuva)

Tabel 2.  Vahekaart Display (Kuva)

Tööriist Kirjeldus
Ristniit-kursor – sünkroonib liikumise kõigi vaateavade vahel. 
Kasutage voolujoone alguspunktina.

Orientatsiooni nupud – muudavad kujutise tasapinda 3D ja kaldus 
vaateavades.

S = Superior (ülemine)
I = Inferior (alumine)
A = Anterior (eesmine) 
P = Posterior (tagumine) 
L = Left (vasak)
R = Right (parem) 
Kaldus režiim – kuvab kaldu ümbervormindatud tasandi ja risti 
oleva vaheseina, et kuvada soovitud anatoomia. 

Kaksikkaldu režiim – kuvab kolm kaldu tasapinda, mis on 
määratletud kolme kohandatava värviteljega – sinine, kollane ja 
roheline. Ühe telje kohandamine uuendab teist kahte tasapinda. 

3D vaate režiim – kujutise sirvimise režiim 3D vaateavades

MIP – maksimaalse intensiivsuse projektsioon (vaikimisi).
MINIP – minimaalse intensiivsuse projektsioon.
Pind – vt Pinna režiim lk 175.

Kuvarežiim – kuvab segmenteerimise visualiseerimise tööriistad (vt 
Tabel 6, „Visualiseerimise tööriistad (vahekaart Kuva (Display) või 
Veresoon (Vessel))“, lk 172). 

Voolujooned – 3D-kiirusväljade üldine visualiseerimine 
konkreetses ajafaasis.

Seadistused:
Voolufilter – reguleerib voolujoonte intensiivsust.
Voolujooned – üksikute vereosakeste trajektoorid nende liikumisel 
läbi kardiovaskulaarsüsteemi aja jooksul.

Voolutee filter – reguleerib verevoolu läviväärtust.
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Vektorid – verevoolu kiirust ja suunda näitavad nooled. 

Seadistused:
Vektori filter – reguleerib verevoolu läviväärtust. 
Samm – reguleerib noolte tihedust.
Suurus – reguleerib noole skaalat kohaliku kiiruse järgi.
1 Värvülekate* (keelatud, kui valitud on voolujooned ja vektorid.)
2 Värvülekatte eemaldamine*
3 Faasi visualiseerimine*
4 Angiogramm*
*Olemas vaid 4D voolul.
Kiiruse vahemik – kohandab voolu suuna kiiruse värvi määramist. 
Olemas vaid 4D voolu kujutistel.
Kiiruse vahemiku värviriba tingmärki kuvatakse iga vaateava 
parempoolses servas. Väärtus on hinnanguline.

Läbipaistmatus – reguleerib kujutisel kiiruse värvi läbipaistmatust 
alloleva anatoomia paremaks visualiseerimiseks. Olemas vaid 4D 
voolu kujutistel. 

4D värvi silumine – värvülekatte silumise aste. 

Video – kontrollib kaadrite arvu sekundites ja määrab video algus- 
ja lõppkaadri. Olemas ainult 3D ajalahutusega ja 4D voolu kujutistel. 
Kasutage klaviatuuri tühikuklahvi video käivitamiseks ja pausile 
panemiseks.

Salvesta DICOM-i seeriad – kuvatõmmis – salvestab kuvatud 
vaateava kujutised, sh visualiseerimised. 

1 - Aktiivne vaateava
2 - Kõik vaateavad 

MÄRKUS. Kujutise tüüp tehakse kindlaks 3D-vaate režiimi 
valikust. 

Tabel 2.  Vahekaart Display (Kuva)

Tööriist Kirjeldus

1 2 3 4

1 2
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Salvesta DICOM-i seeriad – pöörlemise video – salvestab aktiivse 
vaateava kujutise pöörlemise videona.

1 - Edasi-tagasi režiim – valige kujutiste salvestamiseks edasi-tagasi 
liikuva videona 
2 - Valige pööramise suuna nool. 

Salvesta DICOM-i seeriad – edasine analüüsimine – 3D-hõivamised 
salvestavad kujutised MIP-ina. 4D-hõivamised salvestavad kujutised 
tavaliste videotena koos magnituudi ja/või faasiga. Loodud seeriaid 
saab kasutada edasisteks analüüsideks. 

1 - Mitmekihiline Rx-tööriist 

MÄRKUS. Iga magnituudi ja faasi seeria jaoks luuakse 
alusjoone korrektsiooni seeria. 

Salvesta – salvestab seeria definitsiooni järgi loodud kõik kujutise 
seeriate tüübid kohalikku andmebaasi. 

Tabel 2.  Vahekaart Display (Kuva)

Tööriist Kirjeldus

1 2

1

1
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Tabel 3.  Vaateava tööriistad

Tööriist Kirjeldus
Sirvimine ja lõigu paksus – muudab MIP-kujutiste paksust ja sirvib 
tervet kujutiste komplekti. 

1 = klõpsake ja lohistage äärmisi nuppe MIP-kujutise paksuse 
muutmiseks
2 = klõpsake ja lohistage liugurit terve kujutiste komplekti 
sirvimiseks või kasutage kerimisratast. 

Juhtnupud on valitud vaateavast paremal.

Lineaar – sirgel joonel oleva kauguse mõõt. 
Klõpsake otse mõõdu peal ja seejärel tehke paremklõps, et 
kustutada, lokaliseerida või sildistada. (Kiirklahv Alt + 1)

3D rotatsioon – kallutab või pöörab kujutisi 3D vaateavas. 
Kallutamiseks või pööramiseks klõpsake hiirel keskmist klahvi ja 
lohistage otse vaateavasse. 

Voolu suund – kuvab kaldus vaateavades risttasapinna. Tehke 
paremklõps vaateavas, vasakklõps voolu suuna valimiseks. Tehke 
vasakklõps otse huvipakkuval anatoomilisel kohal. Saadaval ainult 
4D voolu jaoks.
Aken/tase – tehke paremklõps vaateavas.

Panoraamimine – tehke paremklõps vaateavas.

Suumimine – tehke paremklõps vaateavas.

Rotatsioon – saadaval 3D vaateava ja kaldus vaateavade jaoks.

Võta tagasi – eemaldab vaateavas viimase toimingu
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JOONIS 2. Kiirklahvid

Lähtesta 

Peida 3D-kujutis – klõpsake mahulise kujutise andmete peitmiseks 
3D-vaates, et kuvada ainult ISO pind. 

Saada kujutis aruandesse – tehke paremklõps vaateavas.

Skannimisparameetrid – tehke paremklõps vaateavas.

Tabel 4.  Kiirklahv

Funktsioon Tegevus
Kursor sihtkohale Pange kursor soovitud anatoomilisele kohale ja vajutage klahvi Shift.
1 × 1 paigutus Topeltklõps mistahes 2 × 2 vaateavas lülitab paigutuse 1 × 1 versioonile 

või tagasi 2 × 2 versioonile. 
Lineaarne mõõtmine Tehke, klõpsates klahve Shift + 1.

Tabel 3.  Vaateava tööriistad

Tööriist Kirjeldus
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Vahekaart Veresoon (Vessel)
Vahekaart Veresoon (Vessel) võimaldab rindkere aordi automaatset segmenteerimist koos redigeerimise ja mõõtmise 
aruannete tööriistadega. 

Vajalikud kujutised: Automaatne 3D veresoone segmenteerimine (Automatic 3D Vessel Segmentation) on optimeeritud 
bSSFP järjestuste jaoks, kuid toetab kontrastiga 3D MRA-d ja kontrastiga täiustatud topeltkajaga veega rekonstrueeritud 
kujutise tüüpe. 

JOONIS 3. Veresoone analüüsi liides (3D)

1. Redigeerimise tööriistad, 2. 3D vaateava, 3. Aksiaalne vaateava, 4. Kaldus vaateava, 5. Kaldus vaateava, 6. Keskjoone vaade, 
7. Ortogonaalne vaade, 8. Mõõtmise tabelid 

3D segmenteerimine koos mõõtmistega

1. Valige .

2. Valige vahekaart Veresoon (Vessel). 

3. Valige seeriate sirvimise rippmenüüst sobiv 3D-seeria. 
Valitud kujutise tüüp näidatakse nupul.

4. Klõpsake , et teha automaatne segmenteerimine, arvutada keskjoon, paigutada aordi orientiirid kollaste 
kolmnurkadega ja jäädvustada maksimaalse läbimõõdu mõõtmed roheliselt näidatud orientiiridega segmentides. 
Vt Joonis 4.

1

2 3

4 5

6

7

8
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MÄRKUS. Veresoone segmenteerimise saab eeltöötluse jaoks konfigureerida.

MÄRKUS. Tähised: sinutobulaarne ühenduskoht (Sinotubular Junction (STJ)), õlavarre-peatüvi (Brachiocephalic Artery 
(BCA)), vasak rangluualune arter (Left Subclavian Artery (LSA)), kõhuõõnetüvi (Celiac Artery (CA)). 

Maksimaalsed läbimõõdud ja risti mõõtmine, mis läbib maksimaalse läbimõõdu keskpunkti, arvutatakse 
automaatselt piki keskjoont.  

Ortogonaalses vaates hiirerattaga kerimine liigutab vaadet mööda keskjoont edasi/tagasi. 

MÄRKUS. Võimalik on kerida keskjoone otsast edasi – ortogonaalne vaade kuvab lõigud, mis on ekstrapoleeritud 
lõpliku keskjoone punkti suunas. See võib olla kasulik navigeerimiseks keskjoone lõpp-punktidest 
kaugemale, eriti juure lähedal.

JOONIS 4. 3D segmenteerimise vaade

5. Vaadake mõõtmistulemusi paremas alumises nurgas vahekaardil Aort (Aorta). Otse mõõtmistulemuste tabelis 
klõpsamine leiab mõõtmise asukoha vaateavades. Vt Joonis 5.

MÄRKUS. Eelistustes valitud mõõtühik on aruandes kasutatavaks ühikuks. 

MÄRKUS. Klõpsake vahekaarti Kohandatud (Custom) ja klõpsake , et lisada kohandatud mõõtmine.

JOONIS 5. Mõõtmise tabelid

Maksimaalne salvestatud läbimõõt

Orientiir
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6. Vaadake üle orientiiri segmendid. Muutmiseks klõpsake ja lohistage kollast kolmnurka mööda keskjoont või 
paremklõpsake keskjoont ja paigutage valitud keskjoone punkti orientiir.

Orientiire saab kustutada, tehes orientiiri kohal paremklõpsu ja valides prügikasti ikooni. Vt Joonis 6.

MÄRKUS. Maksimaalsed automaatsed mõõtmised arvutatakse uuesti.

JOONIS 6. Paremklõps orientiiri muutmiseks (vasakul)   Paremklps kustutamiseks (paremal)

MÄRKUS. STJ mõõtmine on orientiiriks. Orientiiri liigutamine uuendab salvestatud mõõtmist.

7. Maksimaalset salvestatud mõõtmise asukohta saab käsitsi muuta, tehes segmendi aordil paremklõpsu ja valides 

, et muuta mõõtmise asukohta.

8. Salvestatud mõõtmisi saab ortogonaalvaates käsitsi alistada, klõpsates lineaarsel annotatsioonil ja lohistades 
kumbagi otsa (vt Joonis 7). Lineaarseid mõõtmisi saab lähtestada, tehes annotatsioonil paremklõpsu ja valides 

.

JOONIS 7. Ortogonaalne vaade

Aruande 

valimine
läbimõõdu
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9. Vahekaardil Aordijuur (Aortic Root) on kuus eelnevalt määratletud mõõtmist. Tehke kindlaks aordijuure asukoht ja 
klõpsake tabelis otse mõõtmisel ning seejärel klõpsake lineaarsete mõõtmiste loomiseks ortogonaalset vaadet. 
Vt Joonis 8.

JOONIS 8. Vahekaart Aordijuur (Aortic Root), kus on näidatud ortogonaalne vaade

10. Keskjoone vaates keskjoonel klõpsamine teisendab selle splainiks, redigeerimiseks klõpsake ja lohistage punkti. 
Topeltklõpsake keskjoone kumbagi otsa, et seda pikendada. Vt Joonis 9.

TÄHTIS! Otsene keskjoone alistamine takistab keskjoone edaspidist värskendamist segmenteerimise muudatuste tõttu!

JOONIS 9. Keskjoone vaateava ja ortogonaalne vaateava 
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11. Vaadake segmenteerimine üle, tehes väikesi muudatusi olemasolevat kontuuri laiendades, erodeerides ja liigutades 
(Tabel 7), või suuri muudatusi, kasutades pintsleid, vabavormi ja silumist (Tabel 8).

MÄRKUS. Enne mis tahes suuremat segmenteerimise redigeerimist on soovitatav mõõtmised esmalt üle vaadata, 
kuna keskjoon võib olla täpne ja vaja on ainult väikseid mõõtmiste korrigeerimisi.

Tabel 5.   Segmenteerimise juhtnupud (vahekaart Veresoon (Vessel))

Valik Kirjeldus
Veresoone valiku rippmenüü – valige segmenteerimise 
redigeerimiseks aktiivne veresoon.

MÄRKUS. Automaatne segmenteerimine segmenteerib kõik 
veresooned olenemata valitud veresoonest.

MÄRKUS. PA, SVC, IVC valikud ilmuvad ainult 4D puhul.

Automaatne veresoone segmenteerimine 
3D: rindkere aort 
4D: rindkere aort, PA, SVC ja IVC 

Kustutab aktiivse, valitud või kõik segmenteerimised. 

MÄRKUS. 3D puhul rippmenüüd ei ilmu ja kustutatakse ainult aort.

Piiranguga/piiranguta ROI Lülitab aktiivselt valitud veresoone teiste 
veresoone segmentatsioonide alistamise (vokslite tuvastamiseks) 
sisse- ja väljalülitamise. 

MÄRKUS. Saadaval ainult 4D jaoks.
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Tabel 6.  Visualiseerimise tööriistad (vahekaart Kuva (Display) või Veresoon (Vessel))

Valik Kirjeldus
Avab vahekaardil Kuva (Display) segmenteerimise visualiseerimise 
paani. 

Lülitab iga veresoone isopinna nähtavuse sisse ja välja (ainult 
vahekaart (Display)). 

Silt (Label) – värvib aktiivse veresoone türkiissiniseks, passiivsed 
veresooned halliks.

Veresoon (Vessel) – kõik veresooned värvitakse heledalt eri 
värvidega. 

Läbimõõt (Diameter) (ainult 3D) – aktiivne veresoon värvitakse 
vastavalt ristlõike läbimõõdule.

Ala (Area) (ainult 3D) – aktiivne veresoon värvitakse vastavalt 
ristlõike alale.
Läbimõõdu ja ala režiimis saab liugurit redigeerida värviriba 
skaleerimiseks. 

Reguleerib kõikide segmenteerimiste läbipaistvust (%).
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Tabel 7.  Vaateava redigeerimise tööriistad

3D vaade – üldine erodeerimine ja laiendamine

Ortogonaalne vaade 

Nooleklahvid võimaldab kontuuri ühevokselist paigutust. 
Kontuurile rakenduvad erodeerimise ja laiendamise nupud.

Erodeerumine, laiendamine ja liigutamine kehtivad levivad kõik 
praegusest lõigust üles ning alla jäävatele lõikudele 
proportsionaalselt rakendatud nihkega.

Klõpsake ja lohistage kontuuri ortogonaalses vaates (alates sinisest 
ruudust), et rakendada kombineeritud nihkeid, selle asemel et 
klõpsata nooleklahve mitu korda. 
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MÄRKUS. Need tööriistad mõjutavad läbi paani virna. Pintsel ja kustutamine mõjutavad praegust lõiku ja üleval/all 
olevaid lõike. Jälje vaikimisi paksus on 10 mm. Lõikamise ja silumise toimingute tegelik paksus on aktiivse 
vaate lõigu paksus.

MÄRKUS. Automaatse läviväärtuse (Automatic Threshold) valimisel arvutatakse optimaalne läviväärtus tausta 
veresoonest eraldamiseks interaktsiooni käigus. See tööriist nõuab, et kasutaja joonistaks piki veresoont / 
veresoone lähedale piiri ja arvutaks lisamiseks või kustutamiseks optimaalse läviväärtuse. Parimate 
tulemuste saavutamiseks kasutage piirkondades, kus veresoont ei ümbritse sarnase heledusega kude.

Tabel 8.  3D redigeerimise tööriistad

Tööriista valik Kirjeldus
Pintsli lisamine 
Värvib 3D sfääri. Värvi suurus on protsent vaateväljast. (Vaikimisi on 
läbimõõt 6% vaateväljast. (30 cm vaateväli ~ läbimõõt 1,8 cm). 

Pintsli kustutamine
Vaikimisi on läbimõõt 6% vaateväljast. (30 cm vaateväli ~ läbimõõt 
1,8 cm).

Jälje lisamine
Paksus on vaikimisi 10 mm läbi paani.
Mõjutab virna, mitte kõvera mahtu.

Lõikamine 
Saab kasutada 3D-vaates, kehtib kogu lõigu paksusele. 

Sujuv   
Kannatakse pintsliga otse isopinnale. 
Ilma ROI-d joonistamata vajutage üldise silumise rakendamiseks 
pärast tööriista valimist klahvikombinatsiooni ALT + S. 
Pärast ROI joonistamist korduvalt tugevamaks silumiseks vajutage 
korduvalt klahvikombinatsiooni ALT + S. 
Muutub sfääriliseks silumisharjaks, et suhelda 3D pinnamudeliga. 
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Pinna režiim
Vajalikud kujutised: täiustatud kontrastsusega 3D hõivamised või muud angiograafilised järjestused, milles 
intravaskulaarne signaal on taustkoest oluliselt kõrgem. Vt Joonis 10.

1. Valige vahekaart Kuva (Display).

2. Valige rippmenüüst Pind (Surface) (ainult 3D). 

JOONIS 10. Pinna režiim

3. Kasutage vasakpoolsel paanil olevat läbipaistmatuse liugurit, et muuta pinna sügavust nähtavaks. 
Läbipaistmatuse vähendamine paljastab suurema signaali intensiivsusega sisemised anatoomilised struktuurid, samas kui 
läbipaistmatuse suurendamine hõlmab rohkem ümbritsevat taustakudet, millel on väiksem kujutise intensiivsus. 

4. Tehke paremklõps värvikaardistuse muutmiseks ja valige .
Akna laius reguleerib värvivahemikku, samas kui akna tase määrab heleduse.
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Näidistöövoog: 3D kujutisteseeriast MIP-kujutiste loomine

1. Valige sobiv uuring ja käivitage tarkvara suiteHEART®.

2. Valige .

3. Valige seeriate sirvimise rippmenüüst sobiv 3D-seeria. Valitud kujutisetüüp näidatakse nupul, nagu on näidatud 
Joonis 11.

JOONIS 11. Seeriate sirvimine

4. Valige  ja klõpsake soovitud vaateaval. Ilmuvad ümbervormindamise jooned, nagu on näidatud Joonis 12. 

JOONIS 12. Topeltkaldu režiim
 

5. Klõpsake pideval joonel, tehke vasakklõps ja lohistage ning kallutage joont, et kuvada soovitud anatoomia. 
a.) Klõpsake salvestamiseks soovitud vaateaval. 
b.) Kohandage MIP-i paksust, kasutades vaateava parempoolses servas olevaid juhtnuppe. 
c.) Lõpetage seeria defineerimise sisestused, nagu näidatud Joonis 13. 
d.) Klõpsake salvestamise nupul, et MIP-kujutis kohalikku andmebaasi salvestada.
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JOONIS 13. Salvestamine edasiseks analüüsimiseks

6. Looge MIP-kujutiste virn, valides .

MÄRKUS. Loodud järeltöödeldud MIP-kujutiste maksimaalne arv võib olla 512.

7. Klõpsake vaateaval, mille kujutist kasutatakse võrdlusena ja defineerige kujutistevirna pakk, nagu näidatud Joonis 14.
a.) Laiendage lõikudega katmise vahemikku.
b.) Kohandage lõigu suunda näitavat nurka ja nooli.
c.) Liigutage Rx telge.

JOONIS 14. Rx planeerimine

8. Sisestage seeria defineerimise suvandid ja klõpsake , et salvestada kujutiste pakk kohalikku andmebaasi. 

9. Loodud seeriate vaatamiseks lülitage funktsiooni analüüsi režiimile, valige ülevaatuse režiim ja klõpsake Värskenda 
(Refresh). 

1. Valige MIP

2. Klõpsake Salvesta (Save)

b

a a

c
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Näidistöövoog: analüüsimiseks 2D seeria loomine

Konventsionaalsete 2D faasikontrastsete või 2D funktsiooni kujutiste loomiseks on vaja 4D voolu seeriat, millel on nii 
ajalahutusega magnituudi kui ka voolu konventsioonid R/L, A/P ja S/I. 

4D voolu kujutistest loodud ainult magnituudi või magnituudi- ja faasi-seeriad on sobivad 2D-tavaseeriad, mida saab 
kasutada funktsiooni või voolu analüüsis.

Seeriatel, mis on loodud 4D voolu järeltöötlusest, on värvivoo ülekate.

1. Valige sobiv uuring ja käivitage tarkvara suiteHEART®.

2. Valige .

3. Valige seeriate sirvimise rippmenüüst sobiv 4D seeria, nagu näidatud Joonis 15. Valitud kujutisetüüpi näidatakse 
nupul, nagu on näidatud Joonis 15.

JOONIS 15. Seeriate sirvimine

4. Valige  ja klõpsake soovitud vaateaval. Ilmuvad ümbervormindamise jooned, nagu on näidatud Joonis 16.

JOONIS 16. Topeltkaldu režiim
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5. Klõpsake pideval joonel, tehke vasakklõps ja lohistage ning kallutage joont, et kuvada soovitud anatoomia. 
a.) Klõpsake salvestamiseks soovitud vaateaval ja valige magnituudi ja faasi režiim, et luua 2D faasikontrastne seeria või 

valige magnituud, et luua funktsiooni seeria. 
b.) Kohandage lõigu paksust kasutades vaateava parempoolses servas olevaid juhtnuppe. 
c.) Lõpetage seeria defineerimise sisestused, nagu näidatud Joonis 17, ja klõpsake salvestamise nupul, et seeria kohalikku 

andmebaasi salvestada.

JOONIS 17. Seeria defineerimine ja salvestamine

6. Mitme lõiguga mitmefaasiliste kujutiste paki loomiseks klõpsake .
MÄRKUS. Loodavate multifaasiliset kujutiste maksimaalne arv on 32. 
MÄRKUS. Magnituudi ja faasi seeria salvestamisel rakendatakse teisele seeriale automaatne algtaseme korrektsioon. 

Seeriale lisatakse silt „korrigeeritud“ (corrected) nagu Joonis 18. 

JOONIS 18. Automaatse paigutusvea korrigeerimisega faasi seeria näide

1. Valige Lisa faas (Include Phase)

2. Klõpsake Salvesta (Save)
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7. Klõpsake vaateaval, mille kujutist kasutatakse võrdlusena ja defineerige kujutistevirna pakk nagu näidatud Joonis 19.

JOONIS 19. Rx planeerimine

8. Valige seeria defineerimise suvand ja klõpsake , et salvestada kujutiste pakk kohalikku andmebaasi. 

9. Loodud seeriate analüüsimiseks lülitage vastavale analüüsirežiimile ja klõpsake Värskenda (Refresh). 

Näidistöövoog: 4D voolu segmenteerimine koos voolu analüüsiga

1. Valige .

2. Valige seeriate sirvimise rippmenüüst sobiv 4D voolu seeria. 

Valitud kujutise tüüp näidatakse nupul .

3. Valige vahekaart Veresoon (Vessel). 

4. Automaatseks segmenteerimiseks klõpsake . 
See segmenteerib, märgistab ja paigutab 2D voolu paanid aordi, PA, IVC ja SVC jaoks. Valige vaatamiseks vahekaart Kuva 
(Display). Vt Joonis 20.

MÄRKUS. Veresoone segmenteerimise saab eeltöötluse jaoks konfigureerida.

MÄRKUS. Veresoonte kategooriate määratlusi vt Vt tabel 1 lk 98.

MÄRKUS. Segmenteerimine tehakse hinnangulises süstoli faasis.
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JOONIS 20. 4D voolu segmenteerimine
 

5. Valige redigeerimiseks sobiv veresoon. Vahekaart Veresoon (Vessel) võimaldab segmenteerimise redigeerimist 
sarnaselt 3D-režiimile. Vt Tabel 8 lk 174. 

6. Vaadake segmentatsioon üle ja soovi korral redigeerige. 
Segmentatsiooni eesmärk on vahekaardil Analüüs (Analysis) näidatud voolu paanide paigutamine.

7. Vahekaardil Analüüs (Analysis) on näidatud voolu tulemused; vaadake üle iga kategooria ja voolu kontuurid 
ortogonaalses vaates.  

8. Vajutage nuppu Crtl + hiire keskmine nupp, et vaadata kontuurid üle kõikides faasides. 

9. ROI asukoha määramiseks veresoones tehke ROI-l vasakklõps ja seejärel paremklõps ning valige .

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õige kategooria 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus. 
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JOONIS 21. ROI asukoha määrmaine veresoones 

10. Kerige ortogonaalses vaates mööda keskjoont ja klõpsake voolutasandi asendi kiireks reguleerimiseks välgunoolt. 
Kinnitage veresooni kategooria vahekaardil Analüüs (Analysis). (Joonis 22)

JOONIS 22. Ortogonaalne vaade

11. Splainipunktide lohistamiseks, külgnevatest faasidest kopeerimiseks ja liigutamiseks/erodeerumiseks/laiendamiseks 
tehke kontuuril vasakklõps. (Joonis 23) 
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JOONIS 23. Muutmise tööriistad

Vahekaardil Analüüs (Analysis) kuvatakse valitud voolu kontuuri voolujooned. Emissiooni üldiseks sujuvamaks muutmiseks 
valige vahekaart Kuva (Display).

Näidistöövoog: voolu käsitsi mõõtmine 

Voolu analüüsi liidese tööriistade kohta lisateabe saamiseks vt Voolu analüüs lk 96.

1. Valige Analüüsi vahekaart (Analysis Tab).

2. Lokaliseerige huvipakkuv veresoon. Voolukõver genereerimiseks klõpsake .
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JOONIS 24. Aordi- ja kopsuveresoonte näide

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õigete kategooriate 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus.

3. Käsitsi segmenteerimiseks lokaliseerige huvipakkuv veresoon ja klõpsake,  nagu näidatud Joonis 25.

Võimalik on teha 6 ROI-d, numbritega 1–6. Värvikood jääb kogu analüüsivaates, kujutiste vaateavades ja graafikutel 
samaks.

4. Looge veresoone ümber kontuur, paigutades 4 punkti huvipakkuva veresoone ümber.

5. Kõikides faasides segmenteerimiseks klõpsake .

JOONIS 25. ROI paigutamine käsitsi
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Kiiruse diskreetmoonutuse korrigeerimise tegemine

Kiiruse diskreetmoonutuse automaatne korrigeerimine  kohta vt lk 107.

Kiiruse diskreetmoonutuse korrigeerimiseks lohistage faasi lahtipakkimiseks liuguri juhtnuppu. Muudatuse mõju 
uuendatakse otse faasi kujutisel ja tulemused kuvatakse otse voolugraafikul. Kõigi kolme kiirusega kodeeritud kujutise 
kontrollimiseks kolmes ortogonaalses (x, y, z) suunas valige rippmenüüst, nagu on näidatud.

JOONIS 26.
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Aruandlus

HOIATUS! Aruanne tuleks enne kinnitamist ja väljastamist üle vaadata, et veenduda, et sisu vastab analüüsile. 
Kui aruandes esineb vigu, võib tekkida diagnoosimise edasilükkumine või valediagnoos. Analüüsi ja 
selle tõlgendamise peaks läbi viima nõuetekohaselt koolitatud ja kvalifitseeritud kasutaja.

MÄRKUS. Funktsionaalanalüüsi toetatakse mitme seeria puhul. Aruandes olevad tulemused kajastavad 
funktsionaalanalüüsi käigus valitud praegusi seeriaid.

Aruandluse liidesele saab ligi klõpsates liidese alumises parempoolses nurgas  või vajutades Alt + R. Südame 
kujutistest aruannete tegemiseks on soovitav kasutada kahte ekraani. 

Kui kasutatakse mitut ekraani, klõpsake ekraani valimiseks liidese ülemises parempoolses nurgas . 

Aruandluse liides (Joonis 1) pakub menüüpõhist valikut. Valikuid saab teha otse liideses, valides sobiva aruande jaotise ja 
seda tekstiga täites. Aruande tekstid ja kategooriate vahemikud parameetrite tulemustega saab defineerida eelistustes. 
Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System) (ainult administraator) ja valige 
vahekaart Aruandlus (Reporting). 

JOONIS 1. Aruandluse liides

1. Südame anatoomia valik, 2. Tulemused, 3. Menüü valikud, 4. Polaardiagrammide skeemid, 5. Monitori valimine, 
6. Kopeeri aruanne HTML-vormingus, 7. Aruande sisu, 8. Patsiendi demograafilised andmed, 9. Makro vahekaardid, 
10. Lisa aruandesse kujutisi, graafikuid, tabeleid

1

2 3

4

5 6

7

8

9

10
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Patsiendi demograafilised andmed
Kirjelduse jaotis sisaldab patsiendi demograafilisi andmeid DICOM-i päisest. Välju saab redigeerida (esiletõstetud) nagu 
näidatud Joonis 2. 

MÄRKUS. Redigeerimine ei muuda DICOM-i päist. 

JOONIS 2. Demograafilised andmed   

1. DICOM-i päise teave, 2. BSA valik 

BSA arvutamise tüüpi saab valida, tehes vasakklõpsu ümberpööratud kolmnurgal.

Allikas: http://halls.md/formula-body-surface-area-bsa/

Sobivat südame anatoomiat aruande jaoks saab valida liidese ülevalt vasakult, nagu näidatud Joonis 3. 

• LV: vasak vatsake 
• RV: parem vatsake 
• Kojad (Atria) 
• Klapid (Valves)

JOONIS 3. Südame anatoomia valik

BSA arvutamise meetod Valem

DuBois ja DuBois BSA (m2) = 0,20247 × pikkus(m)0,725 × kaal(kg)0,425

Mosteller BSA (m2) = SQRT( [pikkus(cm) × kaal(kg) ]/3600)
BSA (m2) = SQRT( [pikkus(in) × kaal(lbs) ]/3131)

Gehan ja George BSA (m2) = 0,0235 × pikkus(cm)0,42246 × kaal(kg)0,51456

Haycock BSA (m2) = 0,024265 × pikkus(cm)0,3964 × kaal(kg)0,5378

Boyd BSA (m2) = 0,0003207 × pikkus(cm)0,3 × kaal(g)(0,7285 – (0,0188 × LOG(g))

1

2
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Aruande tegemine
MÄRKUS. Kategooriate vahemike täitmine võimaldab aruande automaatset eeltäitmist. Tekst eeltäidetakse vastavalt 

kasutaja määratud väärtustele. Kui aruande tegemise ajal tehakse menüü liidesest valik, siis eeltäitmise 
funktsioon enam ei tööta.

1. Valige menüüdest uuringu jaoks asjakohased leiud. Kui valitakse LV, täidetakse vasaku vatsakese aruande jaotis 
tekstiga, nagu näidatud Joonis 4.

JOONIS 4. Vasaku vatsakese valimise näide 

2. Asetage kursor sulgudest väljapoole ja vajutage klaviatuuril tagasinoolt, et eemaldada terve sulgudega rida, või 
paigutage kursor sulgude sisse, et teksti käsitsi lisada või redigeerida.

MÄRKUS. Enne tulemusparameetrite loomist tuleb teha kõik asjakohased analüüsid.

3. Kõiki aruande jaotisi saab käsitsi redigeerida. Makrosid saab luua aruannete jaotiste Ajalugu, Mulje, Tehnika ja Leiud 
jaoks. Makrode konfigureerimiseks valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit) ja valige 
vahekaart Makro (Macro). 

JOONIS 5. Ajaloo vahekaart koos kasutaja defineeritud makrodega 

4. Valige aruande jaotises märkeruudud, et sisu aruandesse lisada või sellest välja jätta. Vt Joonis 6.

JOONIS 6. Aruande sisu  

5. Aruande eksportimiseks HTML-vormingus klõpsake .
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Aruandesse kujutiste, graafikute või tabelite lisamine

1. Tehke mistahes vaateaval, graafikul või tabelil paremklõps ja valige .

2. Vaadake graafikuid või tabeleid valides .

MÄRKUS. Aruandesse saab saata mitme lõiguga kujutisi. Valige Tööriistad (Tools) > Eelistused (Preferences) > 
Redigeeri (Edit). Valige jaotises Üldine (General) märkeruut Mitme lõiguga kujutised aruandesse (Multi-
slice Image to Report). 

Tehke ülevaate režiimis paremklõps nupul ; pange tähele, et video peab olema pausile pandud.

JOONIS 7. Kujutised, graafikud, tabelid   

1. Vaata graafikuid ja tabeleid, 2. Pealdise sisestamine, 3. Juhtnupud 

Juhtnupud 

Kujutiste, graafikute või tabeli sirvimine

Kaasa raportisse, kui saadaval

Kujutise formaat, väike või suur

Eemalda kujutis, graafik või tabel

Kujutise asukoht

1 2

3
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Polaardiagrammid
Polaardiagramme saab aruandesse lisada, kui täita vastav skeem. Polaardiagrammid on olemas funktsioonis, täiustatud 
režiimis ja perfusioonis. Polaardiagrammi aruandesse lisamiseks valige märkeruut, nagu näidatud Joonis 8.

JOONIS 8. Skeemid 

Segmendi valimine
1. Tehke vasakklõps värvkodeeritud kirjeldajal ja vasakklõps segmendil või 

paremklõps otse valitaval segmendil valides selle loendist või 
valige segmendist eemal, et seadistada kõik segmendid.

2. Kui segment valitakse funktsioonis või täiustatud režiimis, ilmub vastavasse aruande jaotisse kas Vasak vatsake või 
Parem vatsaka koos tehtud valiku teksti kirjeldajatega nagu näidatud Joonis 9.

3. Konfigureerige vaikimisi silt „Täiustatud“ (Enhancement) valides Tööriistad (Tools) > Eelistused (Preferences) > 
Redigeeri süsteemi (Edit System) (ainult administraator) ja sisestades soovitud sildi Müokardi hindamise (Myocardial 
Evaluation) alla. Valige Müokardi hindamise analüüsi (Myocardial Evaluation Analysis) vahekaardil sobiv silt.

MÄRKUS. Kui pikitelje tipusegment on tehtud, vormindatakse aruandel 17 segmendiga polaardiagramm.
MÄRKUS. Täiustatud skeemi saab sisse/välja lülitada, kui vaadatakse perfusiooni skeeme.

4. Polaardiagrammi seadistamiseks 4 värvile, valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi 
(Edit System) (ainult administraator) > Aruandlus (Reporting) > Polaardiagrammi (Polar Plot) ja valige 4-värviline (4-
color).

JOONIS 9. Segmendi valimine 
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Eelvaade ja aruande kinnitamine 

1. Valige Fail (File) > Aruande eelvaade (Preview Report) või valige alt paremalt .

2. Vaadake aruanne üle, et kindlustada, et kõik soovitud tulemused ja struktureeritud teave oleks olemas.

3. Valige nupp , et salvestada aruanne vormingus PDF, RTF, XLS või TIFF. 

4. Valige faili tüüp ja asukoht.

MÄRKUS. Aruande failinime saab konfigureerida Eelistustes (Preferences). Vt Aruande eelistuste valikud lk 30.

JOONIS 10. Aruande eelvaade

5. Valige Ekspordi aruanne (Export Report), et luua DICOM-i sekundaarse hõive seeriad.

6. Valige Aruanne saata… (Report to...), et eksportida muu tootja aruandesüsteemi..

HOIATUS! Aruanne tuleks enne kinnitamist ja väljastamist üle vaadata, et veenduda, et sisu vastab analüüsile. 
Kui aruandes esineb vigu, võib tekkida diagnoosimise edasilükkumine või valediagnoos. Analüüsi ja 
selle tõlgendamise peaks läbi viima nõuetekohaselt koolitatud ja kvalifitseeritud kasutaja.
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Uuringu kinnitamine 
Rakendusel on funktsioon, mis kinnitab ja lukustab aruanded. Kinnitatud aruanne salvestatakse ja seda saab vaadata, kuid 
mitte muuta. Kinnitamine on võimalik ainult kuval Aruande eelvaade (Preview Report).

MÄRKUS. Eeltingimused: kasutajal peab olema aruande allkirjastamise õigus. Vt Aruannete lubatud kinnitajad lk 31. 
(ainult administraator)

MÄRKUS. Automaatse eksportimise sihtkohta saab konfigureerida, vt Aruannete kinnitajate haldamine lk 32. (ainult 
administraator)

MÄRKUS. Uuringu kinnitamisel automaatselt DICOM-ina ekspotimiseks vt lk 33. (ainult administraator)

1. Valige aknas Eelvaade (Preview) suvand Kinnita uuring (Approve Exam).

JOONIS 11. Uuringu kinnitamise aken

2. Kui soovite, sisestage allkirjastaja kirjeldus.

3. Valige rippmenüüst Nimi (Name) oma kasutajanimi.

4. Sisestage oma salasõna.

5. Klõpsake Kinnita (Approve), et kinnitada ja sulgeda aken. Klõpsake Tühista (Cancel), et aken ilma allkirjastamise 
protseduurita sulgeda.

Toodud kirjelduse järgi luuakse seeria.

MÄRKUS. Kui kinnitatud uuring on tehtud, on aruandel kuupäeva- ja ajatempel.

Eksportimise suvandid
1. Valige Tööriistad (Tools) > Ekspordi (Export) > Aruanne Excelisse (Report to Excel)

Ekspordib aruande Excel-faili.

2. Valige Tööriistad (Tools) > Ekspordi (Export) > Aruanne XML-i (Report to XML).
Ekspordib aruande XML-faili.

3. Valige Tööriistad (Tools) > Ekspordi (Export) > Andmed Matlab-i (Data to Matlab).
Ekspordib binaarvormingus Mat-faili.

4. Valige Tööriistad (Tools) > Ekspordi (Export) > Segmenteerimine NRRD-sse (Segmentation to NRRD).

5. Valige Tööriistad (Tools) > Ekspordi (Export) > Isopind STL-i (Isosurface to STL).
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Kinnitatud uuringu ülevaatamine 
1. Valige Fail (File) > Laadi üles kinnitatud uuring (Load Approved Exam). 

Kuvatakse aken Kinnitatud uuringu valimine (Select Approved Exam). Kõik kinnitatud uuringud, mis on seotud 
uuringuga, kuvatakse loendis.

JOONIS 12. Kinnitatud uuringu valimise aken

2. Valige loendist seeria.

3. Kinnitatud uuringu ja sellega kaasneva analüüsi laadimiseks ja kuvamiseks klõpsake nuppu Laadi (Load). 
• Kinnitatud uuringut saab ainult vaadata.
• Kinnitatud uuringu põhjal saab luua uue uuringu, redigeerides kinnitatud aruannet ja salvestades need muudatused uuele 

uuringule. Uus uuringu salvestatakse teise ülesvõtte seeriana.

MÄRKUS. Kinnitatud uuringu ja analüüsi laadimisel kirjutatakse praeguse analüüsiseansi teave üle.

MÄRKUS. Tarkvara suiteHEART® varasemate versioonidega analüüsitud uuringute taastamisel ja kui on tehtud „Laadi 
üles kinnitatud uuring“ (Load Approved Exam), ei ole aruandel kinnitaja nime ega kuupäeva ja kellaaja 
templit. Soovitav on enne aruande väljastamist kõik analüüsid üle vaadata ja kõik tulemused kinnitada.
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Aruande andmebaas

Aruande andmebaas võimaldab otsida varem kinnitatud aruannete sisust. Aruanne sisestatakse aruande andmebaasi 
ainult pärast selle kinnitamist.

Aruande andmebaasi tööriista protseduur
1. Valige Tööriistad (Tools) > Aruande andmebaas (Report Database).

Valige otsingukriteeriumid

2. Valige otsingu jaoks Otsingute mallide (Search template) rippmenüüst õige mall.

3. Valige Ajaloo (History) rippmenüüst otsingupäring. Hetke päringuriba kuvab valitud väärtused.

JOONIS 1. Otsingu suvandid

MÄRKUS. Kui soovitud päringut veel ei eksisteeri, looge uus.
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 Päringu tegemine
1. Valige Ajalugu (History) reast paremalt Uus (New), nagu näidatud joonisel 1. 

Loodud päringute paane kuvatakse Aruande andmebaasi (Report Database) aknas.

JOONIS 2. Andmebaasi päringu paan

1. Päringu analüüside vahekaardid, 2. Päringu rühm, 3. Päringu väljad, 4. Päringu tähised, 5. Päringu parameetrid, 6. Loo päring (Create Query), 
7. Uus päring (New Query), 8. Päringu reeglid, 9. Päringu käivitamine, 10. Päringu suvandid

2. Valige päringu kategooria vahekaart Uuring (Study), Funktsioon (Function), ME, T2*, T1 kaardistamine (T1 Mapping) 
ja T2 kaardistamine (T2 Mapping). Päringu rühmad ja väljad uuendatakse vastavalt sellele.

3. Valige päringu rühm.

4. Valige päringu väli.

MÄRKUS. Aruande andmebaas ei saa teha otsingut kohandatud mõõtmiste järgi.

5. Otsingu parameetrite määramiseks valige tähis.

6. Sisestage otsingukriteeriumi väärtuse jaoks parameetrid.

7. Valige Loo päring (Create Query) päringu kuvamiseks Reeglite (Rules) paanil. Ühe otsingu jooksul saab teha mitu 
päringut. Korrake samme 1 kuni 7 iga lisareegli jaoks.

Nupp Mitte (Not) tähistab, et päringu väärtus on negatiivne.

1

2

3
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Nupp Või (Or) ühendab mitu päringut, rahuldades otsingu vaid ühe päringuga. Nupu Või (Or) toime kohandub 
ülal tehtud päringureeglile.

Nupp Kustuta (Delete) annab võimaluse päringu reeglit valida ja kustutada.

8. Andmebaasist otsimiseks valige Käita (Run).

Otsingu tulemused kuvatakse Päringu tulemuse (Query Result) aknas. Päringu väärtused, mis rahuldavad 
otsingut, kuvatakse tulemuse akna kõige parempoolsemas veerus.

JOONIS 3. Päringu tulemuse aken

1. Ajaloo riba, 2. Päringu tulemused, 3. Prindi loend (Print list), 4. Prindi aruanded (Print Reports), 5. Ekspordi loend (Export list), 6. Kustuta, 7. Too 
uuringud (Retrieve Studies)

MÄRKUS. Uue päringu tulemused ainult luuakse uuringu ID, uuringu kuupäeva, lubatud kinnitaja allkirja ja aruande 
malli kordumatu kombinatsiooni järgi. Kui nende väljade duplikaat tuvastatakse, asendatakse vana aruanne 
uuega.

Too uuringud (Retrieve Studies) 
1. Valige Päringu tulemuste (Query Result) aknast DICOM-i allikas (DICOM source).

2. Valige tulemuste loendist Uuringud (Studies).

3. Klõpsake Too (Retrieve).

JOONIS 4. Päringu tulemuse aken

1

2 3
4
5
6

7



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3                   197

Tulemuste vaatamine
1. Aruande vaatamiseks tehke topeltklõps Päringu tulemuse akna mistahes kirjel. 

Avaneb uus aken, kus kuvatakse valitud aruanne. Kui olemas on rohkem kui üks aruanne, kasutage aruannete 
sirvimiseks nuppe Järgmine aruanne (Next Report) ja Eelmine aruanne (Previous Report). Aruande vaatamise 

akna sulgemiseks klõpsake akna sulgemise märgil .

JOONIS 5. Aruande vaatur

2. Peamisest aruandest lähtudes teeb andmebaasi liides järgmisi tegevusi.

Redigeeri (Edit) > Vali kõik (Select All) – valib kõik otsingutulemused.

Redigeeri (Edit) > Tühjenda valik (Clear Selection) – tühistab kõik otsingutulemuste valimised.

Redigeeri (Edit) > Lülita valik ümber (Invert Selection) – lülitab ümber kõigi tulemuste valimise olekud.

Redigeeri (Edit) > Tühjenda ajalugu (Clear History) – kustutab eelmiste päringute kirje.

3. Päringu loendi saatmiseks printerisse valige Prindi loend (Print List).

4. Valitud aruannete printerisse saatmiseks valige Prindi aruanded (Print Reports).

5. Loendi salvestamiseks HTML-failina ja aruande salvestamiseks PDF-failina valige Ekspordi loend (Export List).

6. Valitud aruande/aruannete eemaldamiseks aruande andmebaasist valige Kustuta (Delete).
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Päringu salvestamine
1. Valige Lemmikud (Favorites) > Lisa lemmikutesse (Add to Favorites). 

2. Sisestage Lisa lemmikutesse (Add To Favorites) tekstiväljale päringu silt ja klõpsake OK.

JOONIS 6. Lemmikute menüü

JOONIS 7. Lemmikute rippmenüü
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Lemmikute kustutamine
1. Valige Aruande andmebaasist Lemmikud (Favorites) > Halda lemmikuid (Manage Favorites).

JOONIS 8. Lemmikute haldamise aken

2. Valige lemmiku kirje.

Tulemuse aknas kuvatakse terve päringu valem.

3. Klõpsake Kustuta (Delete).

Kinnitamise hüpikaken kontrollib teie kustutamise valikut. Valige Jah (Yes).

4. Valige Sulge (Close).
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Otsingu tulemuste eksportimine HTML-faili
1. Valige Aruande andmebaasi akna paremas servas Ekspordi loend (Export List). 

JOONIS 9. Eksportimise aken

2. Valige kataloog, kuhu loend eksportida.

3. Valige OK.
• Hüpikaken küsib, kas kaasata tuleb ka aruanded.
• Loend ja aruanded eksporditakse HTML-faili. 
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Ekspordi andmebaas
Kui andmebaas muutub mahukaks, on soovitav andmed arhiveerida.

1. Valige Aruande andmebaasi menüüribalt Fail (File) > Ekspordi (Export).

2. Valige kataloog, kuhu loend eksportida.

3. Valige OK. Andmebaas eksporditakse välisesse salvestusseadmesse.

Andmebaasi importimine
Andmebaasi saab importida teisest arvutist, kuhu see eksporditi. 

1. Valige Fail (File) > Impordi (Import). 

JOONIS 10. Importimise aken

2. Valige kataloog, kuhu andmebaas importida.

3. Imporditud andmebaas liidetakse olemasolevaga. 
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Lisad

Lisa A: kasutaja taseme eelistused
Rakendus võimaldab individuaalsetel kasutajatel konfigureerida eelistuste alamhulka. 

Administraatoriõigused määrab teie IT-osakond. See, kas olete kasutaja, kellel on juurdepääs suiteDXT administraatori 
versioonile ja suiteDXT mitte-administraatori versioonile sisselogimiseks, sõltub installitud versioonist. suiteDXT 
administraatori poolt käivitamise saab tuvastada otseteede kaudu. (Joonis 1)

JOONIS 1. Valikute käivitamine

Süsteemi uuendamine: varasemad eelistuste seadistused ja mallid on saadaval kõigile kasutajatele, olenemata sellest, kas 
tegemist on ühe kasutaja või mitme kasutaja keskkonnaga. 

MÄRKUS. Pärast mis tahes eelistuste või mallide muutmist on soovitatav suiteHEART sulgeda ja uuesti käivitada. 

Järgmises tabelis toodud menüüvalikud on saadaval suvandis Tööriistad (Tools) > Eelistused (Preferences).    

Tabel 1.  Kasutaja tasemel menüüvalikud

Valik Tase Kirjeldus

Redigeeri 
(Edit)

Kasutaja/
administraator

Võimaldab kasutajal muuta oma eelistusi ja malle; halli värvi valikud mõjutavad 
kõiki kasutajaid ja neid saab muuta ainult administraatori süsteemi redigeerimise 
funktsiooniga.

Redigeeri 
süsteemi 
(Edit System)

Ainult 
administraator

Võimaldab redigeerida kõiki eelistusi, mis pole standardse redigeerimise jaoks 
saadaval. Lisaks võimaldab redigeerida vaikimisi eeltöötluseks kasutatavaid 
eelistusi.

Impordi 
(Import)

Ainult 
administraator

Taastab eksporditud failist kõigi kasutajate eelistused ja mallid. Eelistuste 
importimine versioonist enne kasutaja eelistusi impordib eelistused 
süsteemikomplekti. Importimisel kõik praegused eelistused ja mallid kustutatakse.

Kopeeri 
(Copy)

Kasutaja/
administraator

Kopeerib eelistused teistelt kasutajatelt (malli omandiõigust ei kopeerita).

Ekspordi 
(Export)

Kasutaja/
administraator

Ekspordib kõikide kasutajate kõik eelistused ja mallid. 
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Administraatori funktsioonid

Uue kasutaja lisamine aruannete lubatud kinnitajana 

1. Käivitage suiteDXT administraatorina.

2. Käivitage suiteHEART.

3. Valige Tööriistad (Tools) -> Eelistused (Preferences) -> Redigeeri süsteemi (Edit System).

4. Sisestage kasutaja jaotises Aruannete lubatud kinnitajad (Authorized Report Approvers).

5. Määrake parool.  Kasutajad saavad oma parooli muuta. 

6. Valige sobiv automaatse ekspordi sihtkoht, kui see on konfigureeritud. 

7. Klõpsake nuppu Rakenda (Apply).

8. Klõpsake Salvesta ja välju (Save and Exit). 

Süsteemiüleste eelistuste muutmine

1. Käivitage suiteDXT administraatorina.

2. Käivitage suiteHEART.

3. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri süsteemi (Edit System).

4. Tehke analüüsi eelistustes vastavad muudatused, nagu on loetletud Tabel 2.

MÄRKUS. Süsteemi eelistustes mis tahes muudatuste tegemine mõjutab kõiki kasutajaid.

Tabel 2.  Administraatori juhitud analüüsi eelistused  

Vahekaart Jaotis Eelistus

Üldine (General) Report (Aruanne) Kõik jaotise eelistused, mis hõlmavad aruande 
päiseid, logosid jne

Üldine (General) Aruannete lubatud kinnitajad 
(Authorized Report Approvers)

Aruannete lubatud kinnitajad (lisamine, 
kustutamine) 

Üldine (General) Üldine (General) Kinnitatud uuringu automaatne eksport 
(Automatically Export Approved Exam)

Üldine (General) Vool (Flow) Automaatne algtaseme korrigeerimine (Auto 
Baseline Correction)

Üldine (General) Vool (Flow) Regurgitatsioonirežiim: Automaatne 
(Regurgitant Mode: Auto)

Üldine (General) Vool (Flow) Automaatne diskreetmoonutuse tuvastamine 
(Aliasing Automatically Detected) 
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Üldine (General) Vool (Flow) Diskreetmoonutuse korrigeerimine on 
vaikimisi sees (Aliasing Correction On By 
Default)

Üldine (General) Vool (Flow) Voolu ühik (Flow Unit)

Üldine (General) Vool (Flow) Vaikemeetod (Default Method)

Üldine (General) Jõudeoleku taimer (Idle Timer) Jõudeoleku taimer (Idle Timer)

Üldine (General) Müokardi hindamine Kõik jaotise eelistused

Virtual Fellow Apeksi suund (Apex Direction) 2-kanaliline, 3-kanaliline, 4-kanaliline suund

Funktsioon (Function) Üldine (General) Rakenda MV ja TV rõngas (Apply MV and TV 
Annulus)

Funktsioon (Function) Üldine (General) Rakenda põhimikujoone interpoleerimine 
(Apply Basal Line Interpolation)

Funktsioon (Function) Üldine (General) Rakenda vatsakese keskosa interpoleerimine 
(Apply Mid Ventricular Interpolation)

Funktsioon (Function) Üldine (General) Liikumise korrigeerimine seeriate vahel 
(Motion Correction Between Series)

Funktsioon (Function) Üldine (General) Luba mitme seeria eeltöötlus (Enable 
Preprocessing for multiple series)

T1/T2/T2* T1 Jada (Sequence), ICF

T1/T2/T2* T2 Parameetrite sobitamine (Parameter Fit)

T1/T2/T2* T2* Parameetrite sobitamine (Parameter Fit)

T1/T2/T2* Endo/epi nihe (Endo/Epi Offset) T1, T2 endo/epi nihe (Endo/Epi Offset)

Aruandlus Aruandlus Kõik eelistused vahekaardil Aruandlus 
(Reporting), sealhulgas mis tahes kohandatud 
tekst ja teksti valimise kriteeriumid 
aruandluse liideses

Automaatne seeriate 
koostamine (Auto-
Compose Series)

Automaatne seeriate koostamine 
(Auto-Compose Series)

GE kombineeritud T1, Philips T1/T2, Siemens 
T1/T2

Tabel 2.  Administraatori juhitud analüüsi eelistused  

Vahekaart Jaotis Eelistus
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Mallid

Mallide pealkirju, mis on paksus kirjas, ei saa redigeerida. 

Varasemate 5.1.2 mallide haldamine.

Administraator saab määrata olemasolevad 5.1.2 mallid konkreetsetele kasutajatele. Omandiõiguse muutmiseks tehke 
järgnevat: 

1. Käivitage suiteDXT administraatorina.

2. Käivitage suiteHEART.

3. Valige Tööriistad (Tools) -> Eelistused (Preferences) -> Redigeeri süsteemi (Edit System).

4. Valige vahekart Mall (Template).

5. Valige malli nimi, mille soovite määrata.

6. Kasutage rippmenüüd Kasutajanimi (Username), et määrata mall konkreetsele kasutajale.

7. Klõpsake Salvesta ja välju (Save and Exit). 

Mallide kustutamine:

1. Käivitage suiteDXT administraatorina.

2. Käivitage suiteHEART.

3. Valige Tööriistad (Tools) -> Eelistused (Preferences) -> Redigeeri süsteemi (Edit System).

4. Valige vahekart Mall (Template).

5. Valige praeguse malli nimi.

6. Klõpsake Kustuta (Delete).

7. Klõpsake Salvesta ja välju (Save and Exit). 

Kasutaja funktsioonid

Ühe kasutajaga keskkond

Ühe kasutajaga keskkonnas pole kopeerimise funktsioon saadaval. Kehtib ainult mitme kasutajaga keskkonnale, kus 
kasutaja soovib kopeerida olemasoleva kasutaja eelistuse. 

Mitme kasutajaga keskkond 

Kasutajad saavad kopeerida teiste kasutajate eelistusi. 

1. Käivitage suiteHEART.

2. Valige Tööriistad (Tools) > Eelistused (Preferences) > Kopeeri (Copy).

3. Faili rippmenüü kuvab kasutajanimed (malle ei kopeerita).

4. Valige kasutaja.

5. Klõpsake OK.

MÄRKUS. Administraatori juhitud analüüsi eelistused muutuvad, nagu on loetletud Tabel 2.
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Mallid

Mallid on saadaval kõigile kasutajatele kasutamiseks suiteHEART-is, sealhulgas varasemad mallid ja NeoSofti pakutavad 
mallid (eelnevalt määratletud). Kasutajad saavad redigeerida/muuta oma malle ja teiste kasutajate malle nad muuta ei 
saa.

Kasutajad saavad olemasolevaid malle kopeerida. Kopeeriv kasutaja saav kopeeritud malle redigeerida. 

Iga kasutaja saab pärast uuringu käivitamist valida oma malli. Eelmist malli valikut rakendatakse tulevaste juhtumite jaoks. 

Kasutajad saavad ise luua uusi malle või kasutada eelmääratletud malli. 

Aruannete lubatud kinnitajate parooli muutmine

MÄRKUS. Kasutajad vajavad administraatori määratud algset parooli. 
1. Käivitage suiteHEART.

2. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). 

3. Sisestage Vana parool (Old Password).

4. Sisestage Uus parool (New password).

5. Sisestage uus parool uuesti väljale Kinnita parool (Confirm password).

6. Klõpsake nuppu Rakenda (Apply).

7. Klõpsake Salvesta ja välju (Save and Exit). 

Süsteemi eelistuste muutmine

1. Käivitage suiteHEART.

2. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).   

3. Tehke analüüsi eelistustes vastavad muudatused. 

MÄRKUS. Halli värvi suvandeid saab muuta ainult administraator.
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Lisa B: funktsiooni analüüsi skannimistasapinna näide
Täpsete funktsiooni analüüsi tulemuste saamiseks tuleks analüüs läbi viia lühikese telje vaates, nagu on näidatud alloleval 
esimesel joonisel.

Õige skannimistasapinna ettekirjutus lühikese telje vaate hõivamiseks. Lõigud tuleks määrata vasaku vatsakese pikiteljega 
risti, vähemalt 2 lõiku põhimikust kõrgemal ja 1 lõik pärast seeriasse kaasatud tippu.
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Lisa C: GE 2D video etapi kontrasti parameetrid
1. Voolu suund = lõik

2. Ahendamine = väljas

3. Voolu analüüs = sees

4. Voolu tuvastus = faasi erinevus

Lisa D: funktsiooni mahu analüüsi meetodid

Vaade Meetod

LV/RV lühikese telje virn Simpsoni reegel

LV pika telje mitu vaadet (2-kanaliline, 4-kanaliline) Kahetasandiline Simpsoni reegel 

RV pika telje vaated, 4-kanaliline Mittetäielik muudetav ala (FAC)

LV pika telje ühekordne vaade Simpsoni reegel 

LA/RA lühike telg või aksiaalne virn Simpsoni reegel

LA mitu vaadet (2-kanaliline ja 4-kanaliline) Kahetasandiline Simpsoni reegel 

RA vaade (4-kanaliline) Simpsoni reegel

LA/RA pika telje ühekordne vaade Simpsoni reegel

LV mass Müokardi tihedus = 1,05
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Indeks

Arvväärtused
3D/4D voolu vaatur 161

3D segmenteerimine koos mõõtmistega 167
Pinna režiim 175
Vaaturi paigutus 166
Vahekaart Display (Kuva) 162
Vahekaart Veresoon (Vessel) 167

A
Abimenüü suvandid 11

Algtaseme korrigeerimine 103

Andmebaas, sirvija 18

Andmebaasi sirvimine 18

Aruande andmebaas 194
Eksportimine, otsing HTML-i 200
Importimine, andmebaas 201
Lemmikute kustutamine 199
Otsingukriteeriumid 194
Päring 195
Salvesta päring 198
Tööriistade kasutamine 194

Aruande eelvaade 191

Aruandlus 186
Aruande eelvaade 191
Ekspordi 192
Polaardiagrammid 190
Protseduur 188
Ülevaatamine, kinnitatud uuringu 192, 193

Aruanne
Eelistuste protseduur 30
Kinnitajad 31
Kinnitajad, haldamine 32
Kujutiste, graafikute, tabelite lisamine 189

Automaatne LV ja RV segmenteerimine 67

Automaatne segmenteerimine 98
Kõik lõigud, üks faas 69
Protseduur 99

Automaatne värskendamine 58

Avatud ovaalmulgu (PFO) analüüs 153
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E
Eelistused

Aruande kinnitajad 32
Aruanne 30
Ekspordi 49
Funktsioon 44
Impordi (Import) 49
Jõudeoleku taimer 34
Makro 40
Mall 36
Määramine 29
Printimise vahekaart 42
Redigeeri 29
Seeria filter 36
T1/T2/T2* vahekaart 45
Virtual Fellow® 31
Virtual Fellow® vahekaart 43
Vool 35
Üldine (General) 33

Ekspordi
Eelistused 49

Ekspordi koostaja 24

Eksportimine, otsingu tulemus HTML-i
Aruande andmebaas 200

F
Faasivahemikud, redigeerimine 102

Failimenüü suvandid 10

Fantoomiga korrigeerimine 105

Funktsiooni analüüs 66
Kiire LV protseduur 82
Kohandatud mõõtmine

Lisa 87
Mõõtmine

Eemalda 87
Kustuta 87
Lisa 87

Mõõtmiste seadistamine 86
Vatsakeste funktsiooni analüüsi tulemused 78

Funktsiooni mahu analüüsi meetodid 208

H
Hiline täiustamine

T2 128
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Hilisema täiustamise analüüsimise protseduur 122

Histogrammirežiim 110

HTML, tulemuste eksportimine 200

I
Impordi

Andmebaas 201
Eelistused 49

Impordi (Import)
Eelistused 49

Indeksmõõdud, arvutamine 67

Indeksmõõtude arvutamine 67

Integreeritud analüüs, tulemused 120

J
Jõudeoleku taimeri seadistused 34

K
Kambrite mahtude tabel 79

Kasutajaliides
Abimenüü 11
Analüüsirežiimid 9
Aruandlus 18
Failimenüü 10
Kujutise töötlemine 12
Kujutisevaaturi juhtnupud 11
Redaktori aken 10
Režiimi vaade 10
Ristlõigete režiim 12
Seeriate sirvimine 9
Tööriistade menüü 10
Video 11
Ülevaade 8

Kasutusnäidustused 2

Kasutusotstarve 2

Kiirklahvid 14

Kiiruse diskreetmoonutuse automaatne korrigeerimine 107

Klapi tasapinna analüüs 88

Kojad (Atria) 83

Kombineeritud analüüs 128

Kontuuri kustutamine 64
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Kontuuri redigeerimine
Kustutamine 64
Müksamise tööriist 61
ROI punktsplain 60
Tõmbamise tööriist 62

Kontuuri tõmbamise tööriist 62

Kontuuride redigeerimine 60

Kujutise töötlemise tööriistad 12

Kujutisehalduse tööriistad 21
Võrdlusrežiim 26

Kujutisevaaturi juhtnupud 11

Kustuta lemmik, aruande andmebaas 199

Kõvera tingmärgid, redigeerimine 112

Kõverarežiimi valikud 109

Käsitsi segmenteerimise protseduur 99

L
LA

automaatne 84
käsitsi 83

Lineaarne mõõtmine
Seadistamine 86

Lokaalne ROI tööriist 135

LV
käsitsi 70

LV segmenteerimine 67

M
Makro

Eelistused 40
Kustuta 41
Muljed, lisamine 40
Rakendamine 41
Tekst 40

Mall
Eelistused 36

Mittesünkroonsuse analüüs 81

Muljed
Makro, lisamine 40

Mõõtmised
Kohandatud, eemalda 87
Kohandatud, lisa 87
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Kustuta 87
Lineaar 86

Mõõtmised, kasutaja määratud 86

Mõõtmiste kustutamine 87

Müksamise tööriist 61

Müokardi hindamine 121
Polaardiagrammi vormingud 124
T2 analüüs 126

Müokardi värvikaart 159

Mürapikslid, välistamine 106

Mürapikslite välistamine 106

N
Nihke suvandid 105

O
Ohud seadmetest 3

Ohutusmärkused 3

P
Patsiendi demograafilised andmed 187

Piirkondlikud analüüsid 80

Polaardiagrammid
Segmendi valimine 190

Printimise vahekaart 42

Põhimiku interpoleerimine 71

Päringu salvestamine, aruande andmebaas 198

Q
Qp/Qs

Arvutamine 116
Valikud 115

R
RA

Analüüs, käsitsi 83
automaatne analüüs 84

Rakenduse käivitamine 6
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Rakendusest väljumine 6

Redigeerimise tööriistad, vaateava 102

Regurgitatsiooni fraktsioon, arvutamine 117

Regurgitatsioonimaht, arvutamine 117

Ristlõigete režiim 12

ROI punktsplain 60

RV käsitsi 70

RV segmenteerimine 67

Rõhu poolaeg 110

S
Seeriate sirvimine 9

Segmenteerimine
automaatne 99
käsitsi 99

Signaali diferentsiaal 132
Tulemused 132
Vahekaart 132

Silt
Kategooria 112

T
T1 kaardistamine 136

T1/T2 T2* vahekaart 45

T2 kaardistamine 142

T2Star 157
Analüüsimise protseduur 158
Müokardi värvikaart, loomine 159
Parameetrite sobitamine 159
Tulemused 160

Teisaldamine, veresoone kategooria 101

Tippkiirus, kasutaja määratud 109

Tööriistade menüü 10

U
Uuringu kinnitamine, struktureeritud aruanne 192

V
Vaateava redigeerimise tööriistad 102



Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Vers 3                  215

Vaatur 21

Vahekaart
Aruandlus 18

Varase täiustamise analüüs 133

Vatsakesed 67

Veresoone kategooria, teisaldamine 101

Veresoonte kategooriad 98

Video režiim 11

Virtual Fellow® 50
Liidese tööriistad 52

Virtual Fellow® vahekaart 43

Virtual Fellow™
Liides 52
Vaatamisprotokollid 54

Vool 35

Voolu analüüs 96
Automaatne segmenteerimine 98
Kõvera tingmärgid 112
Nihke suvandid 105
Qp/Qs valikud 115
Sildi muutmine 112
Tulemuste vaatamine 111
Tööriistad 105

Võrdlusrežiim 26

Värvülekate 106

Ü
Üldised eelistused 32
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